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[M] micromeritics®

TRADEMARKS

Alconox is a registered trademark of the Alconox Company.

AutoPore is a registered trademark of Micromeritics Instrument Corporation.
MicroActive is a trademark of Micromeritics Instrument Corporation.
Micromeritics is a registered trademark of Micromeritics Instrument Corporation.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Python is a registered trademark of Python Software Foundation.

This application may contain a binary form of the Info-ZIP tool to create .zip files. That source code
is provided under the following license:

This software is provided "as is," without warranty of any kind, express or implied. In no event shall Info-ZIP or its
contributors be held liable for any direct, indirect, incidental, special or consequential damages arising out of the use of
or inability to use this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it
and redistribute it freely, subject to the following restrictions:

1.

Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this list of con-
ditions.

Redistributions in binary form must reproduce the above copyright notice, definition, disclaimer, and this list of
conditions in documentation and/or other materials provided with the distribution.

Altered versions — including, but not limited to, ports to new operating systems, existing ports with new graph-
ical interfaces, and dynamic, shared, or static library versions — must be plainly marked as such and must not
be misrepresented as being the original source. Such altered versions also must not be misrepresented as
being Info-ZIP releases — including, but not limited to, labeling of the altered versions with the names "Info-ZIP"
(or any variation thereof, including, but not limited to, different capitalizations), "Pocket UnZip," "WiZ" or
"MacZip" without the explicit permission of Info-ZIP. Such altered versions are further prohibited from mis-
representative use of the Zip-Bugs or Info-ZIP e-mail addresses or of the Info-ZIP URL(s).

Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "WiZ," "Pocket UnZip," "Pocket Zip," and
"MacZip" for its own source and binary releases.

Copyright

The software described in this manual is furnished under a license agreement and may be used or
copied only in accordance with the terms of the agreement.

Copyright © 2014 - 2022. Micromeritics Instrument Corporation. All rights reserved.
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WARRANTY

MICROMERITICS INSTRUMENT CORPORATION warrants for one year from the date of shipment each instrument it
manufactures to be free from defects in material and workmanship impairing its usefulness under normal use and
service conditions except as noted herein.

Our liability under this warranty is limited to repair, servicing and adjustment, free of charge at our plant, of any
instrument or defective parts when returned prepaid to us and which our examination discloses to have been defective.
The purchaser is responsible for all transportation charges involving the shipment of materials for warranty repairs.
Failure of any instrument or product due to operator error, improper installation, unauthorized repair or alteration, failure
of utilities, or environmental contamination will not constitute a warranty claim. The materials of construction used in
MICROMERITICS instruments and other products were chosen after extensive testing and experience for their
reliability and durability. However, these materials cannot be totally guaranteed against wear and/or decomposition by
chemical action (corrosion) as a result of normal use.

Repair parts are warranted to be free from defects in material and workmanship for 90 days from the date of shipment.

No instrument or product shall be returned to MICROMERITICS prior to notification of alleged defect and authorization
to return the instrument or product. All repairs or replacements are made subject to factory inspection of returned parts.

MICROMERITICS shall be released from all obligations under its warranty in the event repairs or modifications are
made by persons other than its own authorized service personnel unless such work is authorized in writing by
MICROMERITICS.

The obligations of this warranty will be limited under the following conditions:

1. Certain products sold by MICROMERITICS are the products of reputable manufacturers, sold under their
respective brand names or trade names. We, therefore, make no express or implied warranty as to such
products. We shall use our best efforts to obtain from the manufacturer, in accordance with his customary prac-
tice, the repair or replacement of such of his products that may prove defective in workmanship or materials. Ser-
vice charges made by such manufacturer are the responsibility of the ultimate purchaser. This states our entire
liability in respect to such products, except as an authorized person of MICROMERITICS may otherwise agree
to in writing.

2. Ifaninstrument or product is found defective during the warranty period, replacement parts may, at the dis-
cretion of MICROMERITICS, be sent to be installed by the purchaser, e.g., printed circuit boards, check valves,
seals, etc.

3. Expendable items, e.g., sample tubes, detector source lamps, indicator lamps, fuses, valve plugs (rotor) and
stems, seals and O-rings, ferrules, etc., are excluded from this warranty except for manufacturing defects. Such
items which perform satisfactorily during the first 45 days after the date of shipment are assumed to be free of
manufacturing defects.

Purchaser agrees to hold MICROMERITICS harmless from any patent infringement action brought against
MICROMERITICS if, at the request of the purchaser, MICROMERITICS modifies a standard product or manufactures a
special product to the purchaser’s specifications.

MICROMERITICS shall not be liable for consequential or other type damages resulting from the use of any of its
products other than the liability stated above. This warranty is in lieu of all other warranties, express or implied, including
but not limited to, the implied warranties of merchantability or fitness for use.
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CORPORATE PROFILE

Micromeritics Instrument Corporation is the world’s leading supplier of high-performance systems
to characterize particles, powders and porous materials with a focus on physical properties,
chemical activity, and flow properties. Our technology portfolio includes: pycnometry, adsorption,
dynamic chemisorption, particle size, intrusion porosimetry, powder rheology, and activity testing
of catalysts. The company has R&D and manufacturing sites in the USA, UK, and Spain, and
direct sales and service operations throughout the Americas, Europe, and Asia. Micromeritics
systems are the instruments-of-choice in more than 10,000 laboratories of the world’s most
innovative companies and prestigious government and academic institutions. Our world-class
scientists and responsive support teams enable customer success by applying Micromeritics
technology to the most demanding applications. For more information, please visit
www.Micromeritics.com.
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CONTACT Us

Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA/USA /30093-2901
Phone: 1-770-662-3636
Fax: 1-770-662-3696

www.Micromeritics.com

Instrument Service or Repair
Phone: 1-770-662-3666
International: Contact your local distributor or call 1-770-662-3666
Service.Helpdesk@Micromeritics.com

Micromeritics Application Support
Support@Micromeritics.com
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ABOUT THIS MANUAL

The following can be found on the Micromeritics web page (www.Micromeritics.com).

m Calculations document (PDF)
m Error Messages document (PDF)
® QOperator Manual (PDF)

® Parts and Accessories
® VVacuum Pump Guide (PDF)

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear in this manual:

/ NOTE — Notes contain important information applicable to the topic.

CAUTION — Cautions contain information to help prevent actions that may damage
the analyzer or components.

WARNING — Warnings contain information to help prevent actions that may cause
personal injury.

> @

AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022


http://www.micromeritics.com/

[M] micromeritics’ Generai Saety

GENERAL SAFETY

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

The AutoPore uses mercury which is an extremely toxic substance. Read the Mater-

ial Safety Data Sheet (MSDS) and be aware of the hazards of mercury and know

what to do in the event of a spill or an exposure incident.

Any piece of laboratory equipment can become dangerous to personnel when improperly
operated or poorly maintained. All employees operating and maintaining Micromeritics

instruments
on safety.

® Read the

should be familiar with its operation and should be thoroughly trained and instructed

operator manual for any special operational instructions for the instrument.

= Know how the instrument functions and understand the operating processes.

Wear the appropriate personal protective equipment when operating this
instrument — such as eye protection, lab coat, protective gloves, etc.

When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assist in
moving the instrument. The AutoPore V 9600 weighs approximately 227 - 250 kg
(500 - 550 Ib) depending on configuration.

Always pay attention to the safety instructions provided on each label affixed to the
instrument and do not alter or remove the labels. When inspecting the instrument,
ensure that the safety labels have not become worn or damaged.

Proper maintenance is critical to personnel safety and smooth instrument
operation and performance. Instruments require regular maintenance to help
promote safety, provide an optimum end test result, and to prevent costly down
time. Failure to practice proper maintenance procedures can lead to unsafe
conditions and shorten the life of the instrument.

Improper handling, disposing of, or transporting potentially hazardous materials
can cause serious bodily harm or damage to the instrument. Always refer to the
MSDS when handling hazardous materials. Safe operation and handling of the
instrument, supplies, and accessories is the responsibility of the operator.

AutoPore V
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INTENDED USE

The AutoPore V Series mercury porosimetry analysis technique is based on the intrusion of
mercury into a porous structure under stringently controlled pressures. Besides offering speed,
accuracy, and a wide measurement range, mercury porosimetry permits you to calculate
numerous sample properties such as pore size distributions, total pore volume, total pore surface
area, median pore diameter and sample densities (bulk and skeletal). The AutoPore V Series
Mercury Porosimeters can determine a broader pore size distribution more quickly and accurately
than other methods. This instrument also features enhanced safety features and offers new data
reduction and reporting choices that provide more information about pore geometry and the fluid
transport characteristics of your material.

proper operation of the equipment recommended by the manufacturer and as well as
relevant hazards involved and prevention methods. Other than what is described in
this manual, all use is seen as unintended use and can cause a safety hazard.

i "_\ The instrument is intended to be operated by trained personnel familiar with the

/ The instrument is intended to be used as per applicable local and national regulations.

TRAINING

It is the customer's responsibility to ensure that all personnel operating or maintaining the
equipment participate in training and instruction sessions. All personnel operating, inspecting,
servicing, or cleaning this instrument must be properly trained in operation and machine safety
before operating this instrument.

AutoPore V Series Operator Manual
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General Safety

ENVIRONMENTALLY FRIENDLY USE PERIOD

Hazardous Substances Table

Hazardous Substances

Part Name |Lead |Mercury |[Cadmium | Hexavalent |[Polybrominated Polybrominated
(Pb) (Hg) (Cd) Chromium biphenyls diphenyl ethers
(Cr (V1)) (PBB) (PBDE)

Metal Parts 0 0 0 0 ¢ 0
Power Entry o] o] o] o] o] o]
Thermo-
couple X o] o] o] o] o]
Cables
Electronic . o o o o o
Components
Gas Fittings,
Hoses and X o} o} o} o] o]
Filter

o Hazardous substance is below the specified limits as described in SJ/T11363-2006.

X  Hazardous substance is above the specified limits as described in SJ/T11363-2006.

The Environmentally Friendly Use Period (EFUP) for all enclosed products
and their parts are per the symbol shown here unless otherwise marked. Cer-
tain parts may have a different EFUP (for example, battery modules) and are
marked to reflect such. The Environmentally Friendly Use Period is valid only
when the product is operated under the conditions defined in the product

manual.

&
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SYMBOLS THAT MAY APPEAR ON YOUR INSTRUMENT

The following symbols or icons indicate safety precautions and/or supplemental information and
may appear on your instrument:

Use extreme caution when working on the instrument where one of these symbols
may be displayed. These symbols indicate the part may be hot and cause serious
burns.

Use the cotton gloves provided in the accessory when handling heated surfaces.
These cotton gloves are not intended to protect hands when heated surfaces are
above 60 °C.

When working on the instrument where this symbol is displayed, refer to your Micro-
meritics' instruction manual for additional information.

When this symbol is displayed, toxic or flammable gases require proper venting of
exhaust.

B BB BB

This symbol can also indicate the instrument uses mercury which is an extremely
toxic substance. Read the Material Safety Data Sheet (MSDS) and be aware of the
hazards of mercury and know what to do in the event of a spill or an exposure
incident

AutoPore V Series Operator Manual
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1 ANALYZER COMPONENTS FOR AUTOPORE

FRONT PANEL

A. High pressure ports (2)
B. LED display
C. Low pressure ports (4)

Front Panel Components

Component Description

High Pressure Ports Pressurized. llluminates when the high pressure system is

[LED light] pressurized, when the computer system is not connected, or when
the computer is connected but the application is not running.

Low Pressure Ports Pressurized. llluminates when the low pressure system is

[LED light] pressurized, when the computer system is not connected, or when

the computer is connected but the application is not running.

Hg Up. llluminates when the amount of mercury in the low pressure
system is sufficient to fill the penetrometers.

Hg Drained. llluminates when mercury has been drained from the
low pressure system.

Power [LED light] llluminates when power is supplied to the analyzer.

AutoPore V Series Operator Manual
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REAR PANEL

Power

Ventilation

External gas supply port
Ethernet port

Aux RS-232 port

moow>»

Rear Panel Components

Component

Description

Power

Power cord connector, power supply, and power switch.

Reset buttons:

= 10 Amp. Resets the internal vacuum pump.
= 25 Amp. Resets the internal vacuum pump in a high pressure analyzer.

Ventilation

Provides ventilation for the analyzer. This exhaust can be vented to the outside
using flexible tubing similar to the type used on a home clothes dryer, and a vent
system which pulls air from the exhaust port.

External Gas

Used for connecting an external gas supply to the analyzer when generating

Supply pressures in the low pressure system.

Ethernet Port for a shielded Ethernet cable allowing communication between the analyzer
Port and the computer.

Aux RS-232 | Used by service personnel.

port

1-9 AutoPore V Series Operator Manual
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MERCURY PRECAUTIONS

Improper handling, disposing of, or transporting potentially hazardous materials can cause
serious bodily harm or damage the instrument. Always refer to the MSDS when handling
hazardous materials. Safe operation and handling of the instrument, supplies, and accessories is
the responsibility of the operator.

At all times practice strict chemical hygiene when working with mercury:

Read the MSDS for mercury hazards
Store mercury in a cool location to minimize mercury vaporization
Instruments should be installed in a cool location

Wear safety glasses, protective gloves, and appropriate clothing (long lab coat, closed toe
shoes)

Avoid skin and eye contact.

Wash hands and face after handling mercury

Do not eat or drink in the lab where mercury is present
Dispose of contaminated waste in an appropriate manner

AutoPore V Series Operator Manual
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OPERATIONAL SAFETY FEATURES

The AutoPore V comes with multiple safety features:

= Mercury Drip Trays

Safe collection of mercury for disposal in the case of compromised penetrometer seals or
operator error resulting in broken penetrometers

® Mercury Temperature Sensor

Automatic measurement of mercury temperature allows automatic calculation of mercury
density used for penetrometer calibrations. The ability to set a temperature limitin manual
mode allows the display of a warning message if the temperature is exceeded.

= |mproved Mercury Funnel Design

Attached screw cap and funnel-shaped opening eliminates mercury contamination and
possible drip spillage associated with separate detached filling funnel. Attached screw cap
prevents loose cap and possible vapor release.

= Triple Fail Safe-One Penetrometer Safety Caps

In case of operator error, this device prevents penetrometer or rod being released from port
unintentionally

= Triple Fail Safe-Two Interlock on Locking Cap

Verifies that capacitance detector is installed on low pressure port, automatically suspends run
if cap is notin place. This prevents the penetrometer from being accidentally released while
under pressure. If error is corrected, suspend run can be resumed.

= Triple Fail Safe-Three System Pressure Vent on manifold

Works in concert with cap interlock to automatically vent system pressure if above ambient
pressure and error condition is detected.

= Mercury Vapor Detection Device

Hand held device to check localized mercury vapor levels that exceed defined safety limits.
Portable device allows point checks at the analyzer or any location within lab exposed to
mercury.

= Mercury Vapor Capture Filter

Affixed to vacuum pump, this filter prevents release of mercury vapors. This is a superior
solution to cold trap Dewars, particularly if the cryogen level is insufficiently maintained.

= Software Control for Fine Powder Samples

Prevents fine powder from accidental aspiration into low pressure ports during analysis.

AutoPore V Series Operator Manual
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THE BASsIC WORKFLoOwW

Before a sample can be analyzed, it must be:

1. Weighed and the mass recorded, and
2. A sample file must be created that describes the sample and gives the analysis conditions
and other parameters for the analysis. This file also includes a pressure table, which lists
the pressure points at which data are collected during the analysis.
To begin the analysis, a sample is placed in a penetrometer then the penetrometer is installed into
alow pressure port. The low pressure analysis consists of two phases:

1. The first phase is the evacuation of gases from the penetrometer. The penetrometer is then
filled automatically with mercury.

2. The second phase is the collection of data at pressures up to and including the last low
pressure point specified in the pressure table.

When the low pressure analysis is complete, remove the penetrometer from the low pressure port
and weigh it, then install it in a high pressure port. The mass of the penetrometer with sample and
mercury can be entered in the sample file or in the window for starting the high pressure analysis.

Pore volume data are calculated by determining the volume of mercury remaining in the
penetrometer stem. As pressure increases, mercury moves into the sample’s pores, vacating the
stem (this is called intrusion). Intrusion of different size pores occurs at different pressures. (The
greater the pressure, the smaller the pore diameter into which the mercury can be forced.)
Because mercury has a high surface tension and is nonwetting to most materials, its angle of
contact and radius of curvature can be used to calculate the pore diameter into which it intrudes at
a given pressure.

The volume of mercury in the penetrometer stem is measured by determining the penetrometer
electrical capacitance. Capacitance is the amount of electrical charge stored per volt of electricity
applied. The penetrometer capacitance varies with the length and diameter of the penetrometer
stem that is filled with mercury.

When the penetrometer is initially filled with mercury, the mercury extends the entire length of the
penetrometer. As increasing pressure causes the mercury to intrude into the sample’s pores, the
volume of mercury in the penetrometer stem decreases by an amount equal to the volume of the
pores filled. This decrease in the length of the penetrometer stem that is filled with mercury causes
a reduction in the penetrometer capacitance. The analysis application converts measurements of
the penetrometer capacitance into data points showing the volume of mercury intruding into the
sample’s pores.

Theory for Mercury Porosimetry on page E - 1 provides a thorough discussion of the theory of
porosimetry.
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SPECIFICATIONS FOR AUTOPORE V

Electrical
Frequency 50 to 60 Hz
Power 500 VA maximum
Voltage 100/120/220/240V~ £10%

220V applications should use the 230V setting.

Overvoltage category Il

Gas

Nitrogen or other clean, dry gas at 50 psig (345 kPa)

Environment

10 °C to 35 °C (50 °F to 95 °F), operating
Temperature 0°Cto 50 °C (32 °F to 122 °F), non-operating
Maximum rate of change of 2 °C per hour

Humidity 10% to 80% relative, non-condensing

Indoor only (not suitable for wet locations)
Altitude: 2000 m max (6500 ft)
Pollution degree of the intended environment: 2

Indoor or
Outdoor use

Instrument should be located in a dust-free, vibration free envir-

LI onment, away from exposure to direct sunlight and direct air drafts.

Degree of Ingress Pro-

tection 1249

AutoPore V Series Operator Manual
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High Pressure Model 9600 and 9605

Measurement

Pore Diameter Range
Resolution

Servo Control Precision
Transducer Accuracy

Transducer Hysteresis

From atmospheric pressure to 33,000 psia (228 MPa)

610 0.005 um

0.165 psi (1400 Pa) from 3300 psia (21 MPa) to 33,000 psia
0.05% of target, min 5 psia, no overshoot

10.1% of full scale (transducer manufacturer's specifications)

0.05% of full scale

High Pressure Model 9610 and 9620

Measurement

Pore Diameter Range
Resolution

Servo Control Precision
Transducer Accuracy

Transducer Hysteresis

From atmospheric pressure to 60,000 psia (414 MPa)

610 0.003 um

0.3 psia from atmospheric pressure to 60,000 psia

0.05% of target, min 5 psia, no overshoot

1 0.1% of full scale (transducer manufacturer's specifications)

0.05% of full scale

Intrusion
Accuracy 10.1% of maximum penetrometer stem volume
Resolution Better than 0.1 pL
AutoPore V Series Operator Manual 1.7
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1 Analyzer Components for AutoPore Iml micromeritics®

Low Pressure

Measurement 0.2 to 50 psia (345 kPa)
Pore Diameter Range 50010 3.6 um
Resolution 0.00025 psi

Servo Control Precision 1% of target, min. 0.05 psia, no overshoot

Transducer Accuracy 10.1% of full scale (transducer manufacturer’s specifications)
Penetrometers
. Maximum: a cylinder 2.54 cm diameter x 2.54 cm long (1 in. dia-
Sample Size

meter x 1in. long)

Stem Intrusion Volumes  0.38,1.1,1.7,3.1,and 3.9 mL

Physical
Height 143 cm (56.251n.)
Width 54.3cm (21.38in.)
Depth 78 cm (30.75in.)

Weight (9600 and 9610) 227 kg (500 Ib)
Weight (9605 and 9620) 250 kg (550 Ib)

AutoPore V Series Operator Manual
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Computer Requirements

Operating System Windows 10 or higher operating system is required.

The application should not be installed on a network drive with
shared access.

Multiple users cannot operate the application at the same time.

Desktop Installation Ensure the "Sleep" setting on the desktop is set to

Required "Never" to avoid interruption while running an analysis.
If this occurs, the application loses network
connectivity with the instrument and a communications
error will be reported. A restart of the Windows
application may be required if automatic reconnection

is not successful.

If the computer is to be connected to a network, two Ethernet ports
are required. If more than one Ethernet-based unit is connected to
the same computer, an Ethernet switch will also be required.

10Base Tor 100 Base T
Ethernet Port

All application users will need Read/Write permission to all

RIS e directories and subdirectories where the application is installed.

Drives USB port

Due to continuous improvements, specifications are subject to change without notice.
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El micpomeritics® 2 About the Software

2 ABOUT THE SOFTWARE

The analyzer allows other computer programs to run while an automatic operation is in progress.
The Help menu provides access to the online operator manual.

Report options can be specified when creating the sample file. When running an analysis, data
gathered during the analysis process are compiled into predefined reports. Reports can also be
defined and generated after an analysis has been run. Each selected report is displayed on its
own tab and reflects data collected during the analysis.

The MicroActive feature offers a Windows interface with an easy way to collect, organize, archive,
reduce raw data, and store sample files for later use. Scalable and editable graphs and copy and
paste graphics are easily generated. Customized reports can be viewed on a computer monitor,
printed, or exported for use in other programs.

In addition to customizable standard reports, user-defined calculations and reports can be created
through the Advanced reports feature (using Python).

Data can be manipulated and displayed interactively using MicroActive reports.

MENU STRUCTURE

All program functions use standard Windows menu functionality. The title bar contains a Unit [n]. If
multiple analyzers are installed, ensure the appropriate unit is selected before continuing.

Main Menu Bar Options

Selections Description

File Use to manage files used by the application — such as sample files, ana-
lysis conditions files, report options files, etc.

Unit [n] Use to perform analyses, calibrations, and other analyzer operations. Unit
[n] displays on the menu bar for each analyzer attached to the computer.

Reports Use to start or initiate reports and view the results.

Options Use to change presentation options, set the method and active metals

defaults, configure signal calibration, manage libraries, select units, and
create report styles.

Window Use to manage open windows and display a list of open windows. A
checkmark appears to the left of the active window.
Help Use to access the embedded operator manual, Micromeritics web page,

and information about the application.

AutoPore V Series Operator Manual
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[M] micromeritics®

COMMON FIELDS AND BUTTONS

The fields and buttons in the following table are located in multiple windows throughout the
analyzer application and have the same description or function. Fields and button descriptions not
listed in this table are found in tables in their respective sections. All entry fields will accept
information when using a bar code reader.

Common Fields and Buttons

Selections

Description

Add

Adds an item to the list.

Add Log Entry

Use to enter information that will display in the sample log report that
cannot be recorded automatically through the application. Click the but-
ton again to enter multiple log entries.

Append Use to insert one row at the end of a table.

Autoscale When enabled on report parameters windows, allows the x- and y-axes
to be scaled automatically. Autoscale means that the x- and y- ranges
will be set to show all the data. If Autoscale is not selected, the entered
range is used.

Axis Range On report parameters windows, the From / To fields are enabled when

Autoscale options are not selected. Enter the starting and ending val-
ues for the x- and/or y-axes.

Bar Code (default field

Use to enter additional information about the sample, such as a sample

label name) lot number, sample ID, etc.

Browse Searches for afile.

Cancel Discards any changes or cancels the current process.

Clear Use to clear the table entries and display only one default value.

Close Closes the active window and displays a prompt to either accept or
reject changes.

Close All Closes all active windows. If changes were made and not yet saved, a
prompt displays for each changed file providing the option to save the
file.

Comments Enter comments to display in the report header about the sample or
analysis.

Copies Selects the number of copies to print. This field is only enabled when
Print is selected.

Delete When working with tables, deletes the selected information.

Destination Selects the report destination.
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Iml micromeritics® Common Fields and Buttons

Common Fields and Buttons (continued)

Selections Description

Edit When working with report parameters, highlight the item in the Selected
Reports list box and click Edit to modify the report details.

Exit Exits the application. If a file is open with unsaved changes, a prompt
displays the option to save the changes and exit or exit the application
without saving the changes. If an analyzer is currently operating, an
additional prompt displays to confirm exiting from the software.

Export Exports data in a sample file as a .TXT, .XML or .XLS file. When saved
to a file, the data can be imported into other applications.

File Selects the destination directory. Enter a new file name in the File
name field or accept the default. Select to save the file as a spread-
sheet (.XLS), a portable document format (.PDF), or an ASCI| text
(.TXT) file format.

File name Selects a file name from the list shown or enter a file name. If the
required file type is not shown, select the type of file from the list.

From/ To Indicates the From and To range for x- and/or y-axes when working
with report parameters windows.

Insert Inserts one row above the selected row in the table.

List Creates a list of samples or other types of files. The list will contain the
file name, date/time the file was created or last edited, file identification,
and file status.

Name Contains a list of files in the selected directory or library.

Next Moves to the next window or next step.

OK Saves and closes the active window.

Open Opens the selected file. Alternatively, double-click the file name in the
Name column to open the file.

Prev Moves to the previous window.

Preview Previews predefined reports. Click the tabs at the top of the window to
preview each selected report. When an analysis has not been run on a
sample, this button is disabled.

Print Sends the report to the selected destination (screen, printer, or file).

Remove Removes the selected file or files from the list.

Replace Selects another file where the values will replace the current file’s val-

ues.
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[M] micromeritics®

Common Fields and Buttons (continued)

Selections Description

Replace All Selects another .SMP file where the values will replace all values for
the active sample file. The original file will remain unchanged. No
analysis data is added to the file. The only information added is sample
information, material properties, liquid properties, analysis, and
reporting parameters.

Report Displays a window to specify report output options.

Save Saves changes.

Save As Saves a file in the active window under a different file name. A portion
can be saved as a separate, stand-alone file, such as Analysis Condi-
tions or Report Options, when saving sample information.

Start Starts the report, test, analysis, or operation.

Start Date Displays a calendar to select the start date for the report.

View Operation. Displays the data from the current analysis.

Instrument Log. Displays recent analyses, calibrations, errors, or

messages. Enabled only in Service Test Mode.

Instrument Schematic. Displays a schematic of the analyzer system.
5.4 AutoPore V Series Operator Manual
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File Status

FILE STATUS

In the File Selector window, the Mic Description column and the Mic Status column display the file
description and file status. The File Selector incorporates standard Windows features for resizing
windows, reordering and repositioning columns, and right-clicking an entry to display a menu of

standard Windows functions.

File Status

File Status

Description

Analyzing

Sample files that are currently used for analysis.

HP Complete

® A high pressure analysis has been performed using this sample

file.

A low pressure analysis must be performed on a sample before a
high pressure analysis can be performed. Files with the status HP
Complete have finished one low pressure analysis and at least one

high pressure analysis.

Multiple high pressure analyses can be performed on a sample, so
files with the status HP Complete may have finished more than

one high pressure analysis.

LP Complete

A low pressure analysis has been performed using this sample file.
(Only one low pressure analysis may be performed on each file.)

No Analysis

Sample files that have not been used to perform an analysis.

File Type and File Name Extension

File Type File Name
Extension
Analysis Conditions ANC
Methods .MTH
Penetrometer .PEN
Report Options .RPO
Sample Information .SMP
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[M] micromeritics®

File Types for Printing or Exporting

File Type

File Name Extension

Portable document
format

.PDF

Extensible markup lan-
guage

Report .REP
Spreadsheet XLS
Unicode TXT

XML
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KEYBOARD SHORTCUTS

Shortcut keys can be used to activate some menu commands. Shortcut keys or key combinations
(when applicable) are listed to the right of the menu item.

Certain menus or functions can also be accessed using the Alt key plus the underlined letter in the
menu command. For example, to access the File menu, press Alt + F, then press the underlined
letter on the submenu (such as pressing Alt + F) then pressing O to open the File Selector).

/ If the underscore does not display beneath the letter on the menu or window, press
the Alt key on the keyboard.

Keyboard Shortcuts

Selections Description

Alt +[Unit n] Opens the Unit [n] menu.

Alt + F4 Exits the program. If files are open with unsaved changes, a prompt to
save changes displays.

Alt+H Opens the Help menu.

Alt + 1 Opens the Options menu.

Alt + R Opens the Reports menu.

Alt +W Opens the Window menu.

Ctrl + N Opens a new sample file.

Ctrl+ O Opens the File Selector window.

Ctri+P Opens the File Selector to start a report from a selected .SMP file.

Ctrl + S Saves the open file.

F1 Opens the online help operator manual.

F2 Opens the File Selector window.

F3 When in the File Selector window, opens the file search box.

F4 When in the File Selector window, opens the address bar.

F6 Cascades open windows.

F7 Tiles all open application windows.

F8 Opens the File Selector to start a report from a selected .SMP file.

F9 Closes all open reports.

Shift + F9 Opens the shortcut menu of either the selected component on the ana-
lyzer schematic when manual control is enabled or the onscreen reports.
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[M] micromeritics®

OPTION PRESENTATION

Options > Option Presentation

Use to change the way sample files and parameter files display: Advanced, Basic, or Restricted.
Each display option shows sample information and options differently.

Option Presentation Display

Presentation Display

Description

Advanced

Displays all parts of sample and parameter files. Navigate to para-
meter windows by selecting the tabs across the top of the window.

Basic

Displays sample information in a single window. This display option
is used after the parameter files have been created. The previously
entered or default parameter files are then accessible using drop-
down lists.

Restricted

Displays the sample file in a single window like the Basic display
option with certain functions disabled. A password is set when the
Restricted option is selected. That same password must be entered
to change to the Basic or Advanced display option. This display type
is typically used in laboratories — such as the pharmaceutical
industry — where analysis conditions must remain constant. The
Advanced option is not available in the view selector at the bottom of
the window when using the Restricted display option.

Show Splash Screen

Enables (or disables) the splash screen upon application startup.

/ To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.

The following examples show the same sample file in Advanced and Basic display. Basic and
Restricted displays will look the same. A password is required if using Restricted format.
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Option Presentation

Option Presentation Examples

Mew File =
Samgie Anadyss Report
Descrigtion Conditioes Options
Method:  Default
Sample: | 000-007
Operator
Sabeniter
Bar Code
Material; | Garnet Edt
Penetrometer: | #2222 - 0 oc B, 0,000 cc MMV, Sobd o
Penetreenter mas 1.0000 | g Correction methed: None
Sarmiple mass 10000 | g
2 1 Assermbly Mats s the Sample + PTG + MERCUTY
HPPLEY e 9 mass after the low pressre anslysis
Type of Dets User Parameters
) Avtomatcally collected Parameter | 0.000
Marvaalty entered Parameter 2 0000
Parameter 3 U000
Comments:
Add Log Entry
Replace AL
Save As OCose Advenced ~

oo )

Advanced view

Method: | Default

Sample: |

Material:

Penetrometer:

e e a——

ot s [

* Assembly mass is the sample + penetrometer +mercury
sosemblymess: | o sk e on pressurs anchv.

Analysis Conditions: |Run Conditions.

Report Options: | Default Report Options ~
Add Log Entry Replace All...
Save Close Basic ~ Preview

Basic or Restricted view

A sample file must be created for each analysis. The file can be created prior to or at
the time of analysis. The sample file identifies the sample, guides the analysis, and

specifies report options.
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LIBRARIES

Options > Manage Libraries

/ This feature is not available when using Restricted option presentation.

Manage Libraries it

Adsorptive Properties ~ Manage

Close

The library provides an easy way to locate and open specific analyzer files. Libraries are located
within the File Selector window and can be viewed only within the application.

The library gathers sample and parameter files stored in multiple locations, such as folders on a C:
drive, a network location, a connected external hard drive, or a connected USB flash drive, and
provides access to all files. Even though libraries do not store actual sample and parameter files,
folders can be added or removed within each library.

One library can include up to 50 folders. Other items, such as saved searches and search
connectors, cannot be included.

When removing a folder from a library, the folder and its contents are not deleted from the original
file storage location. However, when deleting files or folders from within a library, they are deleted
from their original file storage location. Deleted files and folders can be recovered from the
Recycle Bin located on the Windows desktop.
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METHODS

File > New Method
Options > Default Method
File > Open > [ MTH File]

A Method determines the default sample identification format and sequence number. A Method is
a template of specifications that go into a newly created sample file. It allows for the definition of
complete sets of parameters for each type of sample commonly analyzed. Only a single selection
is required for each new sample file created.

The Method drop-down list displays only those methods applicable to the open sampile file type.

= ) ek
= . | o e - 3 poit =
- = | (o= )
Default Method Sample Information file
Default Methods
Selections Description
Sample file name Enter a format for the sample identification. The entry in this field
[text box] becomes a part of the saved sample file name. Include the $ symbol
to have the sample file number included as part of the identification.
Sample These field labels may be renamed, and the new label becomes a
Operator part of all new sample files.
Submitter
Bar Code [text box]
Sequence Number Specify a default numeric string to use as a prefix in the Sample field
[text box] when a new sample file is created. This number increments with
each sample file created.
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CONFIGURE THE ANALYZER

ATMOSPHERIC PRESSURE

Options > Atmospheric Pressure

For accurate analysis, the application must adjust pressure measurements to account for
variations in local atmospheric pressure (barometric pressure).

Atmospheric pressure:

Default Atmospheric Pressure

14.700

| Determine high pressure transducer offzet

=)

psia

ok |

| Cancel

Enter a value between 10,000 and 20.000.

Enter the current atmospheric pressure or accept the system default of 14.7 psia (0.1014 MPa).
When the portis open, it is recommended to enter the value on the low pressure display. It is
recommended to enter the current atmospheric pressure daily (or more frequently if atmospheric
pressure rises or falls rapidly during the day).

Select Determine high pressure transducer offset to enable the system to determine automatically
the high pressure transducer offset.

If the atmospheric pressure is above the entered value and the Determine high pressure
transducer offset option is selected, a warning will display.
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EI micromeritics® Measured Temperature Warning

MEASURED TEMPERATURE WARNING

Options > Warnings

Enable this option to have the analyzer automatically display a warning if the measured
temperature rises above the entered temperature.

Warnings @

[]Warn if the measured kemperature is above 250 °C

Ok Canicel

Enter avalue between 10,0 and 40,0,

UNIT SELECTION

Options > Units

Use to specify how data should appear on the application windows and reports. This menu option
is not available if using Restricted option presentation in a standard installation environment.

==

Pore Size @) diameter " radius

Pare Length @) pm _inm = A
Pressure Unit I MPa @) psia

Cumulative Values _) Coarser '@ Finer

Intrusion Volume @ mLfg ~) mm3/g

[ OK ] l Cancel ]
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UNIT CONFIGURATION

Unit [n] > Unit Configuration

Use to display and confirm hardware and software configurations and calibrations of the analyzer.

Software Versions
Controller Boot ver: Boot Block
Controller Application:  Application
Waorkstation: -k B A
Configuration
IP address:  192.168.77.3
Serial #: 102
Type: -
Calibration
Low Pressure servo.
Signals:
Unit Configuration
Selections Description

Calibration [group box]

Displays calibration information for analyzer components.

Configuration
[group box]

Displays the IP address used by the analysis program, serial
number, and type of analyzer.

IP address. Displays the IP address of the analyzer.

Change IP. Displays the Board ID dialog, which describes the circuit
boards in the analyzer. Use the Board drop-down list to select a
board to view.

Board ID. Click to display information from the circuit boards in the
analyzer. Use the drop-down list to select a board to view. The
parameters shown cannot be edited.

Software Versions
[group box]

Displays the software versions of the controller start up code,
analysis program, and type of analyzer.

For fields and buttons not listed in this table; see Common Fields and

/

Buttons on page 2 - 2.
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[M] micromeritics®

INSTRUMENT STATUS

SHOW INSTRUMENT SCHEMATIC

Unit [n] > Show Instrument Schematic

To operate the valves and elevator from the schematic, manual control must be enabled (Unit [n]
> Enable Manual Control).

' aYd Y
=0 EER ()
%Flle Unitl Reports Options Window Help - |[&] =
| 2h.2 “Cl -
@ %
Intrusion Intrusion
Port Sample Vol. (ml) %o Stem Port Sample Vol. (ml) % Stem
- — [k S50
3 0.000 %o ptatus:  Idle Pressure: 0.000 MPa
4 0.000 %a Idle
Status:  Idle Pressure: 0.0000 MPa
‘Idle
Low Pressure High Pressure
. AN v
Analyzer Schematic Icons
Icon or Symbol |Description
. Open Valve. Green indicates an open valve.

Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.

Servo Valve. Closed.

S
@
<

Servo Valve. Open.
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Low Pressure Schematic Icons

Mercury Degasser. Displays the mercury level.

| m E .';5.:5. .

Drained Partially Filled Filled Overfilled. This alarm
displays

with a red background.

This is an alarm state.

Mercury Trap. Displays the state of the mercury trap.

| ¢

Empty Contains more than 6 mm of mercury.
This is an alarm state.

Mercury Reservoir. Displays the level of mercury in the reservoir.

e -

If the mercury level is low, see Maintain Mer- Level is OK.
cury Level on page 11 - 16.

Hg Reservoir Vacuum Switch
When illuminated, indicates that mercury reser-
Evacuated

voir has been evacuated.

Low Pressure Ports
Indicates that the mercury fill sensor detects mercury.

Indicates a rod and capacitance detector are present (detector
reading is less than -5 pF).

Indicates there is no mercury, but the capacitance detector is on
with either a rod or a penetrometer.

Indicates there is no capacitance detector and penetrometer or
rod in place.

O © @ @&
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Iml micromeritics® Show Instrument Schematic

High Pressure Schematic Icons

Hydraulic Pump

When the pump is operating, the target pressure
displays below the icon. A green icon indicates
the pump is ON. A yellow icon indicates the pump
m is OFF. To set the target pressure when the icon
is yellow, either double-click the pump icon or
right click the icon and select Set.

Intensifier. Displays the state of the intensifier limit switches.

Midway Top Bottom
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Instrument Schematic Shortcut Menus

Each manually controlled schematic component has a shortcut menu displaying the operations
available for that particular component. To access the shortcut menu, hover the mouse pointer
over the component and right-click.

Schematic Shortcuts

Icon Available Options:

Valve options Automatic. Automatically operates the servo valve during dosing or
evacuation. Enter the target pressure.

%ﬂ Close. Closes the selected valve.

Disable. Select to disable the servo pump. To enable the pump,
right-click the servo pump icon and select Set to verify or set a target
temperature. When the pump is enabled, the target temperature
displays below the servo pump icon.

Open. Opens the selected valve.

Pulse. Use to quickly turn the valve on and off allowing the operation
to proceed in small increments.

Set. Use to set the servo pump target pressure.

SHow STATUS

Unit [n] > Show Status

Use to show the current status for each port.

5 Status =N Bl >
Intrusion Intrusion
Port Sample Vol. (mL/g) % Stem Port Sample Vol. (mL/g) % Stem
1 0.000 1 0.000

2 0.000 2 0.000

3 0.000 Status: Idle Pressure: 0.0 psia
4 0.000 Idle
Status: Idle Pressure: 0.00 psia 8

Idle.

If multiple units are attached to the computer, select Show Status on each Unit [n] menu. The
status for all units displays.
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SHow DASHBOARD

Unit [n] > Show Dashboard
The dashboard displays the following:

Number of days until low pressure system service is due
Days until high pressure system service is due

Days until Hg filter replacement is due

Low pressure manifold outgas rate

Hg temperature (°C) mean +20, min/max

High pressure cycles completed

Low pressure analyses completed / started

High pressure analyses completed / started

Data for the dashboard comes from the logged diagnostic data. The dashboard is automatically
kept current as the relevant diagnostic data items are updated. The gauges will be updated even if
the dashboard window is not open.

31 Dashboard =8 ESE )

364

Days unti kow pressure
system service i

isdue

27.78 £0.94
27.04/28.40

Hg tempersturs (°C) mean £ 20,
‘min/max

/ Red numbers on the dashboard require attention. To reset the dashboard numbers,
right-click on the dashboard setting, then click Reset.

Dashboard Gauges

Selections Description

Days until high The number of days until service is required on the high pressure sys-
pressure system tem. When the displayed value is 30 or less, the value is displayed in
service is due red. Red negative numbers display if maintenance is past due.

Days until Hg filter The number of days until the mercury filter replacement is due. When
replacement is due the displayed value is 30 or less, the value is displayed in red. Red

negative numbers display if maintenance is past due.

Days until low pressure | The number of days until service is required on the low pressure sys-
system service is due |tem. When the displayed value is 30 or less, the value is displayed in
red. Red negative numbers display if maintenance is past due.

AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022




2 About the Software

[M] micromeritics®

Dashboard Gauges (continued)

Selections

Description

Hg temperature

Displays the statistics of the manifold temperature reading. The
mean, the value at two standard deviations, the minimum, and the
maximum display.

High pressure analyses
completed / started

Displays N/M where N is the number of high pressure analyses that
have finished data collection and M is the number of analyses that
have been started. Analyses canceled or terminated by errors before
the termination stage starts are not counted as completed.

High pressure cycles
completed

Indicates the number of completed high pressure cycles. Cycles can-
celed or terminated by errors before the termination stage starts are
not counted as completed.

Low pressure analyses
completed / started

Displays N/M where N is the number of low pressure analyses that
have finished data collection and M is the number of analyses that
have been started. Analyses canceled or terminated by errors before
the termination stage starts are not counted as completed.

Low pressure manifold
outgas rate

Provides the qualitative indication of the outgas rate in the dosing
manifold. LED images constitute a bidirectional bar graph of the
outgas rate.

® Three green LEDs are lit if outgas rate is below 30% of outgas rate
limit.

® At 30%, the left LED turns off.

® At 60%, the center LED turns off.

= At 90%, three green LED lights turn off and the center yellow
LED is turned on.

= At 110% and above, only the red LED is lit and attention is
required.

2-20
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SHOW INSTRUMENT LOG

Unit [n] > Show Instrument Log

Use to display a log of recent analyses, calibrations, errors, or messages. The log displays:

® 7 days of analysis data
® 30 days of messages
®m 30 days of calibration data

.”1¢| Untl Raports Optiom Window Help - -.::J-§.

Instrument Log

Selections Description

Add Log Entry To manually enter information into the log file, enter the text into the
text field to the left of the Add Log Entry button, then click Add Log
Entry.

Analysis /

Calibration / ,

Message / Select the logs to display.

Conductivity

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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EXPORT FILES

File > Export
Exported Data Example on page H - 1

Provides the option to print the contents of one or more sample or parameter files to either the
screen, a printer, or a file. Data can be exported as a .PDF, .TXT, .XML, or .XLS file format. The
type of data to include or exclude can be selected during the export process. The data can be
imported into other applications that read these file formats when exported to afile.

1. Click Listand open an .SMP file.
2. Select an experiment and the applicable options.
3. Click OK.

; Dynamic Analysis Export Options x
|

Selected experiments

| B : Cull TPR 50 scom H2As

. Inchide peak data < Inchide measurements
= Normakze by mass Report calbrated values
~| Inchude labels ~| Report at o specified time interval
< Inchide options 0.02 | seconds per measurement
! Include experiment kst | Selact & tme range
=) Inchde semple g Stmrting tme: 0.00 | min
Ending time: 0.00 | min
Destnation
Freve
Print
& Fle: C\wtoChem [ITdata\, (]

Fie nype: Spresdsheet (")

oK | Cancel
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[M] micromeritics®

List Files

LiST FILES

File > List

Provides the option to create a list of sample file information —such as file name, date, time the
file was created or last edited, file identification, and file status.

Select one or more files from the file selector, click List, then provide the file destination.

File Listing
No. File Name Date Time Description Status

1 13x with CO2 at 0C Port 1B.SMP 8/10/2020  3:53:54 PM 13x with CO2 Port 1 Complete

2 13x with CO2 at 0C Port 2B.SMP 8/10/2020  3:53:54 PM 13x with CO2 Port 2 Complete

3 13x with CO2 at 0C Port 3B.SMP 8/10/2020  3:53:54 PM 13x with CO2 Port 3 Complete

4 13x with N2 and TranSeal Port 8/10/2020  3:53:54 PM 13X Zeol Tube 2 w/ FS @ end of Complete
2.SMP analysis, Port 2

S 13x with N2 and TranSeal Port 8/10/2020  3:53:54 PM 13X Zeol Tube 1A w/ FS @ end of Complete
3.SMP analysis, Port 3

6 Activated Carbon with Butane C3 8/10/2020  3:53:55 PM Activated Carbon Tube C3 Butane Complete
Port 1.SMP Port 1

7 Activated Carbon with Butane C4 8/10/2020  3:53:55 PM Activated Carbon Tube C4 Butane Complete
Port 3.SMP Port 3

Example of
File List
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2 About the Software EI micromeritics®

SOFTWARE UNINSTALL

The software can be uninstalled in two ways. Either method removes only the files required to run
the software, not the analysis files.

m Click the Windows Start icon. Scroll to the Micromeritics entry. Select the Uninstall [analyzer]
option, then follow the prompts.

® | ocate the uninstall.exe file in C:\Program Files (x86)\Micromeritics\[analyzer name] (or
wherever the application was installed). Double-click the uninstall.exe file, then follow the
screen prompts.

SOFTWARE UPDATES

all components of the Micromeritics application are correctly installed. If UAC is not

/ A User Account Control in the Windows operating system must be enabled to ensure
enabled, right-click the setup.exe installer file and select Run as administrator.

The most current version of the instrument software can be found on the Micromeritics web page
(www.Micromeritics.com).

When performing a software update, existing data files are not overwritten.

Insert the setup media into the media drive. The setup program starts automatically. If the
program does not start automatically, navigate to the installation media drive, locate and double-
click the setup.exe file.
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[M] micromeritics’ 3 Sample Fies

3 SAMPLE FILES

Option Presentation on page 2 - 8

Sample files include the information required by the analyzer to perform analyses and collect data.
A sample file identifies the sample, guides the analysis, specifies report options, and may be
displayed in Advanced, Basic, or Restricted presentation display mode. After data is collected, the
file is shown in MicroActive mode or the tabbed file editor.

A sample file consists of parameter sets; however, parameter sets can also stand alone. A sample
file may be created either before or at the time of analysis.

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sampile file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

The analysis application contains a default method. A method is a template for sample files that
contains the parameters to be used for an analysis. When a new sample file is created, all the
parameters are filled with the values in the default method.

/ To change the view for the selected window, use the drop-down list at the bottom of
the sample file editor.
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3 Sample Files [M] micromeritics®

CREATE SAMPLE FILES

Options > Option Presentation > [Advanced / Basic / Restricted]

File > New Sample
File > Open > [.SMP File]

Each analysis must be linked with a sample file before the analysis can proceed.

Specify or change the option presentation by selecting Options > Option Presentation, or use
the view selector drop-down list at the bottom of the window.

The values for individual parameters in a file must be initially entered in Advanced mode and the
file saved. Sample files can then be created in Advanced, Basic, or Restricted mode by selecting
predefined Methods or Analysis Conditions and Report Options.

The values specified in the parameter portions of the default sample file are saved as the defaults
for new sampile files. To navigate from one set of parameters to another, select the parameter tab
across the top of the window.

= |
o Untl Reports  Ope Window  Help fFox
Sk anayan | _:;‘l‘
T ; i |
S o0 D Fie Unz] Bepote Opticns Window Help el
X A Metod: | Dedact
Submither: Sarvphe: 0000
Barrrces Materl:  Gamet
MFeria . e Lo Penewometer: | #aeas -0 oo (b, 0,000 o2 MMV, Gokd
o T -
Pereromene mass: 0000 g et ‘Sample mass: L0000 g
g e 00 P . 'Mwm:wsﬂw:‘m:mw—wun
_ : e et o
P e aftex the ko presare anafyia. Arabyel Conblirs:
Tyee of Duta ey Parameters. feport Optons:  Dedault Report Optors
Autryrancaly colected ey 2,000
Marualy entered et 000 Aadd Log Brary Heplace Al
ot 000
s
Add Log Ent
— = =
Repiace Al
Save ks Oose: cvarced
Advanced option presentation Basic option presentation
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EI micromeritics® Create Sample Files

Sample Files

Selections Description

Assembly mass This field is entered after the low pressure analysis is completed.

[text box] Sample + penetrometer + mercury mass after the low pressure ana-
lysis.

Bar Code [text box] Use to enter additional information about the sample, such as a
sample lot number, sample ID, etc.

Comments [text box] Enter comments to display in the report header about the sample or
analysis.

Material [drop-down box] | Select the material to be analyzed from the drop-down list.

Method [drop-down box] | Select a method from the drop-down list.

Operator [text box] Enter operator identification information. This field label may have
been renamed or may not display if modified in Options > Default
Methods.

Penetrometer Select a penetrometer file from the drop-down list, or click Edit to

[drop-down box] modify or create a new Penetrometer file.

Penetrometer mass Enter the mass of the penetrometer.

[text box]

Sample [text box] Enter a sample description.

Sample mass [text box] | Enter the mass of the sample.

Submitter [fext box] Enter submitter identification information. This text box may have
been renamed or may not display if modified in Options > Default
Methods.

Type of Data [group box] | Automatically collected. Select if the type of data will be
automatically collected by the system while an analysis is running.

Manually entered. Use to enter data manually that was collected
from another source. If Manually entered is selected, the Intrusion
Report becomes available in the Basic/Advanced drop-down list for
pasting or importing data into the file.

User Parameters These fields are primarily used for the SPC (Statistical Process
[group box] Control) reporting to specify sample characteristics or its
manufacturing process but may be used for other data by entering
specific analysis conditions or sample criteria. The entered
parameters display on the SPC Report.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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3 Sample Fies [M] micromeritics®

OPEN A SAMPLE FILE

File > Open > [.SMP File]

/ When working with an existing sample file, consider copying the sample file to
maintain the original configuration options.

File Type File Status Displays
Analyzing
Entered Tabbed file editor
Mercury Porosimetry No analysis
HP Complete MicroActive report window
LP Complete P
e —
- ===
i L. —p—
'E?[. .5-0 s
1
Tabbed file editor in Example of a Report window

Advanced view

To view the tabbed file editor for a sample file with a Complete status, select Advanced from the
view selector drop-down list at the bottom of the window.
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SAMPLE AVERAGING

File > Average

A sample file can be created in which the collected data are the average of up to four similar
analyses. All information in the new sampile file will be the same as in the first selected file except
for the information entered in the Sample Averaging window. The collected data in the file will be
the average of the data in the selected files.

Sample averaging can be used for sample files and blank correction files.

==
Sample 1: Clear

Clear

I
]

Sample 2: Browse...

Sample 3: Browse... Clear
Sample 4: Browse... Clear

Cancel

BASELINE ERROR CORRECTION METHODS

The penetrometer parts, the mercury, and the sample are all affected differently by the pressures
exerted on them during analysis. Each material compresses to a different degree and at a
different rate. Also, the increasing pressure within the high pressure port can cause the
temperature of one or more of these materials to rise.

As a result, analysis data may show intrusion where none actually exists. For example, if the
sample compresses sharply at a given pressure (compared to the compression of the mercury at
that pressure), mercury moves from the penetrometer stem into the sample bulb to fill the space
vacated by the shrinking sample. This reduction in the amount of mercury in the stem is
interpreted by the software as intrusion.

These baseline errors can be reduced or eliminated through one of two correction methods:

® formula correction, and
® blank correction

The correction method is selected in the Penetrometer Properties file and displays in the Sample
file.
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3 Sample Files [M] micromeritics®

CREATE BLANK CORRECTION FILE

File > Open > [.SMP file name]

A sample file must be created even if there is no sample or if the sample is non-porous.

A blank correction file contains analysis data using one of the following:

= Mercury only (a blank run)
= A nonporous sample of the same mass and material as the samples to be analyzed

and penetrometer properties as the sample analysis. Therefore, a separate blank cor-
rection file should be created for each type of sample and set of analysis conditions to
be used.

/ To be used as a correction file, the blank run should use the same analysis conditions

No matter which type of blank correction run is used, the procedure is the same (follow the
instructions for creating a sample file (even if there’s no sample), then run the analysis. (When the
blank file’s sample file is created, select None for correction method.)

1. Create the sample file. Enter zero for the sample mass.
2. Perform the low and high pressure analysis.

/ An alternative method for creating the blank correction file is to perform a High Pres-
sure Differential analysis which analyzes the blank and sample simultaneously.
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EI micromeritics® Formula Correction

FORMULA CORRECTION

A formula for correction is available for each type of penetrometer. The formula is a part of the
application software, therefore when the Formula option in the Penetrometer Properties file is
selected, the formula is applied.

The recommended method of correction is by blank correction file. The formula is provided for use
when comparison with historical data is required.

COMBINE A PENETROMETER CALIBRATION AND BLANK CORRECTION FILE

1. Calibrate the penetrometer. Enter the analysis conditions and pressure table to be used
when samples are analyzed with this blank correction file.

2. After the low pressure run, do not empty the penetrometer. Weigh it and record the
assembly mass. Use a syringe to withdraw a small amount of mercury from the tip of the
capillary so that the mercury column recedes approximately 1/8 in. to 1/4 in. into the stem.
This enables measurement of any rise or fall of mercury in the stem during high pressure
analysis and prevents spilling of mercury into the high pressure chamber. Then install the
penetrometer in a high pressure port.

3. Create blank correction files by completing the high pressure run.

4. Create a new Penetrometer Properties file for this penetrometer.. From the file selection list,
choose the default file for this type of penetrometer. Change the identifier to include the pen-
etrometer serial number. Enter the calibrated volume and save the file. The Penetrometer
Properties file now includes the calibrated penetrometer volume. A blank correction file has
also been created for this penetrometer.
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3 Sample Files [M] micromeritics®

MANUALLY ENTER DATA

This process allows the manual entry of pressure data from a sample file with a Complete status.
There are two methods for manually entering data into a sample file:

= Copy and paste onto the graph area of the interactive window.
= |mport data into the interactive window.

CoPY AND PASTE MANUALLY ENTERED DATA

/ To display the file status in a search window, go to File > Open. Right-click the
column header then click More... Scroll to the MIC entries and enable MIC Status.

1. Open a sample file with a Complete status. The file will open in the interactive reports win-
dow.

2. Right-click in the graph area of the interactive reports window, then select Copy data.

= o Ex|
Intrusion
i 5
=) 8
X 2
@
8 2
E [
= Pz
g g
= e Include report L. @
5 02 ¢ i |
E Paste Data E
o Edlit imported data, &
v Display imported data
A vty o [FID=rsity
Autoscale all wes Elston ncrementai
Reset axis limits to initial setting
Showr curs
Edit cury
)
Eclit wxis 3
2 04
Edit legend =
5
it il g
Copy graph =
2
Copy inS T
E
Copy data H
0 ==
01 100 100,000
Pressure (psia)
5 Cle Intrusion Previer

Example of Report window

3. Open another sample file using the Advanced option presentation.
4. Onthe Sample Description tab, select Manually entered in the Type of Data group box.
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El micromeritics@‘ Manually Enter Data

5. Inthe view selector drop-down list at the bottom of the window, click Advanced, then select
Intrusion.

=

Intrusion Blank Correction | Nane
10 1.0
o e T ntrusion Data Opions...
&
? O Receding contact angle: 130.000 | *
E
t &
B § Intrusion |First
2 2
E 0. s 5 Exrusion Firt
P E
= & Overlay |Log Differential Intrusion
B g
3 2
E F | tmport.. Paste
a (s
=
0.0 - i - - . 4 . 0.0 [Cloensity
1,808,636 1,608,635 =
Pore size Diameter (nm) L1 Show Bcomertor
Summary 1
Total intrusion volume at 0,10 psia: 0.0000 mLig
Total pore area at 0.10 psia: 0.000 mg
Median pore diameter (volume) at 0.10 psia and 1,808,635.38 nm 5
0.000 mLig: 2
Median pore diameter (area) at 0,10 psia and 1,805,635.38 nm £
0.000 méig: s
Average pore diameter (4V/A): 0.00 nm ]
Bulk density a1 0.10 psia; — o
Apparent (skeletal) density at 0.10 psia; - =
Porosity: - :
=
Warning 6017- The Assembly mass, 2
Sample mass, Penetrometer 3
mass or Penetrometer
volume may be incomrect.
Please verify thete
e, 01 100 100,000
Pressure (psia)
Sove As Qlose Intrusica v Preview

6. Ensure that all parameter fields are set appropriately, then click Paste.
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[M] micromeritics®

IMPORT MANUALLY ENTERED DATA

When importing data from an external ASCI|I text file using the Import button on the interactive
window, the ASCII text file must use the following rules:

ASCII text file format rules

Data must be in two columns and separated by a comma or white-space. Acceptable column
headings are:

Pressure (psi)
Pressure (MPa)
Pressure (kPa)
Pressure (Pa)
Pressure (bar)
Pressure (mbar)
Pressure (Atm)

= |ntrusion (cm3)

® |ntrusion (cm3)
® |ntrusion (mL)
= |ntrusion (mm3)

= |ntrusion (mm3)

Sample Mercury Porosimetry ASCII Text File

Cumulative Intrusion for Cycle 1

Pressure (MPa) Cumulative

Intrusion (cm?3/q)

0.138151 0.0
0.155414 0.00637965
0.310025 0.0327685
0.458529 0.0377315
0.816881 0.0411021
1.46145 0.0427142
2.60941 0.0444728
4.00728 0.0460848
5.35594 0.0474771
7.24049 0.0495286
9.63008 0.0519466
13.7208 0.0561233
24.4012 0.0808897
46.6833 0.800216
83.4181 1.15068
159.718 1.1586
286.294 1.16834
412.525 1.17574
310 AutoPore V Series Operator Manual
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To import the ASCII text file

1. Open a new sample file in Advanced option presentation.
2. Onthe Sample Description tab, select Manually entered.
3. Inthe view selector drop-down list at the bottom of the window, click Advanced, then select

Intrusion Blank Correction  None
1.0 1.0
E Advandng contact angle: | 130,000 Inkrusion Data Options...
&
Ién O Receding contact angle: 130,000 |*
: g
) § Intrusion | First A
g2 &
R 05 5 o -
.g E Owerlay  Log Differential Intrusion -
5 g
E =2
E F | tmpot.. Paste
O =y
-
0.0 . + . - . + . 0.0 [l Density
1,808,636 1.808.635 St bicrersiintil
Pore size Diameter (nm) =7
Summary 1
Total intrusion volurme at 0,10 psia: 0.0000 mLig
Total pore area at 0,10 psis: 0.000 mig
Median pore diameter (volume) at 0.10 psia and 1.808.635.38 nm =]
0.000 mLig: ?_‘]
Medsan pore diameter (area) at 0.10 psia and 1,808,635.38 nm =
0.000 mig: H
Average pore diameter (4V/A): 0.00 nm g
Bulk density a1 0.10 paia: — o T T e L
Apparent (skeletal) density at 0.10 psia; — o f
Porosity: - =
B
Warning 6017- The Assembly mass, g
Sample mass, Penetrometer a
mass or Penetrometer
volume may be incorrect.
Please verify these o
ita | T
bl 0.1 100 100,000
Pressure (psia)
Save As Cose Inbrusica v Preview

4. Ensure that all parameter fields are set appropriately, then click Import.
5. Open the .TXT file. The data from the original sample file is imported and displayed. If an
error message displays instead, verify that the . TXT file format is correct.

AutoPore V Series Operator Manual 3-11
962-42800-01 (Rev E) — Oct 2022



[M] micromeritics

This page
intentionally
left blank




EI micromeritics® 4 Parameter Files

4 PARAMETER FILES

Parameter files allow for repeated use of parameter sets. For example, if the same analysis
conditions exist for multiple analyses, an Analysis Conditions file containing the recurring
conditions can be created. When the sample file is created, the Analysis Conditions file can be
selected for the analysis conditions. Once it becomes part of the new sample file, the new file can
be edited, as needed, without affecting the original Analysis Conditions file.

Methods include both analysis conditions and report options, offering the most convenient way to
repeat most analyses.

Predefined parameter files are included with the program and can be edited as needed, or new
parameter files created.

The following file types can exist as part of the sample file as well as individual parameter files.

Parameter File Types

File Type File Extension
Analysis Conditions ANC
Material Properties MTP
Method .MTH
Penetrometer Properties | .PEN
Report Options .RPO
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4 Parameter Files

[M] micromeritics®

ANALYSIS CONDITIONS

File > Open > [LANC File]

(or click the Analysis Conditions tab when in Advanced option presentation)

Analysis conditions specify the parameters used to guide an analysis.

Anaivus Condsons:  SSAFENTY
Mertary,., | Contactanges Advaecr: 10000 Becedeg: 1300000

Besnaton Fingessre .50 pes

Analysis Conditions

Button

Use to Specify...

Analysis Conditions
[drop-down box]

Use to browse for an Analysis Conditions file that contains analysis
condition parameters to be used in the analysis.

Autocalculate Reverberi
pressures [selection]

Select to have the application automatically use the Reverberi
pressures. Selecting this option disables the pressures table. Click
Options to enter additional Reverberi options.

[E=N EoR Fx™

Minimum pore diameter: 0.00050  pm

Maximum pore diameter:  5,000.00000  pm
Pressure range: 0.04 to 361,727.08 psia

Mumber of cavity sizes: 10

Mumber of throat sizes per decade: 10

Enter a value between 0.00050 and 5,000.00000.

Enter target pressures
[selection]

Select to manually enter pressures into the table.
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El micpomeritics® Analysis Conditions

Analysis Conditions (continued)

Button Use to Specify...
High Pressure Equilibrate by. Select the option for equilibration based on elapsed
[group box] Time (in seconds) or decrease in Rate of intrusion (or extrusion).

Scan by:

® Pressure. The analyzer goes through a sequence of segments
with each segment starting at the end of the previous one. Each
segment ends at the specified pressure. The pressure is pro-
grammed to increase or decrease at a rate to give a constant time
per decade of pressure. Along the way, the analyzer takes intru-
sion points at the specified number of points per decade ending at
the specified ending pressure. Also, any points in the pressure
table as well as points separated by the maximum intrusion
volume, are collected.

® Intrusion. The analyzer goes through a sequence of segments,
with each segment starting at the end of the previous one. Each
segment ends at the specified pressure The pressure rate is the
maximum achievable safe rate (up to 0.5 min/decade) and is pro-
grammed to increase or decrease at a rate to give a constant intru-
sion/extrusion rate. The analyzer takes intrusion points at the
specified number of points per decade ending at the specified end-
ing pressure. Also collected are points in the pressure table as
well as points separated by the maximum intrusion volume.

If both high pressure ports are in use, they may have different
intrusion rates. In this case, the left port (port 1) determines
when data are collected. The right port collects data at the
same times as the left. This allows a differential analysis to be
performed in this mode.

® Hold at maximum pressure. Enter additional amount of time to
remain at the maximum pressure in a pressure table intrusion seg-
ment before beginning extrusion.
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4 Parameter Files EI micromeritics®

Analysis Conditions (continued)

Button Use to Specify...
Low Pressure Evacuation. Select if the sample is a Formed solid, Powder, or
[group box] Other. If Other is selected, the remaining fields are enabled. This

window is also available from Unit [n] > Evacuate Low Pressure.

oo
Sample
") Formed solid
~) Powder
@ Other
Initially evacuate at: 5.0  psiafmin
Switch to medium at:
@) Use pressure transducer
0.00 MPa
_ Use vacuum gauge
10,000
_) Skip medium evacuation
Switch to fast at: 900 pmHg
Evacuation target: 50 pmHg
Continue evacuating for: 5 min

Initially evacuate at. Enter the initial maximum evacuation rate.

Switch to medium at. Enter the method and pressure the sys-
tem must reach before medium evacuation begins.

o Use pressure transducer
o User vacuum gauge
° Skip medium evacuation

Switch to fast at. Enter the pressure the system must reach
before fast evacuation begins.

= Evacuation target. Enter the evacuation pressure.
®m Continue evacuating for. Enter the evacuation duration.

Filling pressure. The penetrometer is filled with mercury at this
pressure. It is recommended to set the filling pressure slightly lower
than the first low pressure point on the pressure table.
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[M] micromeritics®

Analysis Conditions

Analysis Conditions (continued)

Button Use to Specify...
Afilling pressure of at least 0.5 psia is recommended.
Because mercury generates pressure and because fill
pressures less than 0.5 psia can fail to fill the corner radii
and gaps between the glass and sample in the pen-
etrometer, using a lower pressures may reduce the
accuracy of data.
If the filling pressure is higher than any point in the table,
an error message occurs. Delete the pressures lower
than the filling pressure or change the filling pressure.
Equilibrate by. Select the option for equilibration based on elapsed
Time (in seconds) or decrease in Rate of intrusion (or extrusion) in
mL/g per second.
Mercury [button] Enter the mercury properties. Mercury properties may change with

variations in temperature.

= el )
Advancng contactangle: 130,000 @
Receding contactangle: 130,000 °
Surface tension: 485000 dynes/am
Density
) Enter 13.5335
@ Calcuiate from the measured temperature
Temperature | Density |~
0 | @) |2
1 18.00 13.5512
2 | 19.00 13.5487
B 2000 13.5462
4 2000 13.543
5 | 200 13.5413 Append
6 | 22,20 13.5408
7 | 22,40 13.5403
& | 2260 13.5398 ~
Linear compressiiity: -3.5740e-005 1/MPa
Quadratic compressbiity: 599522009 1/MPa?
Enter a value between 90.100 and 179.900.

Advancing contact angle. Enter the advancing (intrusion) contact
angle.

Receding contact angle. Enter the receding (extrusion) contact
angle.

Surface tension. Enter the surface tension of mercury.

Density.
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4 Parameter Files EI micromeritics®

Analysis Conditions (continued)

Button Use to Specify...

® Enter. Select to manually enter a density.

®m Calculate from the measured temperature. Select to use the
entries in the table.

= Linear compressibility. Enter the linear compressibility coef-
ficient.

= Quadratic compressibility. Enter the quadratic compressibility
coefficient.

Table Options Last Low Pressure. Select the row to indicate the last low pressure.

Starting Pressure. This column is not editable. The data are taken
from the Ending Pressure of the preceding row and the Filling
Pressure for the first row.

Pressure Increment. Enter the pressure increment for this segment
if a sequence of linearly spaced pressures is preferred. Either the
Pressure Increment or Points Per Decade can be specified. If one is
entered, the other is automatically set to zero and displayed as
blank. By default, both columns are blank (zero) when a new row is
inserted or appended. If both columns are blank, only the Ending
Pressure will be used.

Points per Decade. Enter the number of points per decade for this
segment if a sequence of logarithmically spaced pressures is
preferred. Either the Pressure Increment or Points Per Decade (but
not both) can be specified. If one is entered, the other is
automatically set to zero and displayed as blank. By default, both
columns are blank (zero) when a new row is inserted or appended.

Ending Pressure. Enter the ending pressure for this segment.

Maximum Intrusion. The analyzer automatically takes additional
readings between points on the pressure table when this volume of
additional intrusion is detected. Enter the intrusion volume per gram
of sample that must be reached in order for additional data pair
readings to be recorded. Use 0 to prevent readings between
pressure points. See Maximum Intrusion Volume Option on
page F - 1. The Maximum Intrusion entry is set to the same value as
the preceding row by default when a new row is inserted or
appended.

Scan Rate. If scanning by pressure, enter the minutes per decade
for this segment. If scanning by intrusion, enter the intrusion rate for
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Analysis Conditions (continued)

Button

Use to Specify...

this segment. The Scan Rate column is set to blank (zero) and
disabled for all rows up to and including the Last Low Pressure. If
Scan By Pressure or Intrusion is selected, the column title will
display the appropriate units (min/decade) or (mL/g-sec) and each
high pressure row must contain a value. The value for the previous
row is set by default when a new row is inserted or appended, or the
default value (5 min/decade or 0.001 mL/g-sec) for the first high
pressure row.

Insert Range. [button] Click to display the Enter Pressure Range
window for entering parameters for the system to autofill the table
with starting pressure, ending pressure, and the number of points to
insert within the specified range.

Start pressure MPa
End pressure 0.0207 MPa
Mumber of points 3

CK l l Cancel

Enter a value between 0.0034 and 420.5802.

/

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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MATERIAL PROPERTIES

File > Open > [ MTP File]

Material properties specify the properties of the material to be used in an analysis. This
information is only required if it is to be used in a report.

= (E=8 B P

Material: Garnet
BETsurfacearea:  200.0000 mifg

[T use entered density
1.0000
1.0000

|7 Use entered conductivity formation factor for e

permeability calculations
[ Use entered threshold pressure 0.10

Linear compressibility: -2.7400e-007  1/psia

Quadratic compressibiity:  2.8500e-013  1/psia?

Close

Material Properties

Selections Description
BET Surface Area Enter the BET surface area.
[text box]

Linear compressibility
[text box]

Enter the linear compressibility coefficient.

Quadratic
compressibility
[text box]

Enter the quadratic compressibility coefficient.

Use entered
conductivity formation
factor... [check box]

Select if using the entered conductivity formation factor for per-
meability calculations and enter the factor in the text box.
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Material Properties (continued)

Selections Description
Use entered density Select if using the entered density and enter the bulk and/or true
[check box] density in the appropriate text boxes. The entered values are used in

the intrusion summary results, Mayer-Store report, and the pore
structure report. The Mayer-Stowe particle size calculation has
meaning mostly in the range of interstitial filling. For larger pressures
after which the interstitial space is filled, the particle size calculation
has less meaning.

Use entered threshold | Selectif using the entered threshold pressure and enter the
pressure [check box] threshold pressure in the text box.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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PENETROMETER PROPERTIES

File > Open > [.PEN File]

Penetrometer properties specify the properties of the penetrometer to be used in an analysis. It is
recommended to use a copy of the system penetrometer file that corresponds to the penetrometer
bowl.

] [B=8 E=RIES)

Penetrometer:  ##### - 0 cc Bulb, 0.000 cc MMV, Solid -

Mass: 1.0000 g Constant: 10.780 yLfoF

Wolume: 1.0000 mL Stemvolume:  0.4120 mL
Maximum head pressure:  4.680 psia

Correction Method

) Blank

sample:
) Formula

@ MNone

Penetrometer Properties

Selections Description
Constant [text box] Enter the penetrometer constant provided with the penetrometer.
Verify the field contents if the Replace option has been used.
Correction Method Blank. If using the blank correction method, click Browse to select a
[selection] sample file.
Formula.
None.
Mass [text box] Mass of the empty, assembled penetrometer (excluding the spacer).
Maximum head Enter the maximum head pressure.
pressure [text box]
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Penetrometer Properties (continued)

Selections Description
Penetrometer Enter identifying information for this file. This information can consist
[drop-down box] of the last two digits of the base part number and the 4 digit

penetromer serial number. For example:

Penetrometer part number: 950-61708-00
Serial number: 1420
Suggested identification number: 08-1420

Stem volume [text box] | Enter the penetrometer stem volume provided with the pen-
etrometer.

Volume [text box] Enter the volume of the penetrometer. This is required to calculate
density or when using the blank correction formula.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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REPORT OPTIONS

File > Open > [.RPO File]

(or click the Report Options tab when in Advanced format)
Additional reports are available using the Reports menu.

Use to specify report options for data collected from an analysis or manually entered data. Report
Options files also help in customizing report details such as axis scale, axis range, column
headings, and components of thickness curve equations. These files may contain tabular reports,
plots, or both, as well as advanced report tables.

Customized report options files can be created then loaded into a sample file, allowing quick
generation of reports.

Report Options files may be defined to include overlay options. This system allows the overlay of
up to 25 plots of different samples onto a plot of the same type or overlay one plot type onto a
different plot type from the same analysis.
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Report Options
Report Options
Selections Description
Edit [button] Edit graph options.

Plot Points. Select to plot points on the graph.
Plot Curve. Select to plot curves on the graph.

Show Histogram. Select to show the graph as a histogram. When
selected, the Plot Points and Plot Curve selections are disabled.

Header Options [button]

[Fe] e e
Show report tite Micromeritics Instrument Corporation
[#]show bitmap midogo.emf Browse. ..
Height: 0,250 in  ‘Width: 2,000 in

Show report title. Enter a report title to appear on the report header.
Show bitmap. Displays the selected graphic on the report header.

Height / Width. Enter the height and width of the selected graphic.
These values determine the graphic appearance on the generated
report.

Intrusion Data Options
[button]

This button is also located on Intrusion reports.

= o =s
D Report negative intrusion
Smooth differentials
[] adjust intrusion for compressibility
(@) Use coeffidents from compressibility report
Use material properties
Select Pressures Induded in Intrusion Reports
9.73 to 44,338.20 psia
NOTE: This range applies to the first twelve reports.
Pressure selection for Mayer-Stowe, Pore Structure, etc,
is done via their respective editors

Adjust intrusion for compressibility:

® Use coefficients from compressibility report. Select to have
the application use the coefficients from the Material Com-
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[M] micromeritics®

Report Options (continued)

Selections

Description

pressibility report rather than from the Material Properties.

= Use material properties. Select to have the application use the
parameters from Material Properties rather than from the Material
Compressibility report.

Report negative intrusion. Select to report small incorrect
polarities (negative intrusions or positive extrusions) which may
indicate the presence of noise, improper blank correction, or
analyzer malfunction.

Select Data Included in Intrusion Reports. Enter range of
pressure. This range applies to the first twelve reports on the options
list. When these selections are changed in the intrusion report, the
lower right graph x-axis and the intrusion data in the graph will
change accordingly. The two blue range bars can then be used to
select the required range of data.

®m Pressure. The default behavior of the application is to select data
using pressure as this is the quantity which is varied during mer-
cury porosimetry analysis. The maximal range of data (all data) is
selected by default. It is advisable to use this default setting
unless there is a specific goal is required.

= Pore size. Uses the Washburn equation to translate the user
entered pore size range to a corresponding pressure range used
for data selection.

= Particle size.This option is less commonly used. In the Material
Properties window, select the checkbox Use entered density and
complete the Bulk density and effective Particle density fields. The
effective Particle density and Bulk density quantities are neces-
sary to compute the interstitial porosity of the powder used in the
Mayer-Stowe calculation.

Smooth differentials. Select to apply smoothing to any differentials
reported in tables or graphs.
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Report Options

Report Options (continued)

Selections

Description

Overlays [button]

Select the files to overlay.

x et

Reference [button]

Select a sample file to compare analysis results with the current
sample.

= Slels)
Reference file:

Selected Reports
[check box]

Select the report names to include in the report.

Specification [button]

Selects the sample files to be used for the boundaries of the coarse
and fine specifications. This helps in determining if the results of the
current sample are within the specified boundaries.

] |E= ol
Cancel

/

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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EI micromeritics® 5 Perform an Analysis

5 PERFORM AN ANALYSIS

A low pressure analysis must be performed on a sample before a high pressure analysis can be
performed.

SELECT A PENETROMETER

Selecting the most appropriate penetrometer with which to test a particular material depends on
sample form or shape, sample porosity, and the quantity of sample.

Penetrometers are available with three sample volumes, with five intrusion capacities, and in
configurations for either solid pieces or powders. Refer to the Penetrometer Selection Guide in
this section.

Powder

Solid

Ensure the sample nearly matches the size of the sample bulb and that the capillary volume is
large enough to satisfy intrusion.

Penetrometer Selection Guide

Maximum
Bulb Sample Maximum Total Head Physical Dimensions Part
Volume Type Measurable Stem Pressure Number
(cc) Volume Volume | (psia) | (kPa) | I (mm) | H(mm) | D (mm)
(cc) (cc)
3 Solid 0.387 0.412 | 468 | 32.3 | 227 | 242 | 1.473 | 950-61713-00
3 Solid 1.116 1.190 | 4.68 | 32.3 | 227 | 242 | 2.502 |950-61715-00
3 Powder 0.387 0412 | 468 | 323 | 227 | 242 | 1.473 | 950-61714-00
3 Powder 1.116 1190 | 4.68 | 32.3 | 227 | 242 | 2.502 |950-61716-00
5 Solid 0.366 0.392 | 445 | 30.7 | 215 | 230 | 1.473 | 950-61707-00
5 Solid 1.057 1.131 | 445 | 30.7 | 215 | 230 | 2.502 | 950-61709-00
5 Solid 1.716 1.836 | 4.45 | 30.7 | 215 | 230 | 3.188 |950-61711-00
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Penetrometer Selection Guide (continued)

Maximum
Bulb Sample Maximum Total Head Physical Dimensions Part
Volume Type Measurable Stem Pressure Number
(cc) Volume Volume | (psia) | (kPa) | I (mm) | H (mm)| D (mm)

(cc) (cc)

5 Powder 0.366 0.392 | 445 | 30.7 | 215 | 230 | 1.473 |950-61708-00

5 Powder 1.057 1.131 | 4.45 | 30.7 | 215 | 230 | 2.502 | 950-61710-00

5 Powder 1.716 1.836 | 4.45 | 30.7 | 215 | 230 | 3.188 | 950-61712-00

15 Solid 0.366 0.392 | 445 | 30.7 | 215 | 230 | 1.473 |950-61701-00
15 Solid 1.057 1.131 | 4.45 | 30.7 | 215 | 230 | 2.502 | 950-61703-00
15 Solid 1.716 1.836 | 4.45 | 30.7 | 215 | 230 | 3.188 |950-61705-00

15* Solid 3.007 (3.263) | 4.45 | 30.7 | 215 | 230 | 4.813 |950-61724-00

15* Solid 3.857 (4.185) | 4.45 | 30.7 | 215 | 230 | 4.813 |950-61725-00

15 Powder 0.366 0.392 | 445 | 30.7 | 215 | 230 | 1.473 |950-61702-00

15 Powder 1.057 1.131 | 4.45 | 30.7 | 215 | 230 | 2.502 | 950-61704-00

15 Powder 1.716 1.836 | 4.45 | 30.7 | 215 | 230 | 3.188 |950-61706-00

* The first 3 mm of stem on these penetrometers have an inside diameter (D) of 1.5 mm. In
computing maximum measurable (intrusion) volume, the value of | should be reduced by 3 mm.

= Maximum measurable volume = [(3.14)(D2)(1)/4] x [0.001
cm3/mm3]

®m Total Stem (Capillary) volume =[(3.14)(D2)(H)/4] x [0.001
cm3/mm3]

® Maximum Head Pressure (psia) = [H] x [0.01934 psia/mmHg]

= Maximum Head Pressure (MPa) = [H] x [0.000133 MPa/mmHg]

A powder penetrometer should be used when the sample consists of small grains or particles.
Chunks of material or formed objects (maximum size is 25 mm OD x 25 mm long) should only be
installed in a “solid” penetrometer.
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Best results, generally, are obtained when the bulb of the selected penetrometer is nearly filled by
the minimum amount of sample that is representative. Next, the estimated pore volume of the
sample should not exceed 90% nor be less than 25% of the total stem volume (see column 4 of
the Penetrometer Selection Guide). Once materials of similar characteristics have been tested, it
will usually be possible to select the optimum penetrometer almost without fail.

As an example, suppose the sample consists of a single sintered pellet of nickel (density 8.9 g/cc)
weighing 29 g and having an estimated pore volume of 20% of the true sample volume to analyze.
The following characteristics are calculated:

Volume of sample = mass/density = (29g)/(8.9g/cc) = 3.26 cc

Approximate pore volume = fractional pore volume x sample volume =
0.20 (3.26 cc) = 0.652 cc

Approximate total volume = volume of pores + volume of sample
(3.26 + 0.652) cc = 3.91 cc

Hence, the penetrometer listed sixth in the Penetrometer Selection Guide as solid, 5 cc sample
volume, 1.131 cc total stem volume would be the appropriate choice unless the pellet shape
dictates use of a larger one. The percent of maximum measurable intrusion volume required by
this sample is (0.652 cc/1.131 cc) x 100% = 58%, which falls below the suggested 90% maximum.

The penetrometer for powdered or granular materials is chosen similarly, but remember that the
spaces among the material grains are likely to constitute a void of about 40%. As another
example, assume that 15 g of a granular material (density 3.5 g/cc) had been determined the
minimum quantity for representation. Assume the powder has low porosity: 3%.

Volume of sample = mass/density = (15 g)/(3.5 g/cc) =4.29 cc

Approximate pore volume of material = fractional porosity x sample volume =
0.03(4.29¢cc)=0.13cc

Approximate volume of interstice = (4.29 cc + 0.13 cc) (40/60) = 2.95 cc
Total volume of powdered sample =4.29 cc + 0.13 cc + 2.95cc =7.37 cc

Three powder penetrometers listed in the Penetrometer Selection Guide will contain 7.37 cc of
sample. Considering the sample size, the one having a total stem volume of 0.392 cc is most
appropriate. The sample requires approximately 33% [0.13/0.39] of the stem capacity of the
penetrometer. Optimum performance would be achieved if, instead of merely using the minimum
15 g of sample, the penetrometer were filled to capacity, which is approximately 30.5 g [15 x
15/7.37]. The penetration volume would then be about 0.26 cc [0.13 x 15/7.37] or nearly 66%
[0.26/0.39] of the total stem volume.
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The previous calculations assume that all interstitial volume will be filled with mercury

; at the filling pressure. A minimum fill pressure of 0.5 psia will fill cavities of approx-
imately 500 mm diameter, whereas a filling pressure of 1.5 psia will fill cavities as
small as 120 mm diameter. If some interstitial volume remains unfilled at this point,
allowance for this additional volume must be made in choosing the appropriate stem
volume.

The percentage of the maximum intrusion (stem) volume utilized in each station is displayed on
the Status Display as a guide for the operator. A % STEM reading of less than 25% or more than
90% suggests the need for a procedural change. The first instance suggests a larger quantity of
sample might give better resolution and the second indicates that the capillary is on the verge of
being depleted.

5.4 AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022



[M] micromeritics’ Prepare e Sample

PREPARE THE SAMPLE

To achieve gains in productivity and reduction in analyzer maintenance, as well as improved data
quality, dry the sample material in a shallow pan at 150 °C or higher for one hour. A vacuum oven

may be used, although it is not necessary to do so. Use of a vacuum oven is particularly beneficial
if the oven is backfilled with dry nitrogen prior to opening. Once the sample is dried, minimize any

re-exposure to the atmosphere.

The drying of samples prior to analysis is important, especially for sample types such as fluid
cracking catalysts, porous silicas, porous aluminas, and zeolites, which are almost impossible to
evacuate without fluidization unless first dried.

The preparation process consists of:

Clean the Penetrometer below

Load the Sample on the next page

Seal the Penetrometer on page 5 -7

Weigh the Assembled Penetrometer with Sample on page 5 - 9
Install the Penetrometer on page 5 - 9

ok wpd=

CLEAN THE PENETROMETER

Clean, dry penetrometers are essential for accurate, reproducible results.

/ It is recommended that rubber gloves be worn when handling penetrometers.

Never use an ultrasonic bath to clean penetrometers. Ultrasonic cleaning systems will
damage the metal plating and remove the serial number information.

1. Dissolve Alconox (or other suitable detergent) in water. Ensure the detergent is completely
dissolved before placing the penetrometer into the solution.

2. Place the mercury waste container in a shallow pan of water in case of spills.

3. Hold the penetrometer upright over a mercury waste container to allow any accumulated
mercury to drain out.

4. Remove the cap from the penetrometer If the cap is difficult to remove, see Penetrometer
Nut on page 11 - 34.

5. Turn the penetrometer over and pour remaining sample into the waste container.

6. Immerse the penetrometer in the detergent solution. Clean the outside of the penetrometer
stem and the bulb with a brush. Then clean the inside of the stem with one of the smaller
brushes.
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7.

8.
9.

10.

11.

Rinse the penetrometer with warm water. Hold the penetrometer upright and enure that
water runs from the bulb through the stem freely.

Rinse the penetrometer with IPA.

Immerse the stainless steel cap and nylon closure components in the detergent solution.
Clean with appropriate brushes and rinse in warm water.

If there is any mercury in the bottom of the detergent solution, dispose of the solution prop-
erly.

Use dry nitrogen to dry the penetrometer, cap, and closure components.

LOAD THE SAMPLE

/ To avoid transferring skin oils, it is recommended to wear latex gloves when handling

penetrometers. Skin oils may affect results.

1.
2.

3.

Enter the sample file name (or identifier) on the Sample Data Worksheet on page G - 8.
Weigh the sample using an analytical balance. Record the mass on the data sheet as
Sample mass.

Hold the penetrometer with the stem down and carefully pour the sample into the bulb.

When pouring powders into the bulb, place a finger over the stem opening in the center of
the bulb so that powder does not enter the stem. A small funnel is useful for loading
powders. Large granules or chunks may be loaded with forceps.
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SEAL THE PENETROMETER

/ To avoid transferring skin oils, it is recommended to wear latex gloves when handling
penetrometers. Skin oils may affect results.

Itis important that penetrometers are clean and dry.

1. Avacuum-tight seal is required. Therefore, vacuum grease (Apiezon H) must be used to fill
the inevitable roughness of the ground glass lip and polished surface of the cap. To apply
grease:

unwanted coating and is likely to cause slippage and misalignment of the mating sur-

/ Follow these instructions carefully. Too much grease exposes the sample to an
faces. Too little grease results in an imperfect seal.

Lightly grease the tip of the bulb

a. Use afingertip to apply a light coating of grease to the lip of the bulb.
b. Smooth the grease evenly around the lip of the bulb.
c. Remove all excess grease from both the inside and outside of the bulb.
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2. Hold the penetrometer upright. Place a cap over the greased bulb and turn the cap one half
turn to seat.

A. Place a cap over the greased bulb and turn 1/2 turn to seat
B. Slide the nut over the penetrometer stem and finger tighten

3. Place the penetrometer tool over the nut.

A. Wrench peg
B. Place penetrometer tool over the nut and cap

4. Place the wrench peg into a hole in the penetrometer nut. Use the penetrometer tool to
stabilize the cap while tightening the nut counter-clockwise.

Py

E I A. Wrench peg

B. Place penetrometer tool over the nut and cap

5. Weigh the penetrometer before installing it in the low pressure port.
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WEIGH THE ASSEMBLED PENETROMETER WITH SAMPLE

/ To avoid transferring skin oils, it is recommended to wear latex gloves when handling
penetrometers. Skin oils may affect results.

1. Weigh the assembled penetrometer with sample using an analytical balance. Do not
include the spacer when weighing.

2. Record the mass on the Sample Data Worksheet as Sample + Penetrometer mass.

3. Subtract Sample mass from Sample + Penetrometer mass. Record on the Sample Data
Worksheet as Penetrometer mass.

/ The mass of the penetrometer must be determined by this method in order to account
for the mass of the sealing grease, which varies with each application.

INSTALL THE PENETROMETER

Install a Penetrometer in a High Pressure Chamber on page 10-6
Install a Penetrometer in a Low Pressure Port on page 10-8

Remove a Penetrometer from a High Pressure Chamber on page 10-10
Remove a Penetrometer from a Low Pressure Port on page 10-11
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PERFORM A LOW PRESSURE ANALYSIS

Unit [n] > Low Pressure Analysis

Select the sample files for analysis for each port
Edit the penetrometer properties

Edit analysis conditions

Monitor analysis as data are collected

Prior to starting an analysis, verify that the tank pressure for the gas regulator is at
least 200 psig. Pressures less than 200 psig may cause inaccurate data or ter-
mination of analysis.

Fort Sample
BOK 1P SERVE PUMP TEST
THPTY CHAMDIR Biov

3 e s Lases

(¥
5
i
L

. Select Operation from the View drop-down to enter or edit analysis information.

. Install a Penetrometer in a Low Pressure Port. Install a steel rod with cap detector in any low
pressure port that does not contain a penetrometer.

3. For a selected port, click Browse and select a sample file or click New to create a sample

file. If needed, change the Penetfrometer mass and/or Sample mass field for the sample
material being analyzed.

N —
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4. Click Start to start the analysis. A window displays data as they are collected. A short delay
is encountered before the port status at the bottom of the window changes from the /dle

state.

/-

When the Start button is clicked, if any low pressure station does not show a cap
detector reading that indicates the station has a penetrometer or rod and its cap
detector in place, a warning message will be displayed and the analysis will not
start.

When the next scheduled pressure is above atmospheric pressure and a cap
detector and rod or pen is not in place, the same warning will be displayed and the
analysis will be suspended until the operator has corrected the problem and
resumed.

If a cap detector is removed when the pressure is above atmospheric pressure, the
low pressure system will be vented to atmosphere and the analysis canceled, with
an explanatory error message.

5. When the analysis is complete, remove the penetrometer and store (or dispose of) the
sample material as applicable.
Low Pressure Analysis

Selections Description

Penetrometer mass This information is pulled from the selected sample file. Modify the
penetrometer mass in this field as needed.

Sample mass This information is pulled from the selected sample file. Modify the
sample mass in this field as needed.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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EVACUATE Low PRESSURE

Unit [n] > Evacuate Low Pressure

Select the type of sample when performing a low pressure evacuation. This window is also
available using the Evacuation button on the Analysis Conditions tab.

Select if the sample is a Formed solid, Powder, or Other. If Other is selected, the remaining fields
are enabled.

[E=3 e[ ~>=
Sample
() Formed solid
() Powder
@ Other
Initially evacuate at: 5.0  psiafmin
Switch to medium at:
(@) Use pressure transducer
0.00 MPa
() Use vacuum gauge
10,000
() Skip medium evacuation
Switch to fast at: 900 pmHg
Evacuation target: 50 pmHg
Continue evacuating for: 5 min

Evacuate Low Pressure

Selections Description
Initially evacuate at Enter the initial maximum evacuation rate.
Switch to medium at Enter the method and pressure the system must reach before

medium evacuation begins.

®m Use pressure transducer
® User vacuum gauge
= Skip medium evacuation .

Switch to fast at Enter the pressure the system must reach before fast evacuation
begins.
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Generate Low Pressure

Evacuate Low Pressure (continued)

Selections Description

Evacuation target

Enter the evacuation pressure.

Continue evacuating
for

Enter the evacuation duration.

GENERATE Low PRESSURE

Unit [n] > Generate Low Pressure

Pressure can be generated in the low pressure system when a low pressure analysis is not

already in progress.

"~ Low Pressure Generation EI@ " Low Pressure Generation EI@
Target Pressure 1470  psia Generating 14,70 psia
Current pressure 14.70 psia
Current vacuum 750,137 pmHg
Generating 14.70 psia Generating 14.70 psia

0.2068 MPa.

/

Threaded penetrometer closures are required for pressures above 30 psia or
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MONITOR A LOW PRESSURE ANALYSIS

This live graph displays data as they are collected. It also shows intrusion as a function of
pressure. The status section below the graph displays the following for each port:

= Sample file name
® |ntrusion volume
® Percent of the penetrometer stem that is filled with mercury

show the state of the low pressure system components. See Show Instrument
Schematic on page 2 - 15.

/ When monitoring a low pressure analysis, the analyzer schematic can be displayed to

Low Pressure Analysis

Selections Description

Pressure Displays the current pressure in the low pressure system. The read-
ing shown is from either the vacuum gauge or the 50 psia transducer,
depending upon which is currently in range.

Resume Restarts the suspended analysis.

Skip Moves to the next step. Select the ports to skip.
Status Displays current low pressure status.
Suspend Suspends an analysis in progress.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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PERFORM A HIGH PRESSURE ANALYSIS

The analyzer is designed to perform two high pressure analyses simultaneously. To run only one
analysis, the other chambers must be closed tightly and have sufficient high pressure fluid to be
drawn into the vent valve.

Unit [n] > High Pressure Analysis

Low and high pressure analyses can be performed simultaneously.

m Select the sample files for analysis for each port
® Edit the penetrometer properties
m Edit analysis conditions
= Monitor analysis as data are collected
= o=
View: [operaton <]
I [&]
Ern:se..
Analysis type * Assembly mass is the sample + penetrometer +
[ close |
I]’url Sample \IEE.-."??«: % Stem

the low pressure analysis. The analyzer checks to see that the same analyzer is used
before it begins the high pressure analysis; if it is not, the analyzer displays a warning
message. The analysis can be continued or canceled.

/ Each sample’s high pressure analysis should be performed on the same analyzer as

1. Select the sampile file with a status of Low Pressure Complete or High Pressure Complete.

If a selected sample file to be analyzed on a 9605 analyzer contains pressures exceeding
33,000 psia, the following message displays:

» Click Yes to proceed with the analysis; only pressures less than 33,000 psia will be used.
* Click No to cancel the analysis.

2. Install a Penetrometer in a High Pressure Port.
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5 Perform an Analysis

[M] micromeritics®

3. Click Start to start the analysis immediately. A live graph of the analysis displays as data

are being collected.

4. Remove the penetrometer after the analysis

Atmospheric Pressure), and if the current high pressure reading differs significantly

/ If it was not requested that the transducer offset be determined (Options >

from the atmospheric pressure, a prompt displays requesting verification that the
system is at atmosphere.

penetrometer. Open the High Pressure Analysis window and enter the name of a file

/ For maintenance purposes, it is possible to perform a high pressure analysis with no

with a No Analysis status. Continue the analysis after a warning message displays.

High Pressure Analysis

Selections

Description

Analysis type

Regular. Performs a differential analysis with the blank
penetrometer in port 1.

Differential, blank in port 1. Performs a differential analysis with
the blank penetrometer in port 1.

Differential, blank in port 2. Performs a differential analysis with
the blank penetrometer in port 2.

Assembly mass

Sample + penetrometer + mercury mass.

Atmospheric pressure

Enter the atmospheric pressure if it differs from the default entry. The
default entry is pulled from the information entered in Options
> Atmospheric Pressure.

Determine transducer
offset

Select to allow the system to determine the transducer offset. The
default entry is pulled from the information entered in Options
> Atmospheric Pressure.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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EI micromeritics® Generate High Pressure

GENERATE HIGH PRESSURE

Unit [n] > Generate High Pressure

Pressure can be generated in the high pressure system when a high pressure analysis is not
already in progress.

S - ] = = -G s
Target Pressure 147 psia Generating 14. 70 psia
Current pressure 14.74 psia
Generating 14.70 psia Generating 14.70 psia
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5 Perform an Analysis EI micromeritics®

MONITOR A HIGH PRESSURE ANALYSIS

This live graph displays data as they are collected. It also shows an intrusion as a function of
pressure. The status section below the graph displays the following for each port:

= Sample file name
® |ntrusion volume
® Percent of the penetrometer stem that is filled with mercury

/ When monitoring a high pressure analysis, the analyzer schematic can be displayed
to show the state of the high pressure system components.

High Pressure Analysis

Selections Description
Pressure Displays the current pressure in the high pressure system.
Skip Moves to the next step. Select the ports to skip.
Resume Restarts the suspended analysis.
Status Displays the high pressure's current status.
Suspend Suspends an analysis in progress.
/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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Iml micromeritics® High Pressure Differential Analysis

HIGH PRESSURE DIFFERENTIAL ANALYSIS

If using a blank correction file as the correction method, the correction file must exist before the
sample data file can be completed (since a blank correction file must be selected when the sample
file is created).

If a blank analysis has not been performed in advance, run a differential analysis of the sample
and the corresponding blank simultaneously. The application associates the sample file with the
blank correction file after the analysis is completed.

An advantage of using differential analysis is that both the sample and blank penetrometers are
subjected to nearly identical conditions (time, temperature, and pressure). Properly used, the
differential analysis option provides the most accurate low porosity sample data possible.

1.

2.
3.

Create a sample file. Also create a sampile file for the blank penetrometer using None for the
correction method.

Run the low pressure analysis on both files.

In the high pressure analysis wizard, select Differential, blank in port 1 or Differential, blank
in port 2 as the analysis type.

Start the high pressure analysis.
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5 Perform an Analysis

[M] micromeritics®

REFERENCE MATERIAL ANALYSIS

HIGH PRESSURE REFERENCE MATERIAL ANALYSIS

Unit [n] > High Pressure Reference Analysis

A reference material analysis is used to verify the analyzer is operating properly and producing
optimum results. These methods provide specifications for critical report quantities and reporting

of whether quantities are in or out of specification.

When running a reference material analysis, use the appropriate reference material provided in
the accessories kit to perform this analysis. The results should match those shown on the label of

the reference material bottle, within the tolerance level.

High Pressure Reference Analyso = || ]
L e—
sthed: | 306 v SRV LM TST

Drowse.. Kssemtsy mags 000 g
T 1P RV PP TEST Ed
G
Drowse... anmdiy masst: 0000 g
30 1P SERVD PLME TEST Em
Gl
+ Assembly mass & the sample + penetrometer +
ey mass.
Amomphercpressare; 14700 pea
[T Re—
| Determine bomedcrs alfset o e
st ot
Intrusion

Port Sample Vol (mLfg) 9% Stem
1 ao00

2 ao00 o |
Statws:_Tdie Pressure: 0.0 psia

High Pressure Reference Material Analysis

Selections

Description

Assembly mass

This information is pulled from the selected sample file.
Sample + penetrometer + mercury mass.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022



Iml micromeritics® Low Pressure Reference Material Analysis

Low PRESSURE REFERENCE MATERIAL ANALYSIS

Unit [n] > Low Pressure Reference Analysis

A reference material analysis is used to verify the analyzer is operating properly and producing
optimum results. These methods provide specifications for critical report quantities and reporting
of whether quantities are in or out of specification.

When running a reference material analysis, use the appropriate reference material provided in
the accessories kit to perform this analysis. The results should match those shown on the label of
the reference material bottle, within the tolerance level.

=2 )
Low Pressure Material Reference Material Analysis
Selections Description
Penetrometer Penetrometer description from the selected sample file.
Penetrometer mass Penetrometer mass from the selected sample file.
Sample mass Sample mass from the selected sample file.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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5 Perform an Analysis EI micromeritics®

LEAPFROGGING - SUGGESTED SEQUENCE FOR MAXIMUM
THROUGHPUT
Leapfrogging is a procedure for running low and high pressure systems simultaneously to

maximize throughput. This process describes leapfrogging a group of eight samples. It is possible
to leapfrog groups of samples continuously.

/ If samples require longer vacuum preparation or heated evacuation, increase the
throughput by preparing samples in a vacuum oven.

1. Prepare and weigh eight samples. Load eight penetrometers with samples then weigh
them. Complete the worksheet and install samples 1 through 4 in the low pressure ports.

2. Create sample files for at least the first four samples.
3. Goto Unit [n] > Low pressure analysis to start the low pressure analysis.

4. When the run is complete, remove samples 1 through 4 from the low pressure ports and
weigh them. Install samples 5 through 8 in the low pressure ports.

5. Start another low pressure run.
Place samples 1 and 2 in the high pressure chambers.
7. Goto Unit [n] > High pressure analysis to start the high pressure analysis.

o

/ While waiting for analysis to complete, samples files can be created and other
samples can be prepared for analysis.

8. When the high pressure run is complete, remove samples 1 and 2 from the high pressure
chambers and replace with samples 3 and 4.
9. Start another high pressure run.

10. Automatic reports specified in each sample file will print when that sample’s high pressure
run ends.

11. When the second low pressure run and the second high pressure run end, remove samples
3 and 4 from the high pressure chambers. Remove samples 5 through 8 from the low pres-
sure ports and weigh them.

12. Install samples 5 and 6 in the high pressure chambers. Start another high pressure run.

13. When the third high pressure run is finished, install samples 7 and 8 in the high pressure
chamber and start another high pressure run.
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[M] micromeritics’ 6 About Reports

6 ABOUT REPORTS

Reports can be generated for data collected on a sample that has completed analysis, collected
on a sample currently being analyzed, or manually entered.

Reports > Start Report

Generates a report on a sample analysis.

Reports > Close Reports

Closes all open reports. This option is unavailable if reports are being generated.

SPC REPORT

Reports > SPC Report Options

Use to generate reports with various SPC (Statistical Process Control) options. All selected
variables must be computed for each sample file used in an SPC report; therefore, it is more
efficient to select only the necessary variables.

Analysis Options Intrusion Summary Pore Structure
[] sample mass [ Total Intrusion volume [ Threshold pressure
[] Assembly mass [ Total pore area [ Characteristic length

[C] LP equilibration time
[ LP equilibration rate

D Evacuation pressure

[ Hag density

[] Penetrometer volume
[] Penetrometer mass
Material Compressibility
[ Linear coefficient

[ Quadratic coefficent

[ Median pore diameter (Volume)
[ Median pore diameter (Area)
[] Average pore diameter {4V/4)

[ stem volume used

Mayer-Stowe
[] Breakthrough pressure ratio
[ interstitial porosity

[] Conductivity formation factor
[ Permeability
D Tortuosity

[ Evacuation time [ Bulk density 0.10 [ Tortuosity factor
[]HP equilibration time [] Apparent (skeletal) density [] Percolation fractal dimension
[C]1HP equilibration rate [T Porasity [ Backbone fractal dimension

User Parameters
[ Parameter 1
[C]Parameter 2
[ Parameter 3
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6 About Reports [M] micromeritics®

REGRESSION REPORT

Reports > Regression Report

Use to generate a Statistical Process Control (SPC) Regression report to determine the
interdependency between two variables. Up to three dependent variables (y-axis) may be plotted
against a single independent variable (x-axis). The degree of correlation between the variables is
also reported.

s Raege
Vintiabla = i
s vinrable:

Regression Report

Selections Description

Autoscale [check box] When enabled, allows the x- and y-axes to be scaled automatically.

Axis Range [text box] Enter the beginning and ending values for the x- and y-axis ranges.
These fields are disabled if Autoscale is selected.

Label data [check box] Use to label the points on the plot to correspond with the values in
the sample files.

Recalculate archived If selected, SPC results are archived in the sample files when a
SPC results [check box] | reportis generated. If deselected, previously archived results are
used to save time when generating reports. Since this option
updates and saves sample files, do not use it with sample files that
need to remain compatible with other applications.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.

Save as Default [button] | Click to save selected report options as default report settings.
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[Mi micromeritics® Rogresson Rapot

Regression Report (continued)

Selections

Description

Show graphic
[check box]

Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated
report.

Show report title

Select then enter a report title to appear on the report header.

[check box]
Tabular report Generates a tabular report of the included samples that contains the
[check box] numeric values contributed by each sample.

X- and Y-Axis variable
[drop-down box]

Designates the x- and y-axes variables. The variables in the drop-
down lists are those selected in the Reports > SPC Report Options
window. Use these options to plot the regression of up to three y-axis
variables against the x-axis variable.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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6 About Reports [M] micromeritics®

CONTROL CHART REPORT

Reports > Control Chart

Generates a Statistical Process Control (SPC) chart report which plots the changes in a statistic.

==
i :::'In 200 weath: 000 r—
X A Order Dy
Ao Label .
raph L. Mone
s’;:af. L2 o dhived SPC readis
Save s Defat == Cancel
Control Chart Report
Selections Description
Graph [n] [button] Defines the y-axis of each graph.
Gas Adsorption Control Chart Graph 1 Options =
¥ A
Statstic: | None
A Autoscale
Center Line Limt Lines
®) Mane (@) Nore
Mean Ci+and
Entered Entered

Statistic. Displays the SPC variables selected on the Reports >
SPC Report Options window. The selected variable will be plotted
for each selected sample. This selection also becomes the y-axis
label.

Autoscale. Allows the y-axis to be scaled automatically. To specify a
range, deselect this option and enter a range in the From and To
fields.
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[M] micromeritics’ Corirl Chart Report

Control Chart Report (continued)

Selections Description

Center Line. Displays placement options for the center line in the
graph. Select Entered to specify placement of the line or Mean to
place the center line at the calculated mean value for the selected
samples.

Limit Lines. Displays limiting lines options. Lines can be placed at
some multiple of the standard deviation or at specified positions
(Entered). When Entered is selected, enter the High limit and Low
limit fields with appropriate values.

Recalculate archived If selected, SPC results are archived in the sample files when a
SPC results [check box] |reportis generated. If deselected, previously archived results are
used to save time when generating reports. Since this option
updates and saves sample files, do not use it with sample files that
need to remain compatible with other applications.

Report [button] Generates the report.

Samples [button] Select additional sample files to add to the report.
Show graphic Use to show a graphic on the report header.
[check box]

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated

report.
Show report title Select then enter a report title to appear on the report header.
[check box]
Tabular report Generates a tabular report of the included samples that contains the
[check box] numeric values contributed by each sample.
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6 About Reports [M] micromeritics®

Control Chart Report (continued)

Selections Description
X Axis Order By Select the order in which x-axis statistics are placed. Sort by:
[group box]

Time. Time the files were analyzed.
File name. Alphanumeric order.
Date. Date the files were analyzed.

Minutes. Minutes elapsed from the first file placed on the list, which
is the earliest-analyzed file.

Days. Number of days elapsed from the first file placed on the list,
which is the earliest-analyzed file.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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PSD History Report

PSD HISTORY REPORT

Reports > PSD History

The PSD History Report generates a sequence of full pore size distribution graphs.

==
[¥] Show report title  Micromeritics SPC Report
Bitmap
Show bitmap midogo.emf
Height: 2,000 in Width: 2,000 in

X Axis Order By X Axis Variable

@ Time () File name (@) Pressure () Pore size

¥ Axis variable

(@) Diff. volume () Diff. % volume (") Diff. area

Show

(@) First Intrusion () First Extrusion

Destination:

(@ Preview

(2 Print Copies: 1

@ File: | &y

[ Save as Default I [ Report l [ Cancel ]
PSD History Report

Selections Description
Report [button] Generates the report.
Samples [button] Select additional sample files to add to the report.

Save as Default [button] | Click to save selected report options as default report settings.

Show [selection] Select one of the following options:

First Intrusion. Select to show the first intrusion segment.

First Extrusion. Select to show the first extrusion segment.

[check box]

report.

Show bitmap Use to show a graphic on the report header.

Height/Width. Enter the height and width of the selected graphic.
These values determine the graphic's appearance on the generated

[check box]

Show report title Select then enter a report title to appear on the report header.
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[M] micromeritics®

PSD History Report (continued)

Selections Description
X Axis Order By Select one of the following:
[selection]

Time. Time the files were analyzed.

File name. Alphanumeric order.

X Axis variable
[selection]

Select one of the following to display on the graph:
Pressure.

Pore size.

Y Axis variable
[selection]

Select one of the following to display on the graph:
Diff. volume.
Diff. % volume.

Diff. area.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022




EI micromeritics® Interactive Reports

INTERACTIVE REPORTS

When opening a sample file that contains data from a complete or in-progress analysis, the
interactive reporting feature is enabled.

1.

When opening a sample file that contains analysis data, a window with the following inform-
ation will display:

= an intrusion linear plot and log plot of the data collected during analysis.
® 3 summary of the analysis giving a single total intrusion volume and other important
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Gumulative Intrusion

Reportnegative intrusion (Y] Smooth differentials
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3
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Close Intrusion - Preview

B

Modify the intrusion graph to show all or first intrusion and/or extrusion segments by select-
ing an option from the Intrusion or Extrusion drop-down lists.

Add an overlay to the intrusion graph by selecting an option from the Overlay drop-down list.
To view the reports selected for generation during or after analysis, click Preview.

From the view selector drop-down list at the bottom of the window, do either of the following:

® Change the option presentation of the sample description window to either Basic or
Advanced to modify certain file parameters.
m Select another plot from the list and edit the data contained in the plot.

When ranges are edited, the changes are reflected immediately in the plots and the sum-
mary data displayed in the window. Some editing options are:

® Drag the blue bars to increase or decrease the range of data included in the plot.

® Right-click to display a popup menu to include reports; enable or select overlays; edit
curves, axes, legends, titles; and copy and paste the data in a graph or in tabular
format.

. Click Save.
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5 About Reports [M] micromeritics®

MICROACTIVE REPORTS

MicroActive reports are generated automatically after an analysis is performed. This feature
provides a quick and easy way to investigate and manipulate analysis data using a variety of
reporting methods.

When a report is opened, plots and summary data are displayed, and in some reports certain
parameters (for example, permeability constant and pore shape exponent) are also displayed.
Plots may be edited by selecting the data points or data point range to be included in the plots and
modifying the parameters. When a report is edited, the results are immediately reflected in the
plots and summary data.
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Iml micromeritics® Report Features and Shortcuts

REPORT FEATURES AND SHORTCUTS

Reports can be customized and manipulated using the toolbar, shortcut menus, the zoom feature,
or axis cross-hairs.

m After analysis, reports can be viewed, printed, and/or copied and pasted into other documents.

® The report zoom feature provides the viewing of fine graph details and the ability to shift the
axes.

® All reports contain a header displaying file statistics.

D E

Cy \&“

B U | = Data display (graph or
o P : text)

Header

Generated tabs

Graphic

Title

List box

Toolbar

>

£

F

P
@mmD O

If configured, the report header can also contain a graphic and/or a title.

= Tabular and graphical reports contain sample and analyzer statistics such as analysis date/-
time, analysis conditions, etc.

® The headers contain notes of sample file changes occurring after analysis.
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6 About Reports [M] micromeritics®

REPORT HEADER SHORTCUTS

Right-click in the report header to display header shortcuts.

Sruany 1oeem Tabndir Food  inctheem L Pt O Tabuda flagt BT Taaratom ot
[ micromeritics®
05 m Tg Ahemina [
-

Capy hasder n st

Seral# 102 Und | P2

Edit
Copy header as text

Report Header Shortcuts

Selections Description
Copies the report header as text. Text is copied to the clipboard and
then can be pasted into other documents.

Edit Opens a dialog box for editing the report title.

Copy header as text

6-12 AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022



Report Features and Shortcuts

[M] micromeritics®

REPORT TOOLBAR

The Report window has a toolbar on the right portion of the window and selectable tabs at the top
of the report header. To view a specific report, either select the tab or the report in the Reports list

box, then click Show.

D

C \(— \ém

Ewane ot Room Temparature®iank Tune Anahysis

a1 Fet 1

>

Data display (graph or
text)

Header
Generated tabs
Graphic

Title

List box
Toolbar

arial & 103 Page 1

(0]
@mmDOOw

Report Toolbar

Selections

Description

Default Style [button]

Specifies default report parameters for fonts and curve properties.

Delete [button]

Deletes the selected report in the Reports list box. Deleted reports
will have to be regenerated if deleted in error.

Hide [button]

Hides (or temporarily removes) the selected report from the tabbed
view. The report name remains in the Reports list box.

Print [button]

Displays the Print window for report output.

Reports [group box]

Contains a list of all generated reports. The same reports display as
tabs at the top of the report header unless the report has been hid-
den using the Hide button.

Show [button]

Displays the selected or hidden report in the Reports list box.

/

For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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TABULAR REPORT FEATURES AND SHORTCUTS

Display tabular report shortcuts by right-clicking in the body of the tabular report. Column
shortcuts require right-clicking on the column to be modified.

Sumerony - Ence] Tobudn Frgest | Cuam Vil v 5iow | s Vel va e | D Vol va 5o 1| i Aumn v 50| Lo 0, Wil wa 50w 1| Vv S |

M micromeritics®

INSTRUMENT

AutoPore Serinl #1379 Port 22

rararacesl

TION

Tabular Report Shortcuts

Selections

Description

Align column

Changes the column alignment to either left, right, or centered.

Copy table as text Copies the report contents to the clipboard as tab-delimited text. It
can then be pasted into another document.
Edit title Edits the report title and/or title font attributes. Click Font to modify

font attributes.

Move column

Right-click the column to be moved. Select Move column on the short-
cut menu and select Left or Right for the move.

Rename column

Right-click the column to be renamed. Select Rename column on the
shortcut menu and enter the new column name.

Resize column

Right-click the column to be resized. Select Resize column on the
shortcut menu and enter the new column width in inches.

Show column

Displays a list of all columns. Click a column to add a checkmark to
show the column or remove the checkmark to hide the column.

Table data font

Right-click in the report data. Select Table data font on the shortcut
menu.

Table header font

Right-click in the report data. Select Table header font on the shortcut
menu.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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Iml micromeritics® Graph Features and Shortcuts

GRAPH FEATURES AND SHORTCUTS

Right-click in the graph area to display graph report shortcuts.
Graph Shortcut Options

Selections Description
Autoscale all axes Returns the report to full view after using the zoom feature.
Edit axis Edits the selected axis properties.
Axis Properties X
Tie: | Volume (om?) Title Font...
Scale
(®) Linear [I1nvert Scale Scale Font...
(O Logarithmic
[+/] Autoscale minimum 1.389
[~ Autoscale maximum 1.3925
Gridlines: Major: | Dotted ~ ‘
Minor: | None - ‘
Cance

Gridlines. Changes how to display major / minor grid lines.

Scale.

® Autoscale minimum/maximum. To manually specify minimum/
maximum autoscale, deselect the option and enter the new
amount in the text box.

= |nvert scale. Inverts the scale.

® Linear/Logarithmic. Scales the graph as linear or logarithmic.

m Scale font. Modifies the font for the scale label. Deselect Use
default font to enable font options.

Title. Edits the selected axis label.
Title font. Modifies the font for the selected axis label. Deselect Use

default font. Select new font attributes for report data. Enable Use
default font to reset default fonts.
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6 About Reports [M] micromeritics®

Graph Shortcut Options (continued)

Selections Description
Edit curve Edits selected curve properties.
Cunve Properties
3;1» Curve sl Points
Curve
Interpolation: | Akima Spline Color...
Mo
l__ oK Cancel

Color. Changes the curve color.

Curve. Changes the interpolation, point style, and pen style for the
selected curve. These options are disabled if Use default fill style is
selected in the Histogram group box.

Histogram. Enabled only if Histogram is selected in the Style drop-
down list. Specifies the type of fill, fill color, and label position for the
selected curve.

Label. Designates where the graph point labels will display (left,
right, center, etc.) on the SPC report.

Isotherm

@J”ﬁﬁ;&ﬂ:ﬁ

- |
g

S~

0o 01 02 3o 251 04 05 08 07 08 (x

Style. Selects another style for the collected data curve.
Title. Changes the title of the selected curve.

Use default thickness. Uses the default curve thickness. Deselect
to enter a new thickness number in the Thickness text box.
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[M] micromeritics®

Graph Features and Shortcuts

Graph Shortcut Options (continued)

Selections

Description

Edit legend

Changes the legend location and font.

Legend Properties

(O) Do not show

(®) Vertical above
(O) Horizontal above
O Left

(O)Right

() Bottom

Font...

X

Edit title

Changes the report title.

Paste Data

Used with pore distribution data reports only. Pastes ASCII text data
from the clipboard onto the active graph.

Reset axis limits to
initial setting

Removes the cross-hair and returns the graph back to the initial set-

ting.

Show curve

Displays a list of all curves. Select the curve(s) to display.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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6 About Reports [M] micromeritics®

AXIS CROSS-HAIR

Left-click on the graph to view the cross-hair coordinates.

Axis cross-hair
—— Signal {a.u.) - 1: H2Ar Gas Calibration /\

626 : r ; :
N Example of
Axis cross-hair feature

Signal (a.u.)

ZOoOoM FEATURE

Use the zoom feature to examine graph details. Click, hold, and drag the left mouse button on the
graphical area to be enlarged. A box will display in the area to be enlarged. To return to normal

view, right-click in the graph and select Autoscale all axes.

AutoPore V Series Operator Manual
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GRAPH GRID LINES

Options > Graph Grid Lines

Graph Grid Lines X

X-Axis
Linear Scale: Major [ IMinor
Logarithmic Scale: Major [ IMinor

Y-Axis
Linear Scale: Major [ Iminor
Logarithmic Scale: Major [IMinor

Grid Line Styles
Major: (O solid (®) Dotted
Minor: () solid (® Dotted

Use to select how grid lines appear on reports. This menu option is not available if using
Restricted option presentation.

Graph Grid Lines

Selections Description

Grid Line Styles Select if the major and/or minor grid lines should appear as solid or

[selection] dotted lines.

X-Axis / Y-Axis Select major and/or minor lines to display in reports for the

[selection] logarithmic and linear scales. Deselect this option to remove the grid
lines.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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GRAPH AND SAMPLE OVERLAYS

Use the graph overlay functions to compare multiple graph options. Graphical lines are
differentiated by the use of varying colored symbols outlined on a legend. Overlays may be
generated in two ways:

= Multiple Graph Overlays. Overlay two different types of graphs from one sample.
= Multiple Sample Overlays. Overlay graphs of the same type with that of the current plot.

/ This feature is available only when using Advanced option presentation. Go to
Options > Option Presentation > Advanced.

AutoPore V Series Operator Manual

6-20 962-42800-01 (Rev E) — Oct 2022



Iml micromeritics® Generate Pore Size Distribution Graph Overlays

GENERATE PORE SizE DISTRIBUTION GRAPH OVERLAYS

The following reports in the mercury porosimetry application can produce graphical results for a
sample material's pore size distribution:

Two methods can be used to import and overlay report data into another interactive graph using
shortcut menu options:

= |Import ASCII text data. Data can be imported from an ASCI| text file into the interactive graph.
The ASCII text file must follow certain rules.

= Copy/paste. Data can be copied from one sample file (source) and pasted into another sample
file (target).

Pore size distribution report overlays menu selections are:

Copy data

Paste data

Edit Imported Data
Display Imported Data

AutoPore V Series Operator Manual
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IMPORT ASCII TEXT DATA

ASCII text file format rules

® The header must consist of one line to include title, two unit specifications, and distribution
type:

°  Accepted pore dimension units are: A, nm, um
o Accepted pore volume units are: cm3/g, cm3/g, mL/g

o Accepted distribution types are: cumulative, incremental
Two examples of a header format:

My Title (A, cm3/g, incremental)
My Title (A, cm3/g, cumulative)

® The data must be in two columns and should be separated by a comma or white space.
® The data lines must be ordered so that pore dimensions are monotonically increasing or
decreasing.

Sample ASCII Text File

silica alumina bjh (A, cm3/g,
cumulative)

456 657 0.0133559
444 847 0.0546427
429168 0.0869924
425 419 0.119721
419629 0.132681
360.634 0.156611
340.859 0.197672
326.601 0233092

Window appearance will vary depending on the selected report. This function can be performed
on samples files with a Complete status or during an analysis.

Create the ASCI| text file using the proper format as indicated above.
In the analyzer application, go to File > Open.

Select a sample file to overlay graphs on to.

Click Open (or double-click the file name).

Right-click in the graph area and select Edit imported data.

o b owbd=
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Iml micromeritics® Generate Pore Size Distribution Graph Overlays

In the Select Imported Overlays window, if the ASCII text file does not display, click Import
to locate the file.

. Select the ASCII text file in the Select Imported Overlays window, then click OK. If an error

message is displayed, verify that the .TXT file format is in the correct format.

To include the overlay data in a printed report, see Print Pore Size Distribution Overlay
Data in Reports below.

OVERLAY PORE SizZE DISTRIBUTION DATA USING COPY/PASTE

1.

ok own

Open a source sample file and a target sample file; both should have a Complete status.
The report will open to the interactive reports window.

In the source sample file, right-click on the graph and select Show Curve.
Deselect any differential curve data to hide them in the graph.
Right-click in the graph area again and select Copy Data.

Change to the target sample file, right-click the graph, and select Paste data. The graph
now displays overlayed data from the source sample file.

Typically, one new graph will appear showing both the cumulative and differential curves.
To show or hide individual curves, right-click the graph and select (or deselect) Display
imported data.

Ensure that all parameter fields are set appropriately, then click Paste.

To include the overlay data in a printed report, see Print Pore Size Distribution Overlay Data
in Reports.

Print Pore Size Distribution Overlay Data in Reports

1.

2.
3.

No gk

Open the sample file containing the overlay data and select Advanced from the view
selector drop-down list at the bottom of the window.

Click the Report Options tab.

In the Selected Reports list box, select the cumulative, differential, or incremental intrusion
graph to show the imported distribution data, then click Edit (or double-click the selected
report).

In the Overlay drop-down box, select Imported.

Click OK to close the window.

Click Preview on the Report Options tab.

Click Print in the reports toolbar section to display print options.

AutoPore V Series Operator Manual
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IMPORT ASCII PORE DISTRIBUTION DATA

Manually Enter Data on page 3-8

IMPORT AN ASCII TEXT FILE USING GRAPH SHORTCUTS

1.
2.
3.

Create an ASCI| text file.
Open a report with a Complete status.

Select a pore-size distribution report from the view selector drop-down list at the bottom of
the window.

Right-click on the graph and select Edit imported data on the shortcut menu.

If the ASCII text file does not display on the Selected Imported Overlays window, click
Import.

Locate and select the file, then click Open. Header information from the ASCII text file will
appear in the Select Imported Overlays window.

. Select the entry, then click OK. If an error message appears, verify that the .TXT file format

is correct.

To hide or show imported data, right-click in the graph area and use the Display imported
data option on the shortcut menu.

CoPY/PASTE AN ASCII TEXT FILE USING GRAPH SHORTCUTS

honh =

o

Create an ASClI text file.
Copy the ASCII text data to the clipboard.
Open a report with a Complete status.

Select a pore-size distribution report from the view selector drop-down list at the bottom of
the window.

Right-click on the graph and select Paste data on the shortcut menu.

To hide or show imported data, right-click in the graph area and use the Display imported
data option on the shortcut menu.

CoOPY/PASTE GRAPH DATA FROM ANOTHER GRAPH

ok owbd=~

Open a source pore distribution data report with a Complete status.
Right-click on the graph and select Copy Data on the shortcut menu.
Open the target pore distribution data report.

Right-click on the graph and select Paste Data on the shortcut menu.

To hide or show imported data, right-click in the graph area and use the Display imported
data option on the shortcut menu.

6-24
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Iml micromeritics® Overlay Multiple Graph Options

OVERLAY MULTIPLE GRAPH OPTIONS

1. Goto File > Open.

2. Select the .SMP file, then click Open.

3. Select Advanced from the view selector drop-down list at the bottom of the window.
4. Click the Report Options tab.

5. Inthe Reports list box, highlight a plot report, then click Edit.

Anabvsis - Roport

Sample .
Description Condtions. Options.

Report Opicns: | CPG1000A

Header Options.. Intrusion Dita Opfions...
Selected Reparts

Save Ay Clase Advanced

6. Inthe Y-Axis group box, select Variable and/or Overlay options.
7. Click OK to return to the Report Options tab.
8. Click Save, Save As, or Preview.
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OVERLAY MULTIPLE SAMPLE FILES

This feature is applicable to overlaying samples from samples files with an LP Complete, HP
Complete or Entered status.

-_—

. Goto File > Open.

. Select the .SMP file, then click Open. Select Advanced from the view selector drop-down
list at the bottom of the window to display the Report Options tab.
Click the Report Options tab.

. Inthe Reports list box, highlight a plot report, then click Overlays.

N

w

N Fe =
Analysis

Sample - Poport
Description Condtions. Options. |

Report Opions: | CPG1000A

Header Ogtions... Irtrusion Data Opfions...

Selected Reparts

Sebected b T St e i)

5. On the Plot Overlay Sample Selection window, move files from the Available Files box to
the Selected Files box.

6. Click Save, Save As, or Preview.
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REPORT EXAMPLES

REVERBERI REPORT PLOT

Micromeritics Instrument Corporation

oActive AutoPore W 9600 MicroActive AutoPore V 9600
Serial # 102 Port 31

Sample: Reverberi Sample
Operator:
Submitter:
File: CiMicroActive AutoPore. \Reverberi Sample Port 3.5MP

LP Analysis Time: 4162014 11:07:12 AM Sample Mass: 0.8264 g
HP Analysis Time: 4M6/2014 2:45:09 PM Stemm Volume Used: 33 %
Report Time: 41772014 6:59:21 AM Show Meg. Int. Mo
Report Range: 010 to 61,000.00 psia Correction Type: None
Adv. ContactAngle: 130,000 ° Mercury Temperature: 21.02 *C

Rec. ContactAngle: 130.000°

Incremental Intrusion vs Pore size

—+— Intrusion for Cycle 1 —a— Extrusion for Cycle 1
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E E i f
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2 0.0157------- R SEERCREEEEED SEEh e RS
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Pare size Diameter (um)
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SiLicA ALUMINA REFERENCE MATERIAL REPORT

Micromeritics Instrument Corporation

MicroActive AutoPore ¥ 9600 MicroActive AutoPore \V 9600
Serial # 102 Port 11

Sample: SilicaAlumina Reference Material Run A
Operator:
Submitter:
File: C:AMicroActive AutoPora V. \Silica Alumina Port 1.5MP

LP Analysis Time: 4/8/2014 8:52:51 PM Sample Mass: 1.0652 g
HP Analysis Time: 4/9/2014 8:33.55AM Stem Volume Used: 51 %
Report Time: 4M7/2014 7:24:39 AM Show Meg. Int: No
Report Range: 0.10to 61,000.00 psia Correction Type: None
Adv ContactAngle: 130.000 © Mercury Temperature: 21.64 °C

Rec. ContactAngle: 130.000 °

Incremental Intrusion vs Pressure

—+— Intrusion for Cycle 1

Incremental Intrusion (mLig)

Pressure (psia)
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m micromeritics Garnet Tabular Report
GARNET TABULAR REPORT
Micromeritics Instrument Corporation
MicroActive AutoPore V 9600 MicroActive AutoPore Y 9600
Serial # 102 Port 11
Sample: garnetref mat 60k eqil (rate) 568
Cperator:. jch
Submitter: micromeritics peformance test
File: C:\MicroActive AutoPore V . \Garnet to 60K Port 1.5MP
LP Analysis Time: 4/10/2014 3:16:40 PM Sample Mass: 0.2899g
HP Analysis Time: 4/10/2014 5:21:38 PM Stem Volume Used: 28 %
Report Time: 417/2014 7:36:34 AM Show MNeg. Int. No
Report Range: 0.10 to 641,000.00 psia Correction Type: None
Adv. ContactAngle: 130,000 ° Mercury Temperature: 21.28 °C
Rec. ContactAngle: 130.000 °
Tabular Report
Mean Cumulative Incremental Cumulative Incremental
Pressure Diameter Pore Volume Pare Volume Pore Area Pore Area
(psia) (umj (mLig) (mLig) (m*g) (m#ig)
1.02 176.49789 0.0000 0.0000 0.000 0.000
2.00 133.52629 0.0095 0.0095 0.000 0.000
3.00 75.44654 0.0206 0.011 0.001 0.001
4.00 5279904 0.0260 0.0053 0.001 0.000
5.00 4072799 0.0314 0.0055 0.002 0.001
6.00 3317779 0.0347 0.0032 0.002 0.000
6.99 28.00820 0.0379 0.0032 0.003 0.000
8.00 2423739 0.0405 0.0026 0.003 0.000
5.099 21.36405 0.0429 0.0024 0.004 0.000
10.00 19.10206 0.0439 0.001 0.004 0.000
10.99 17.27178 0.0460 0.0020 0.004 0.000
11.98 15.76445 0.0481 0.0021 0.005 0.001
13.00 14.49805 0.0499 0.0018 0.005 0.001
13.99 13.42028 0.0515 0.0016 0.006 0.000
14.99 12.49258 0.0531 0.0016 0.006 0.000
15.99 11.68533 0.0542 o.oo0m 0.007 0.000
16.99 10.97620 0.0555 0.0013 0.007 0.000
17.99 10.34770 0.0567 0.0012 0.008 0.000
18.99 978763 0.0577 0.0009 0.008 0.000
19.99 9.28496 0.0587 0.0010 0.008 0.000
20.99 8.83121 0.0598 g.oom 0.009 0.000
21.99 8.42027 0.0608 0.0010 0.009 0.000
2299 8.04556 0.0616 0.0009 0.010 0.000
23.99 770264 0.0627 0.0010 0.010 0.001
2499 7.38819 0.0635 0.0009 0.0M 0.000
2599 7.09860 0.0639 0.0004 0.onm 0.000
26.99 £.83063 0.0653 0.0014 0.012 0.001
27.99 6.58155 0.0657 0.0004 0.012 0.000
28.99 6.35046 0.0671 0.0014 0.013 0.001
30.00 6.13444 0.0679 0.0009 0.014 0.001
30.45 598441 0.0683 0.0004 0.014 0.000
3092 589437 0.0687 0.0004 0.014 0.000
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CONTROLLED PORE GLASS PLOT

CONTROLLED PORE GLASS

MicroActive AutoPore V 9600 MicroActive AutoPore V 9600
Serial # 102 Port 1M1

Sample: Controlled Pore Glass (3000 Angstrom)
Operator: BPM
Submitter: R. CAMP
File: CAMicroActive AutoPore VWV 96000 MCPG 2000 Port 1.8MP

LP Analysis Time: 4M11/2014 11:52:01 AM Sample Mass: 0.2101 g
HF Analysis Time: 4/171/2014 1:12:06 PM Stem Volume Used: 19 %
Report Time: 4172014 7:47:16 AM Show MNeg. Int: Yes
Report Range: 0.00050 to 500000000 ym Correction Type: Mone
Adv. ContactAngle: 130.000 * Mercury Temperature: 21.16 *C

Rec. ContactAngle: 130.000 *

Cumulative Pore Area vs Pore size
—+— Intrusion for Cycle 1

—
T

e

Cumulative Pore area (o)

(=]
4
[ T A,

=]
4
=

1 01 0.01
Pore size Diameter (pm)
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[M] micromeritics®

7 SELECTED REPORTS

To edit reports, open the Sample file then select the Report Options tab. Highlight the
report name in the Selected Reports list box and click Edit.

ADVANCED REPORTS

Advanced Reports - Python Module on page A - 1

GRAPH REPORT OPTIONS

® Cumulative Area vs Size Plot Options
® Cumulative Volume vs Pressure Plot Options
= Cumulative Volume vs Size Plot Options
= Difference from Reference % Volume Plot Options
m Differential Intrusion Plot Options
= Differential Volume vs Size Plot Options
® |ncremental Volume vs Pressure Plot Options
= |ncremental Volume vs Size Plot Options
® | og Differential Intrusion Plot Options
= Qut of Specification % Volume Plot Options
[} [==]=]
Sample Analysis Report
Description Conditions ‘Options
oo e
Report Options:  Default Report Options - Options
[ Header Optians. .. ] [ Intrusion Data Options... ] [¥]PlotPoints  [#]Plot Curve [ Show As Histogram
o E== Omre | Oteen
Icnucm.vzlu\.v 5o [Lr L ® Logarithmic
Cur‘n.Ar‘EavsS\zE kil oo
[#]Cum. Vel. ve Pressure
g;\;“o'“\'fs:s’;:”“ [¥] Autoscale 0.50 5,000,000.00
DL?Q Diff. vol. vs Size ) Y-Axis
o soac v o s verisie e |5
i
[T Cavity to Throat Size Ratio DAl DAl
[~ Fractal Dimension
[¥]Reverberi [¥] Autoscale -10,000.000 10,000.000
[T]Density vs Pressure
[~ Advanced
[¥]options
[ |sample Log
[7]validation
Save Close Advanced v Preview

AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022



7 Selected Reports [M] micromeritics®

Graph Reports

Selections Description

Autoscale [check box] When enabled on the report parameters windows, allows the x- and
y- axes to be scaled automatically. Autoscale means that the x- and
y- ranges will be set so that all the data is shown. If Autoscale is not
selected, the entered range is used.

Options [check box] Plot Points. Select to plot the points on the graph.
Plot Curve. Interpolated from data points.

Show As Histogram. When selected, Plot Points and Plot Curve
options are disabled.

Overlays [button] Select sample files that contain data to be overlayed onto the selec-
ted plot.

Reference [button] Select a sample file to compare analysis results of the current
sample.

Specification [button] Specify sample files to use for the boundaries of the coarse and fine
specifications.

X-Axis [group box] Select options for the x-axis.
Variable.
Scale.

Y-Axis [group box] Select options for the y-axis.

Variable. Select the y-axis variable from the drop-down list.
Overlay. [Optional]. Select an option to overlay.

Intrusion / Extrusion. Select the data points to plot.

® None. No intrusion (or extrusion) data points
® First. Points from the first intrusion (or extrusion) cycle
® All. Include all intrusion (or extrusion) data points

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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CAVITY TO THROAT SiIZE RATIO REPORT OPTIONS

= oo e |

Select Reports
Cavity to throat size ratio plot

Cavity to throat size ratio table

Select Pressures Induded in Report

Select to show the cavity to throat size ratio plot ratio table.

Cavity to Throat Size Ratio Reports

Selections Description

Cavity to throat size Displays the ratio plot.

ratio plot [check box]

Cavity to throat size Displays the ratio table.

ratio table [check box]

Pressures [button] Enter the minimum and maximum calculation pressure range.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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[M] micromeritics®

FRACTAL DIMENSION REPORT OPTIONS

The fractal dimensions can be shown as a graph, table, or both. The graph and table reports
contain the fractal dimension and the RMS error to give an indication of the quality of the fit.

=8| =)
Select pressure ranges for fractal dimension fits
Backbone region: 10,00 to 280,00 psia
Percolation region: 2,500.00 +tp 10,000.00 psia
Select Reports
[¥]Log(V) vs. Log(P-Pt) plot
Backbone region:
[¥] plat [ table
Percolation region:
[¥] plat [ table
Select Pressures Included in Report
Enter a value between 010 and 61,000.00.
Fractal Dimension Reports
Selections Description
Backbone region Enter the pressure at which the calculations are to be performed.
[text box]
Percolation region Enter the pressure at which the calculations are to be performed.
[text box]
Pressures [button] Select to enter minimum and maximum pressures.
Select Reports Show Log(V) vs Log (P-Pt) graph. Select to generate an additional
[check box] graph to help select linear range for calculations.
Backbone region. Select the type of report to generate.
Percolation region. Select the type of report to generate.

Buttons on page 2 - 2.

/ For fields and buttons not listed in this table; see Common Fields and
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MATERIAL COMPRESSIBILITY REPORT OPTIONS

The compressibility calculations can be shown as a graph, table, or both. The graph and table
reports contain the linear and quadratic ¢ compressibility values and the RMS error to give an
indication of the quality of the fit. The linear and quadratic compressibility coefficients from this
report can be copied into a Material Properties parameter file for use in future sample analyses

with the same material.

[E=0 EoH =)
Select Pressure Range for Compressibility Fit
200 10.00 psia

Select Reports

Material compressibility correction plot

[ Tabular repert
Select Pressures Included in Report
Warning: The compressibility values are most accurate if
this uses a blank correction with a run without sample
under the same analysis conditions.

Material Compressibility Reports

Selections Description
Pressures [button] Enter the calculation pressure range.
Range [text box] P1. Enter the beginning pressure.

P2. Enter the ending pressure.

Material compressibility correction plot. Displays the results in
graph format. The graph plots pressure on a log scale on the x-axis
and the volume compressed readings as points on the y-axis, with
the theoretical curve based on the calculated values overlaid.

Select Reports
[group box]

Tabular report. Displays the results in table format. The table
displays pressure, volume compressed, predicted volume
compressed, and error.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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MAYER-STOWE REPORT OPTIONS

[= ][ © )

Select Reports
Cumulative valume vs. partide size plot
Tabular repart

Select Pressures Induded in Report

Pressures...

Mayer-Stowe Reports

Selections Description

Cumulative volume vs particle size plot | Select to show the ratio plot.

[check box]

Pressures [button] Select to enter the minimum and maximum cal-
culation pressure range.

Tabular report [check box] Select to show the ratio table

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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OPTIONS REPORT

The Options report for mercury porosimetry analyses lists the conditions used to perform the
analysis— such as:

Analysis conditions
Evacuation options

]

. Mercury properties
® High pressure options

|

]

Penetrometer properties
Reverberi options
Sample information

Low pressure options
Material properties

/ Options reports cannot be edited.
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PORE STRUCTURE OPTIONS

[= ][ © )

Surface Area
(@) BET () Calculated

Permeability constant:  0.00442
Pore shape exponent: 1.00

Select Reports
Percent intrusion plot
[ rabular report

Select Pressures Induded in Report

Pressures...

Pore Structure Reports

Selections

Description

Permeability constant
[text box]

Viewed on Report Summary.

Pore shape exponent
[text box]

Viewed on Report Summary.

Pressures [button]

Select to enter minimum and maximum pressures.

Select Reports [group box]

Select the report type.

Surface Area [group box]

Select the type of Surface Area to reference.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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REVERBERI REPORT OPTIONS

i

== |EEHEXS

Select Reports
[ Tabular repaort

Show all 1.00

Autoscale 1.00

Show all 1.00

Autoscale 1.00

Show all 1.00

Autoscale 1.00

Select Pressures Induded in Report

[ 20 graph of cumulative distribution function vs. throat diameter @ cavity diameter

[] 2D graph of dv/diog(throat diameter) @ cavity diameter vs. throat diameter @ cavity diameter

[] Show 3D graph of dv/dleg(throat diameter) @ cavity diameter vs, throat diameter @ cavity diameter

1.00

1.00

1.00

100

1.00

100

Cancel

Reverberi Reports

Selections

Description

Cavity diameter
[check box]

Select Show all to display all diameters or enter a specific range to
display.

Show 2D graph of
cumulative distribution
... [check box]

Displays a 2D graph with this description.

Show 2D graph of dV/d-
log (throat diameter) ...
[check box]

Displays a 2D graph with this description.

Show 3D graph of dV/d-
log (throat diameter) ...
[check box]

Displays a 3D graph with this description.

Show table [check box]

Displays a table in the report.

Throat diameter
[check box]

Select Autoscale to autoscale the throat diameter or enter a specific
range to display.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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SAMPLE LOG REPORT

/ Sample Log reports cannot be edited.

Inserts a log of sample operations in the reports.

This report provides information on:

= Manual control operations performed during analysis.
= |nformation entered using Add Log Entry on the sample file editor.
= \Warnings and/or errors which occurred during analysis.
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[M] micromeritics’ Summary Report

SUMMARY REPORT

The Summary Report provides a condensed listing of selected data results.

=] [E=8 o8 =X
Intrusion Summary
[Pl show Graph
Total intrusion volume
— [Fshon Fressre Table
e fiwnete [ show Pore Size Table Options.
Average pore dismeter [ show Percent Intrusion Table
7 "
Eulk density at 0.10 ] show Peak Table
Apparent density at  61,000,00
Porosity Pore Structure Summary...
Physical Properties Summary...
[ Total intrusion vol [] Total intrusion vel [ Total intrusion vol [ Total intrusion vol

Summary Report

Selections Description

Intrusion Summary Select the intrusion options to include in the report. If Bulk Density is

[group box] selected, enter the pressure for the measurement. If the entered
pressure is below the filling pressure, the filling pressure will be used
in the report.

Physical Properties Select the physical properties to display on the report.
Summary [button]

[E=RECR =

[ Mayer-Stowe interstitial porosity
[ Mayer-Stowe breakthrough pressure ratio

[ Material compressibility coeffidents

[ calculated porosity
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7 Selected Reports

[M] micromeritics®

Summary Report (continued)

Selections

Description

Pore Structure
Summary [button]

Select the pore structure to be included in the report.

===l

Permeability

Threshold pressure
Characteristic length
Conductivity formation factor

Tortuosity factor
Tortuosity

Percolation fractal dimension
Backbone fractal dimension

e

Show Graph [check box]

Displays the report in graph format. Click Options to select how the
graph should display.

Pt e

See Report Options on page 4 - 12 for a description of fields and
buttons on this window.
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[M] micromeritics Summry Report

Summary Report (continued)

Selections Description
Show Peak Table Displays the peak table in the report. Click Options to select how the
[check box] graph should display.
o lie e
@ Auto &
Minimum percent of distribution to report: 0.0000 %
Minimum valley depth to separation peaks: 0.0000 =g
) Manual
(@) Diameter
Volume
I Min Max i
1 0.009| 0.509
Insert
Delete
Clear
Append L
< m ] » "

Auto. Select to have the system automatically identify peaks based
on the entered minimum valley depth to separation peaks. Enter the
minimum settings.

Manual. Select to manually enter the minimum and maximum
diameter or volume for each peak in the table.

Show Percent Intrusion | Click Options to enter the percentile intrusion for the report.
[table]

e

S r=—r—r=
e r——r——
1 [Camiion v

* e

i
ikl
FEEELE
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7 Selected Reports [M] micromeritics®

Summary Report (continued)

Selections Description

Show Pore Size Table |Selectto show pore size in the report. Click Options to select points
[check box] to display.

PEEEEE
|
i

Show Pressure Table Select to display pressure points in the report. Click Options to
[check box] select points to display. Use the drop-down fields to specify the data
to appear in the specified columns for report generation.

==
| i T | i
r————

£
PEEEEE

= e

Total intrusion volume |Enables the Pass/Fail button.
[check box]

Upper / Lower. Specify upper and lower limits for the selected
parameter. A range can be left open by not selecting the limit. In the
text box to the right of Upper/Lower, enter operator instructions to
be displayed if a failure is encountered.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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[M] micromeritics®

Tabular Report Options

TABULAR REPORT OPTIONS

Tabular reports display the numerical values for the data points. Up to six columns of data can be
selected to display on the report.

=] =lo s
Tabular Data Definition
@) Collected data
") Tabular data set —

In the Tabular Data Definition group box, indicate select either Collected data or Tabular data set

for this report.
Tabular Reports

Selections

Description

Column [n]
[drop-down box]

Use the drop-down fields to specify the data to appear in the spe-
cified columns for report generation.

Tabular Data Definition
[group box]

Collected data. Select to use data points collected during analysis.
Data are collected at equilibration points on or about the pressure
points specified in the pressure table used for each analysis.

Tabular data set. Select to have a table of specific pressure points
or pore sizes included in tabular reports. Allows for the comparison of
data from various runs, because it interpolates values from each
sample run at the points specified in the table. When this option is
selected, the Table button is enabled.
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7 Selected Reports

[M] micromeritics

Tabular Reports (continued)

Selections Description

m Data Set. Select either Pressure, Pore size, or Percent intrusion
as the data set.

Click Insert to insert a data point immediately before the selected
point. To complete the table quickly, enter the highest value in the
set, then click Insert to enter points below that value.

Y, For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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8 DIAGNOSTICS

Unit [n] > Diagnostics

Use to display diagnostic readings, start and schedule diagnostic tests, and open saved
diagnostic reports. Each test generates a file to the default directory name and path of
...\...\Service\userdiag unless another directory name was specified. These reports can be sent to
a Micromeritics Service Representative for examination.

START DIAGNOSTIC TEST

Unit [n] > Diagnostics > Start Diagnostic Test

Provides a method to start a diagnostic testimmediately. Upon completion of the diagnostic test,
the file is saved as a .REP file which can be retrieved by going to Reports > Open Report and
selecting the report file.

m]) Diagnostic Test E@

View:  Operation i

Test: =

Operator: Sequence:

Comments

Estimated time: min.

["IReport after test

Repeat Start Close

‘ File:

Start Diagnostic Test

Selections Description

Comments [text box] Displays comments from the selected diagnostic test.
Estimated time (min.) |Approximate time for test completion.

[text box]

File [group box] Shows a status bar of steps complete once the test begins.
Next [button] Starts the next test.

Operator [text box] Enter information to identify the person running the service test.
Repeat [button] Repeats the selected diagnostic test.

AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022




8 Diagnostics EI micromeritics®

Start Diagnostic Test (continued)

Selections Description

Report after test Automatically generates reports to the selected destination when the
[check box] test is complete.

Sequence Sequence number assigned to the test.

Start [button] Starts the diagnostic test.

Test [drop-down box] Select the diagnostic test to be performed.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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SCHEDULE DIAGNOSTIC TESTS

Unit [n] > Diagnostics > Schedule Diagnostic Tests

Allows the specification of one-time or periodic running of a sequence of diagnostic tests. A
separate list of tests is saved for each of the possible test frequencies. Tests are categorized and
flagged as requiring intervention or not. If tests requiring intervention are scheduled, the operator
has the option of omitting the tests if the operator does not respond within a specified time after an
initial prompt is displayed and before the test is started. Events are logged in the analyzer log for
all starting, ending, and omitted tests.

Schedule Diagrostic Tests L=z
Test Frequency |
Once (Today)
Daby
Weeidy Day:

@ Monthly  Date: [y

Start test sequence If instrument is idie any tme between

00:00=00 ¥ and 00:00:00
L P —

Test Sequence

e ldentilication Est Time (men)  Intervertion Reg

Marked tests requine operater infervention o run,
Skip these tests if the operator does not respond within mrutes

Schedule Diagnostics Test Frequency

Selections Description

Available Tests Select one or more tests to run unattended.
[drop-down box]

Insert [button] Inserts the selected test in the Available Tests drop-down list.

Skip these tests if the | Check this option if any test requiring operator intervention should be
operator does not omitted if the operator does not respond within the specified time.
respond within [n]
minutes [check box]
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8 Diagnostics EI micromeritics®

Schedule Diagnostics Test Frequency (continued)

Selections Description

Start test sequence if | Enter afrom and to time for an unattended test to begin if the instru-
instrument is idle any | mentis idle at any time during the entered time frame.

time between 00:00:00
and 00:00:00 [text box]

Test Frequency Select how often the test is to run unattended.

[selection]

Test Sequence Provides the test file identification and estimated run time. A
[group box] checkmark in the Intervention Required column indicates that

operator intervention is required.

To remove a test from the sequence, select the test, then click
Delete.

To add a test to the test sequence, highlight a row in the Test
Sequence box, select a test from the Available Tests list, then click
Insert.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.

DIAGNOSTIC TEST REPORT

Unit [n] > Diagnostics > Diagnostic Test Report

Displays previously run diagnostic service tests. Separate directories store tests run once, daily,
weekly, and monthly. Diagnostic test report files have a .SVT file extension and are stored in the
...\Service directory.
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Iml micromeritics® Save Files for Problem Diagnosis

SAVE FILES FOR PROBLEM DIAGNOSIS

Unit [n] > Diagnostics > Save Files for Problem Diagnosis

Use to compress pertinent diagnostic information into a single zip file. This file can be sentto a
Micromeritics Service Representative for problem resolution.

User mormazen MTTmETRCS representatve

huaee o then serten of

Protlem descrpaen:

Enchade fiex
Infsrmation sbcut the nssrument and problem wil be pamered e
and stoved in 2 1P fle.

® Please erter conmact informasion and 8 descrpeen of the

o

= ckd any fles ot are reloted i fhe problem, for instance
sampie fles, 30 sive e fie.

» Send sm emal 1 Service MelpOesh@micromestics.com for
nsiructons on how 1o ransfer the ZIP fle i Mcremerics

Save Je. o Cancel

1. Complete the form. A default file named Diagnostics-[date].zip is created unless another file
name is specified.
2. Add any files that are related to the problem — such as sample files — and save the file.
3. Send an email to Service.Helpdesk@Micromeritics.com for instructions on how to transfer
the .ZIP files to Micromeritics.
Save Files for Problem Diagnostics

Selections Description

Problem description Enter information that would be helpful to the Micromeritics rep-

[text box] resentative.

Include Files [button] = Add. Click to select additional files to send with this problem
diagnosis.

m Delete. Select the file in the Include Files box, then click Delete to
remove the file from the list.

m Clear. Click to clear all files from the Include Files box.

Save As [button] Click to specify the name and location of the compressed file. Make a
note of the file name and location. This file will need to be sent to
your Micromeritics representative for problem resolution.

Micromeritics Enter the name of your Micromeritics representative. This inform-
representative [text box] | ation will remain on the window each time files for problem diagnosis
need to be submitted (can be modified as necessary).
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8 Diagnostics EI micromeritics®

Save Files for Problem Diagnostics (continued)

Selections Description

User Information Enter information for the person to be contacted by a Micromeritics

[text box] representative. This information will remain on the window each time
files for problem diagnosis need to be submitted (can be modified as
necessary).

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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9 CALIBRATION

Unit [n] > Calibration

accessories. It is not necessary to recalibrate the system unless it seems out of

/ A calibration file was created specifically for the analyzer and included with the
calibration.

Disabled calibration menu options can be accessed only with the assistance of an authorized
Micromeritics Service Representative. Calibrations can be saved to a file and reloaded later.

To review calibration details of the analyzer, go to Unit [n] > Unit Configuration.

Generally, it will not be necessary to change the data in the calibration file. However, if a condition
occurs during the operational verification that requires changes to the calibration data, changes
should be saved in a file. Calibration data files are retained in the analyzer history file and can be
reloaded in the event that calibration data becomes corrupt.

CALIBRATE THE Low PRESSURE SERVO

Unit [n] > Calibration > Low Pressure Servo

/ Ensure the pressure transducer was calibrated by a service technician before starting
this process.

This procedure will calibrate the servo valve to the pressure transducer.

=] [E=H B8 50
File Unitl Reports Options Window Help - |5 x

This procedure will calibrate the servo valve to the

pressure transducer,

Make sure that the low pressure chambers are sealed

with rods in place.

Make sure that the pressure transducer was calibrated

before starting.

Start Cancel
Tdle
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9 Calibration

[M] micromeritics®

CALIBRATE SIGNALS

Unit [n] > Calibration > Signals

f=la] =

Low Pressure

Cap. 1pF  Cap.2pF  Cap.3pF  Cap. 4pF  VacpmHg  SOPSIA
Reading: 19 1% 196 19 760,137 14,70
Low Cal.: [ 1500 ] [ 1500 ] [ 1500 ] [ 1500 | [ 10 ] [ oo |
HiCal.: [ 1s0.00 | [ 15000 | [ 1s0.00 | [ 150.00 | [ 740,000 | [ 40,00 |
Calibrated:
Raw Count: 0 1 2 g 43,000 43,000
High Pressure Temperature

LeftCap.pF Rt Cap.pF  SODOPSIA 60,000 PSIA
Reading: 196 196 14.7 14.7 Reading: 26.0

Low Cal.: [ 1500 | [ 1500 | [

193 | [ 143 | Temp. Cal.: [ 20.0

HiCal.: [ 15000 | [ 15000 | [ s000.0 | [ 30,0000 | Calibrated:

Calibrated:
Raw Count: 3

Raw Count: 2

During calibration, the capacitance detectors, vacuum gauge, reference gauge, transducer, etc.
are read. Analysis cannot be started while the calibration window is open.

To manually enter calibration data, click the button containing the value to be changed and enter
the data on the popup window.

Calibration Signals

Selections

Description

Low Pressure

Reading. Displays the current values from each capacitance
detector.

Low Cal. Displays the capacitance of the reference device with the
lower value.

Hi Cal. Displays the capacitance of the reference device with the
higher value.

Calibrated. The date the capacitance detector was last calibrated.

Raw Count. The digital value produced by the analyzer for each
capacitance detector.

Vac ymHg.

® Reading. The current value from the vacuum gauge.

® |Low Cal. The pressure value read on a reference vacuum gauge
after vacuum is achieved.

® High Cal. The pressure value read on a reference vacuum gauge
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[M] micromeritics’ Calbrate Signas

Calibration Signals (continued)

Selections Description

when higher pressure is applied.

® Calibrated. The date the vacuum gauge was last calibrated.

® Raw Count. The digital value produced by the analyzer for the
vacuum gauge.

50 PSIA

® Reading. The current value from the 50 psia transducer.

® Low Cal. The pressure value read on a reference transducer after
vacuum is achieved.

= High Cal. The pressure value read on a reference transducer
when higher pressure is applied.

m Calibrated. The date the 50 psia transducer was last calibrated.

® Raw Count. The digital value produced by the analyzer for the 50
psia transducer .

High Pressure Reading. Displays the current values for the left and right
capacitance detectors.

Low Cal. Displays the left and right capacitance detectors of the
reference device with the lower value.

Hi Cal. Displays the capacitance of the left and right capacitance
detectors with the higher value.

Calibrated. The date the left and right capacitance detectors were
last calibrated.

Raw Count. The digital value produced by the analyzer for left and
right capacitance detectors.

Temperature Reading. The transducer's current temperature.

Temp Cal. The calibration setting for the transducer. Click to reset
the temperature.

Calibrated. The date the transducer was last calibrated.

Raw Count. The digital value produced by the analyzer for the
transducers.

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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9 Calbration [M] micromeritics®

CALIBRATE THE PENETROMETER

Unit [n] > Calibrate Penetrometer

Up to 4 penetrometers can be calibrated simultaneously.

To have the application determine sample density or if blank correction by formula will be used,
the calibrated empty volume of each penetrometer must be entered in the Penetrometer
Properties file. The file can then be selected and used for analyses.

View: | operation -

Fil

o

Port Sample

Status: _ Idle

&
w

[E=8ECR =3
1 Penetrometer: [10-0142 5Bub, 1,131 Stem, Powder
: jous volume: 6.0914mL
Eni i
® cak om ured temperature
ter: [10-0317 5 Bul, 1.131 Stem, Powder -
Temperature Density e
0000 g Previous volume: 5.9948 mL O om) |z
1 18.00 13.5512
.00 13.547
3. Penetrometer: i s Powe —
enetrometer: | 10-0933 5 Bub, 1.131 Stem, Powder 3 0.0  13.5%2
mass: 60.0000 g Previous volume: 5.3503 L 2 Pry
5 22.00 13.5413
s 20 13548 -
Previous volume: ©.0449 mL
Tnsert the empty penetrometers and press the Filbutton. Empty mass of ll selected pene trometers must be areater than 1.0000 .
Enter a value between 1.0000 and 1,000.0000.
Close
Intrusion
Vol.(mL/g) % Stem
0.000
0.000
0.000
0.000
Pressure: 0.00 psia

1.

For each penetrometer to be calibrated, click the drop-down arrow to the right of the Pen-
etrometer field and select a Penetrometer Properties file. If this is a new penetrometer, a
new Penetrometer Properties file must be created for each new penetrometer, then select
the Penetrometer Properties file from the drop-down list. To create a new Penetrometer
Properties file, click Browse from the drop-down list and enter a new file name.

Verify that the Empty mass field contains the correct information for each file selected. If
necessary, modify the field. The Fill button is disabled unless at least one port has a pen-
etrometer selected, and until each port with a penetrometer has an Empty Mass value
greater than (not equal to) 1.0000.

In the Mercury Density group box, select either Enter density to manually enter the mercury
density in the text box or select Calculate from the measured temperature to use the tem-
perature and density entered in the table.

To modify the table parameters, click in the appropriate cell and enter the new parameter.

. Prepare and load the penetrometers as for a low pressure analysis. Click Fill and wait for

the operation to complete, then weigh the penetrometers and enter the Full Mass for each.
The Measurements Completed field will update to include the measurement just finished.
The Full Mass fields will be initialized to 1.0000. The Repeat and Accept buttons will be dis-
abled until all selected ports have a Full Mass greater than their Empty Mass. When a valid
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El micpomeritics® Load Calibration from File

Full Mass is entered, the penetrometer volume for this measurement is calculated and the
Mean Volume and standard deviation for all measurements are updated.

5. Repeat these steps as many times as needed (three times are recommended). The system
will automatically calculate the Mean Volume and report it. Click Accept when finished. The
Mean Volumes will be stored in the selected Penetrometer Properties files.

LoAD CALIBRATION FROM FILE

Use to load a previously saved calibration file.

It is recommended that the current calibration settings be saved using prior to loading another
calibration file. When loading a previously saved calibration file, a backup of the current file is
created and saved as [SN]last.cal. The backup file is overwritten each time a new one is created.

/ Changing the calibration may affect the analyzer’s performance.

SAVE CALIBRATION TO FILE

Use to save the current calibration settings to a backup file which can later be reloaded using the
menu option.

The default file naming convention for calibration files can be used or the file name can be
changed. The default file name of 0217-2013-04-25.CAL is interpreted as:

0217 Analyzer serial number

2013-04-25 Date the calibration file was saved

.CAL File name extension
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Iml micromeritics® 10 Hardware Components and Accessory Installation

10 HARDWARE COMPONENTS AND ACCESSORY
INSTALLATION

SYSTEM COMPONENTS

Low PRESSURE SYSTEM COMPONENTS

Back view
®

Low Pressure System Valve Locations

Valve

Description

Servo isolation
valve [1]

Ensures no leaking occurs through the servo. It is open when the servo is in
use and closed when the servo is off.

Fast evacuation

Used at the end of the evacuation routine to achieve the best vacuum.

valve [2] When this valve is open, the sample stations are directly connected to the
vacuum system.
AutoPore V Series Operator Manual 10-1
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10 Hardware Components and Accessory Installation Iml micromeritics®

Low Pressure System Valve Locations (continued)

Valve

Description

Vacuum valve [3]

The vacuum valve is opened to evacuate the back of the servo valve during
the ramping part of the evacuation sequence. This allows the servo valve to
control the evacuation rate.

When the pressure is low enough, the evacuation through the reservoir
proceeds. This is accomplished by alternately opening valve 8 (to allow gas
from the sample to move to the reservoir) and valve 3 (to evacuate the
reservoir for the next step).

Gas inlet valve [4]

Allows pressurization at the back of the servo valve. The servo can then be
used to dose pressures from 0.2 psia to 50 psia onto the low pressure
stations. Dry nitrogen or argon is the preferred gas. Do not use air unless it
is dried to remove water vapor.

Mercury fill valve

[5]

Mercury flows into the degasser then into the low pressure stations and is
controlled by the fill valve. The drain valve allows mercury to flow back into
the reservoir.

Drain valves [6]

See Mercury fill valve [5].

Mercury reservoir
evacuation valve

[7]

Connects the vacuum line to the mercury reservoir.

Evacuation reser-
voir valve [8]

See Vacuum valve [3].

Vent valve [9]

If a cap detector is removed when the pressure is above atmospheric
pressure, the low pressure system will be vented to atmosphere with this
valve.

10-2
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Iml micromeritics® Low Pressure System Components

Low Pressure System Valves

Component

Description

Low pressure
ports

A sample encased in a penetrometer is first evacuated, filled with mercury,
then pressurized to between 15 and 50 psia.

Mercury

Vacuum

Soft gum rubber

Front panel
Penetrometer

Contact

Metal cladding

Thrust

Rubber tube
Penetrometer stems inserted into a station are sealed for vacuum and
against mercury leakage by compression of a soft, gum rubber cylinder
near the tip. The rubber is compressed by turning the large knob or
pressure collar that protrudes from the front. The inner rim of this knob
serves also as the mounting mechanism for a capacitance transducer after
the knob has been tightened.

— T OMTMOO >

Mercury storage
reservoir

Holds 7 to 10 pounds of mercury and is located behind the front panel. The
level of mercury is visible through a small window in the front panel. Before
beginning a low pressure analysis, the application verifies that the level of
mercury in the reservoir is adequate.
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10 Hardware Components and Accessory Installation Iml micromeritics®

HIGH PRESSURE SYSTEM COMPONENTS

S

Front View

Hydraulic pump
Transducer

High pressure chambers
Mercury storage reservoir
Diagnostic panel
Pressure intensifier
Vacuum pump

@mmoOOoOw>»

High Pressure System Components

Component Description

High pressure chamber | The two high pressure chambers are closed by the chamber plug
assemblies. These are sealed into the chambers with large threads
and tightened by turning two short handles. The closure components
are counter-sprung so that they are readily raised and lowered. On
top of each closure is a manual valve for venting or purging air that
may be trapped when a high pressure chamber is closed.
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Iml micromeritics® High Pressure System Components

High Pressure System Components (continued)

Component Description

e

psia
N
Hydraulic pump The basic high pressure generating unit is a hydraulic pump. The

pump has a hydraulic fluid reservoir and a pressure gauge. The relief
valve limits the maximum pressure to 2800 psia. The pump and drive
motor rotation are reversible to allow the pressure adjustment.

Pump speed and direction are controlled by the application which
prevents overshooting of the target pressure while minimizing time
required to attain a target pressure.

Pressure intensifier The required psia is generated by a double- action, dual piston
intensifier connected to the hydraulic pump. Two limit switches are
located near the upper and lower limits of piston travel. The first of
these switches alerts the operating program; the second interrupts
the power to the motor.

Transducer High pressure measurements are made with one pressure trans-
ducer. The signal from this transducer is processed by electronic cir-
cuitry to yield two pressure output signals.
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10 Hardware Components and Accessory Installation Iml micromeritics®

INSTALL A PENETROMETER IN A HIGH PRESSURE CHAMBER

Before opening the high pressure chamber, check the status display to ensure the sys-
tem is not pressurized.

A. Penetrometer
B. Ventvalve
C. High pressure plug

1. Turn the vent valve slowly counter-clockwise to release excess pressure.

2. Unscrew the chamber plug assembly by turning the arms counter-clockwise. Lift the cham-
ber plug assembly as far as it will go. The chamber assembly contains a latching device
which automatically locks into place when the assembly is in the topmost position.

3. Gently lower the penetrometer assembly, bulb down, into the chamber until it rests firmly on
the banana plug.

4. Verify that the oil in the high pressure chamber just covers the ledge inside the chamber.
Add more oil, if needed.
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EI micr‘omeritics® Install a Penetrometer in a High Pressure Chamber

5. Pull the latch release down to unlock the chamber plug assembly. Gently lower the
assembly while ensuring that the penetrometer is inserted into the assembly hole. After
making sure the penetrometer goes into the hole, lower the assembly the rest of the way

and screw the chamber plug in.

Latch release

6. After the chamber plug is screwed, check the fluid level in the plastic cup above the vent
valve. to ensure all the air bubbles are out of the chamber, and sealing the vent valve.
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10 Hardware Components and Accessory Installation Iml micromeritics®

INSTALL A PENETROMETER IN A LOW PRESSURE PORT

If fewer than four samples are to be analyzed, a steel rod with a receptacle for the cap detector
must be installed in each unused low pressure port. The cap detector must see that a rod is
installed.

/ If a penetrometer or blank rod is not installed in each port, vacuum conditions cannot
be achieved and an analysis cannot be performed.

1. Remove the capacitance detector from the low pressure port by turning it counter-clockwise
and pulling forward. Place it on top of the analyzer or stand it on the surface next to the high
pressure chamber.

Capacitance detector
Retaining knob
Mercury spill tray
Plastic cap

Cow>»

2. Turn the plastic cap counter-clockwise to remove.
3. Turn the retaining knob counter-clockwise until it turns with little resistance.

Do not remove the knob; internal components may become misaligned.
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4. Ifthe low pressure port contains a blank rod, remove it. If it contains a penetrometer,
remove the penetrometer from the low pressure port.

5. Ifusing a 3 cc penetrometer, install the spacer over the penetrometer stem. Insert the pen-
etrometer stem into the port and push it in as far as it will go. The spacer is required for the 3
cc penetrometer only.

A. Spacer is required
only for the 3 cc pen-
etrometer

B. Retaining knob

6. Tighten the retaining knob by turning it clockwise until the penetrometer is firmly seated. Do
not tighten with excessive force.

7. Place the plastic cover over the penetrometer assembly and turn clockwise to tighten.

8. Install the capacitance detector over the penetrometer and turn clockwise to tighten.
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REMOVE A PENETROMETER FROM A HIGH PRESSURE CHAMBER

/ When analysis is finished, ensure the high pressure system indicator PRESSURIZED
is not lit.

1. Loosen the vent valve counter-clockwise approximately 1/8 turn to make the plug removal
easier.

A. Penetrometer
B. Ventvalve
C. High pressure plug

2. Unscrew the chamber plug by turning the arms counter-clockwise. Lift the plug assembly as
far as it will go. Fluid begins to drain from the vent valve. Pause a few seconds to allow fluid

to drain back into the chamber.
3. Remove the penetrometer assembly. Hold it over the chamber for a few moments to allow

the high pressure fluid to drain.
4. Clean the penetrometer.
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REMOVE A PENETROMETER FROM A LOw PRESSURE PORT

1. Ensure the low pressure ports have returned to near atmospheric pressure and the Hg
Drained indicator on the front analyzer panel is illuminated.

Removing penetrometers when the Hg Drained indicator is not illuminated may allow
mercury to spill from the port.

2. Hold the retaining knob to prevent rotation, then turn the capacitance detector counter-clock-
wise to loosen and remove it.

Capacitance detector
Retaining knob
Mercury spill tray
Plastic cap

oo >

3. Turn the plastic cap counter-clockwise and remove.

4. Turn the retaining knob counter-clockwise, then carefully withdraw the penetrometer
assembly. Do not pull on the penetrometer cap.

/ As the penetrometer is withdrawn, tilt the bulb end down and the stem end up, so
mercury does not spill from the open stem end.
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5. Remove the penetrometer spacer if used.

If the assembly is not to be placed immediately in the high pressure chamber, store it
with the stem upward so that none of the mercury will be spilled. The rack for full
penetrometers [part number 962-25827-00] can be used for this purpose.

6. Weigh the penetrometer assembly (remove the spacer first) if density calculations are to be
made or blank correction by formula is used. Record this mass on the Sample Data Work-
sheet.

Do not wait an extended period of time before performing the high pressure run.
Mercury remaining in contact with the sample for long periods of time after the low
pressure analysis may oxidize and reduce the reproducibility of results.
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Iml micromeritics® 11 Maintenance and Troubleshooting

11 MAINTENANCE AND TROUBLESHOOTING

The analyzer has been designed to provide efficient and continuous service; however, certain
maintenance procedures should be followed to obtain the best results over the longest period of
time. When unexpected results occur, some common operational problems not indicated on the
window and their respective causes and solutions are provided.

The following can be found on the Micromeritics web page (www.Micromeritics.com).

® Error Messages document (PDF)
® Parts and Accessories
= VVacuum Pump Guide (PDF)

Improper handling, disposing of, or transporting potentially hazardous materials can
cause serious bodily harm or damage to the instrument. Always refer to the MSDS
when handling hazardous materials. Safe operation and handling of the instrument,
supplies, and accessories is the responsibility of the operator.

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

When lifting or relocating the instrument, use proper lifting and transporting devices
for heavy instruments. Ensure that sufficient personnel are available to assistin
moving the instrument. The AutoPore V 9600 weighs approximately 227 - 250 kg
(500 - 550 Ib) depending on configuration.

Use of a power cord or power supply not provided with the instrument could cause
personal injury or damage to the equipment. If a replacement is needed, contact your
Micromeritics Service Representative. Detachable power supply cords with an
inadequate rating could cause significant instrument damage or physical harm.

dlallall e

Do not add anything between the power cord and the power source that would
compromise the earth ground.

Do not remove or disable the grounding prong on the instrument power cord.

If the equipment needs to be relocated, check with your Micromeritics service
representative. The equipment must be positioned such that the mains supply is not
obstructed and is easily accessible to disconnect the equipment from the AC main
power supply.
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11 Maintenance and Troubleshooting

[M] micromeritics®

A\

Prior to moving the instrument, disconnect and remove all glassware from the
instrument. Ensure all gas shut-off valves on the gas cylinder have been closed and
gas lines disconnected from the instrument. Contact your Micromeritics Service

Representative.

Status display is too large for computer monitor.

Cause:

Action:

Monitor resolution is set below 800 x 600.

Refer to the computer operating system manual to reset the monitor res-
olution at or above 800 x 600.

Difficulty attaining adequate vacuum conditions during low pressure analyses.

Cause A:
Action A:
Cause B:
Action B:

Cause C:
Action C:

Cause D:
Action D:

Cause E:

Action E:

Vacuum pump oil is low.
Add vacuum pump oil.
Vacuum hose not properly connected.

Ensure the connection to the vacuum pump is good and that external clamps
are tight.

Sample contains excess moisture adsorbed from atmosphere.

Prepare samples (prior to loading penetrometer) by heat and/or vacuum to
remove moisture.

Never heat a sample that has contacted mercury.

Proper sealing not achieved on penetrometers

1. Use blank rods to test the ports to eliminate the possibility of having a leak-
ing penetrometer cap / bulb seal.

2. Lightly grease the rods with a high grade vacuum grease, then insert the
rods in the low pressure ports.

3. Tighten the retaining knobs on the low pressure ports. If vacuum con-
ditions are satisfactory, check the penetrometer for scratches or chips in
the bulb.

Scratches or other imperfections in either the lip of the penetrometer bulb or
the penetrometer cap.

1. Polish the lip of the bulb and the cap using 600 grit emery paper or crocus
cloth.

2. Place the paper or cloth on a flat surface, grit-side up.

11-2
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Iml micromeritics® 11 Maintenance and Troubleshooting

3. Clean all grease from the surface to be polished with solvent.

4. Lightly press the surface down on the grit and rub in a circular motion. A
minute of this polishing action is usually sufficient, but it must be continued
until the surface is free from flaws. Examination of the surface under low
magnification (approximately 20X) helps determine when the surface is
free from flaws.

5. Clean the ground surface before regreasing.
Cause F: Leaking valves.

Action F: Check the valves for leaks. See Check Valves for Leaks on page 11 - 28.

Cause G: Moisture has accumulated in the system.

Action G: Remove the accumulated moisture. See Remove Moisture from the Ana-
lyzer on page 11 - 31.

The low pressure analysis is complete and the system has returned to near atmosphere,
but the mercury drained indicator is not illuminated.

Cause A: Indicator is not working properly.

Action A:  Verify the state of the mercury degasser by looking at the status display win-
dow. If the status display does not agree with the indicator, the indicator may
not be working properly. Contact your Micromeritics Service Representative.

If the status display window shows that the mercury has overfilled (the alarm
state), see Handling Mercury Overfill on page 11 - 23. If the status display
shows that the mercury degasser is either filled or partially filled, see Drain
the Low Pressure System on page 11 - 8.

Cause B: Mercury is not drained. Status display shows either filled or partially filled.

Action B: See Drain the Low Pressure System on page 11 - 8.

Mercury warning buzzer sounds in pulses. (Mercury overfill).

Cause: Mercury detected by overflow sensor in low pressure port system.

Action: See Handling Mercury Overfill on page 11 - 23.

Mercury warning buzzer sounds with continuous tone.

Cause: Mercury has been improperly drawn into the mercury trap.

Action: Drain excess mercury into the reservoir. See Handling Mercury Overfill on
page 11 - 23. Remove the plug extending down from the mercury trap. The
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11 Maintenance and Troubleshooting Iml micromeritics®

plug is reached through the front door. Facing the analyzer, the plug is in the
upper back right corner. See Dish for Spilled Mercury on page 11 - 18.
Position a container beneath the trap before removing the plug.

The high pressure system failed to attain the specified pressure.

Cause: Low fluid level in the hydraulic pump.

Action: Add fluid to the hydraulic pump. See Maintain Hydraulic Pump Fluid Level
on page 11 - 26.

High pressure system failed to retain a reasonably constant pressure.

Cause: Leakage around the high pressure chamber cap.

Action: Replace the cup seals and backup rings on the high pressure chamber cap.
See Replace Chamber Cup Seals on page 11 - 24.

Cannot attain low pressure data points above atmospheric pressure.

Cause: Gas supply pressure too low.

Action: Verify gas supply regulator is set to 40 to 45 psig (276 to 310 kPa) and that
there is sufficient gas in the supply cylinder.

AutoPore V Series Operator Manual
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SAFE SERVICING

Do not modify this instrument without the authorization of Micromeritics Service Per-
sonnel.

To ensure safe servicing and continued safety of the instrument after servicing, service personnel
should be aware of the following risks:

Product specific risks that may affect service personnel:

® Electrical. Servicing or repair could require opening the outer panels and exposing ener-
gized electrical components.

® Fuses. Only use fuses rated as:

Power Source Required Fuses
100-120V 4.0A, Slo-Blo, AG
220-240V * 2.0A, Slo-Blo, 5x20mm

* 220V applications should use the 230V setting.

® Understand how to use the Mercury Vapor Kit installed in the front panel of the AutoPore.

Protective measures for these risks:

m Electrical. The electrical components operate at low voltage (24V or less) and pose low risk
when energized. Maintenance, troubleshooting, and repairs should be performed with the
instrument de-energized whenever possible, in accordance with standard electrical safety
guidelines.

® Fuses. Use of improperly rated fuses could cause damage to the equipment.

= Power off and unplug the analyzer from the power outlet prior to servicing.

Verification of the safe state of the instrument after repair:

® The low pressure and high pressure systems readings must be at atmospheric pressure.

® The steel rods must be inserted inside each low pressure port with the cap detectors in
place.

= The high pressure chambers must be opened.
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11 Maintenance and Troubleshooting Iml micromeritics®

CHANGE THE FUSES

Fuse the input power line according to local safety practices. The input power connector can be
used with either a single-fuse arrangement or a double-fuse arrangement.

Fuse

Jumper bar

use Qﬂ@ .@ﬁ,@l e
Elock Qﬁ%/’/)%

Fuse

Retaining

screw
P
Cover

The power cord should be disconnected from the analyzer before removing the cover
from the power input connector. Failure to disconnect the power cord could result in

electrical shock.

m |f the single-fuse arrangement is needed, position the fuse block so that the side with the
single-fuse slot and the jumper bar is away from the cover.

® |fthe double-fuse arrangement is needed, position the fuse block so that the side with the
double-fuse slots is away from the cover.

1. Reposition the fuse block, if necessary:
a. Remove the fuse block retaining screw.
b. Lift the fuse block from the cover.
c. Rotate the fuse block.
d. Mount the fuse block to the cover.
e. Replace the retaining screw.

2. Insert appropriate fuse for the input power source. Refer to the chart below for the appro-
priate fuse rating.

The fuse used in the analyzer must be identical in type and rating to that specified.
Use of other fuses could result in electrical shock and/or damage to the unit.

Power Source Required Fuses
100-120V 4.0A, Slo-Blo, AG
220-240V * 2.0A, Slo-Blo, 5x20mm

* 220V applications should use the 230V setting.
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3. Insert fuse block and cover assembly into input power connector and snap it into place.
After the fuse block and cover assembly are in place, the position of the indicator pin shows
the input power selected.

POWER
NECT SES

N
DISCOT CPIACING FU

BEFORE R

4. Connectthe power cord to the analyzer and plug into an appropriate power source.
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DRAIN THE LOW PRESSURE SYSTEM

Unit [n] > Generate Low Pressure

 Low Pressure Generation EI@  Low Pressure Generation EI@
Target Pressure 14,70  psia Generating 14,70 psia
Current pressure 14,70 psia
Current vacuum 780,137 pmHg
Generating 14.70 psia Generating 14.70 psia

1.

o koo

Specify a pressure of 10 psia. After the system reaches 10 psia and returns to /dle status,
open the reservoir evacuation valve (#7) for 20 seconds.

The Hg reservoir evacuated indicator should be displayed on the analyzer schematic. If itis
not shown, do not proceed to the next step. Instead, verify that the mercury reservoir fill cap
is properly sealed on top of the mercury filling funnel. If the Hg reservoir evacuated indicator
still is not displayed, contact a Micromeritics Service Representative.

Open the mercury drain valve until the mercury drains.
Close the mercury drain valve.
Close the mercury reservoir evacuation valve.
To return the system to atmosphere, go to Unit [n] > Generate Low Pressure and enter a

pressure of 15 psia.

/

If the system still indicates that the mercury is not drained (the status display, the mer-
cury drained indicator or both), see Handling Mercury Overfill on page 11 - 23.

11-8
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EI micromeritics® Dish for Spilled Mercury

DISH FOR SPILLED MERCURY

Hg ONLY
NO Ol

A. Mercury fill
B. Mercury spill drain

A dish for collecting mercury is located just behind the high pressure chambers. Pour
approximately 1.0 to 2.0 cc of oil into the dish to prevent the mercury from vaporizing.

If mercury accumulates in the dish, remove it by removing the cover and extracting the mercury
with the syringe accessory.

/ Approximately 1/8 in.(3 mm) of oil should remain in the container to prevent the
escape of mercury vapors.

AutoPore V Series Operator Manual

962-42800-01 (Rev E)— Oct 2022 -9



11 Maintenance and Troubleshooting Iml micromeritics®

ENABLE MANUAL CONTROL

Unit [n] > Enable Manual Control

Use to enable the manual control of certain system valves and pump components on the analyzer
schematic. When this option is enabled, a checkmark appears to the left of Unit [n] > Enable
Manual Control. If the analyzer schematic is not immediately visible, go to Unit [n] > Show
Instrument Schematic.

Low Pressure

=9 File  Unit \_Reports\, Options

Window Help

A. Hgreservoir indicator
B. Mercury reservoir

C. Mercury degasser
D
E

. Mercury temperature sensor
. Mercury trap

High Pressure

\ G F. Intensifier
G. Hydraulic pump

Schematic Components

Schematic Description
Components
Pressure = Displays the current pressure in the system.

® The pressure is shown in the units selected in Options > Units.
® The reading shown is from either the vacuum gauge or the 50 psia trans-
ducer, depending upon which is currently in range.

Status Provides the sample file name and sequence number, the intrusion volume,
and the percent of the penetrometer stem already used.
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Analyzer Schematic Icons

Icon or Symbol |Description

’ Open Valve. Green indicates an open valve.
e Closed Valve. Yellow indicates a closed valve. When manual control is
disabled, closed valves appear white.
_.. Servo Valve. Closed.
Servo Valve. Open.
- P

Low Pressure Schematic Icons

Mercury Degasser. Displays the mercury level.

Drained Partially Filled Filled Overfilled. This alarm
displays

with a red background.

This is an alarm state.

Mercury Trap. Displays the state of the mercury trap.

Empty Contains more than 6 mm of mercury.
This is an alarm state.

Mercury Reservoir. Displays the level of mercury in the reservoir.

e -

If the mercury level is low, see Maintain Mer- Level is OK.
cury Level on page 11 - 16.

Hg Reservoir Vacuum Switch

E . When illuminated, indicates that mercury reser-
Evacuated voir has been evacuated.
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Low Pressure Schematic Icons (continued)

Low Pressure Ports _ )
Indicates that the mercury fill sensor detects mercury.

Indicates a rod and capacitance detector are present (detector
reading is less than -5 pF).

Indicates there is no mercury, but the capacitance detector is on
with either a rod or a penetrometer.

Indicates there is no capacitance detector and penetrometer or
rod in place.

O ©® @ @&

11-12 AutoPore V Series Operator Manual
962-42800-01 (Rev E) — Oct 2022




EI micromeritics® Enable Manual Control

High Pressure Schematic Icons

Hydraulic Pump

When the pump is operating, the target pressure
displays below the icon. A green icon indicates
the pump is ON. A yellow icon indicates the pump
m is OFF. To set the target pressure when the icon
is yellow, either double-click the pump icon or
right click the icon and select Set.

Intensifier. Displays the state of the intensifier limit switches.

Midway Top Bottom
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[M] micromeritics®

Low Pressure System Valve Locations

Valve

Description

Servo isolation
valve [1]

Ensures no leaking occurs through the servo. It is open when the servo is in
use and closed when the servo is off.

Fast evacuation
valve [2]

Used at the end of the evacuation routine to achieve the best vacuum.
When this valve is open, the sample stations are directly connected to the
vacuum system.

Vacuum valve [3]

The vacuum valve is opened to evacuate the back of the servo valve during
the ramping part of the evacuation sequence. This allows the servo valve to
control the evacuation rate.

When the pressure is low enough, the evacuation through the reservoir
proceeds. This is accomplished by alternately opening valve 8 (to allow gas
from the sample to move to the reservoir) and valve 3 (to evacuate the
reservoir for the next step).

Gas inlet valve [4]

Allows pressurization at the back of the servo valve. The servo can then be
used to dose pressures from 0.2 psia to 50 psia onto the low pressure
stations. Dry nitrogen or argon is the preferred gas. Do not use air unless it
is dried to remove water vapor.

Mercury fill valve

[5]

Mercury flows into the degasser then into the low pressure stations and is
controlled by the fill valve. The drain valve allows mercury to flow back into
the reservoir.

Drain valves [6]

See Mercury fill valve [5].

Mercury reservoir
evacuation valve

[7]

Connects the vacuum line to the mercury reservoir.

Evacuation reser-
voir valve [8]

See Vacuum valve [3].

Vent valve [9]

If a cap detector is removed when the pressure is above atmospheric
pressure, the low pressure system will be vented to atmosphere with this
valve.

11-14
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Preventive Maintenance

PREVENTIVE MAINTENANCE

Perform the following preventive maintenance procedures to keep the analyzer operating at peak
performance. Micromeritics also recommends that preventive maintenance procedures and
calibration be performed by a Micromeritics Service Representative every 12 months.

Maintenance Required

Frequency

Banana plug

Check every 600 samples or 3 months. Replace as
needed.

Chamber plug seals

Replace every 600 samples or 3 months.

High pressure chambers

Check and clean every 600 samples or 3 months.

High pressure fluid

Check every 600 samples or 3 months.

High pressure fluid level

Check prior to performing a high pressure analysis. Fill as
needed.

Hydraulic pump fluid

Check every 6 months. Fill as needed. Change annually.

Low pressure ports

Grease every 600 samples or 3 months.

Mercury dish

Check daily for spills. Service as needed.

Mercury level

Service daily.

Mercury vapor filter

Replace annually.

Moisture in system

Remove as needed.

Vacuum pump exhaust filter

Replace every 600 samples or 3 months.

Vacuum pump fluid

Change every 1200 samples or 3 months.

Vacuum pump fluid level

Check monthly. Fill as needed. Refer to the vacuum pump
user manual for instructions.

Valves

Check for leaks and clean as needed.
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MAINTAIN MERCURY LEVEL

Each analysis may extract from 3 to 15 mL of mercury from the reservoir depending on the
penetrometer and sample size used. When running a low pressure analysis, a pop-up message
displays on the Low Pressure Analysis window when the level of mercury drops below the
minimum level. The mercury level should be within 0.5 to 1.0 in. (1 to 3 cm) below the top of the
mercury viewing window. It must never reach above the viewing window. To avoid delays, check
the mercury level, adding mercury when necessary, at the beginning of each day.

/ Ensure the use of triple distilled mercury that is at least 99.999% pure.

A. Mercury level viewing window
B. Reservoir cap
C. Funnelfor filling mercury
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The analyzer requires approximately 5 Ibs of mercury (minimum) to begin analyses. Do not use
more than 10 Ibs.

A spilled-mercury container, located in the center of the analyzer work surface behind the high
pressure chambers, is provided so that any accidentally spilled mercury can be immediately
brushed into it. Pour approximately 1.0 to 2.0 cc of oil into the container to prevent the mercury
from vaporizing.

1. Remove the mercury reservoir cap.

2. Slowly pour the mercury into the reservoir to within 0.5 to 1.0 in. (1 to 3 cm) from the top of
the viewing window.

3. Replace the reservoir cap.

Overfilling may interfere with the vacuum system. Reservoir cap should be finger tight
only.

Ensure that the mercury filling funnel is tightly secured. If it is necessary to tighten the
funnel, use an appropriate tool. If the funnel is not tightened, there could be a gas leak
and the vacuum will not pull properly.
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DISH FOR SPILLED MERCURY

Hg ONLY
NO Ol

A. Mercury fill
B. Mercury spill drain

A dish for collecting mercury is located just behind the high pressure chambers. Pour
approximately 1.0 to 2.0 cc of oil into the dish to prevent the mercury from vaporizing.

If mercury accumulates in the dish, remove it by removing the cover and extracting the mercury
with the syringe accessory.

/ Approximately 1/8 in.(3 mm) of oil should remain in the container to prevent the
escape of mercury vapors.
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MAINTAIN HIGH PRESSURE FLUID LEVEL

The high pressure fluid level in the high pressure chamber should be checked when preparing for
a high pressure analysis. The fluid level should be up to the ledge when a penetrometer is
installed. Add high pressure fluid as needed.

N\~
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SEAL THE HIGH PRESSURE CHAMBER

/ High pressure fluid leaking past the chamber seal indicates one of three problems:

® Too much fluid. Remove fluid, clean the seal and try again.
® Damaged seal. Replace the seal, then try again.
® Fluid in the threads. Clean and reseal.

The chamber plug seals the high pressure chamber. Proper sealing does not require the use of
excessive force. The outside diameter of the elastic seal on the plug is slightly larger than the
inner diameter of the pressure chamber. Lowering the chamber plug into the pressure chamber
presses the seal against the chamber wall, sealing the chamber. Then, as pressure increases
during an analysis, the outer lip of the seal is forced more tightly against the chamber wall,
preventing leakage.

Ledge for oil level
Removable cap
Transparent cap

Vent valve

Chamber plug

Seal

High pressure chamber

@mmOO w>»

1. Push the plug into the chamber until it contacts the chamber shoulder. Several threads of
the plug will remain exposed.

2. Ensure the vent valve is partially open (unscrewed). Slowly turn the plug clockwise into the
chamber to force air from the chamber. Continue turning until high pressure fluid (or air
bubbles and fluid) appears in the transparent cup on top of the vent valve.

/ Tightening the plug too quickly may cause unwanted intrusion caused by pressure cre-
ated when the chamber is closed.
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Iml micromeritics® Seal the High Pressure Chamber

3. The cup should not be completely full. If the cup is too full, slowly open the chamber and
recheck the fluid level. Fluid may need to be removed. Repeat the previous steps to release
trapped air.

® | arge air bubbles may be caught in the chamber. Slowly loosen and tighten the plug
approximately 1/2 turn several times. This should cause any air bubbles to rise through
the transparent cup to the surface. Any remaining tiny bubbles will not affect the ana-
lysis.

= |f nofluid is visible in the cup when the plug is fully tightened, open the chamber and
recheck the fluid level. It is likely that fluid may need to be added. Repeat the previous
steps to release trapped air.

of the vent valve without opening the chamber. To do so, remove the cap and use

/ Small amounts of high pressure fluid can be added to or removed from the cup on top
appropriate tools, such as a syringe.
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GREASE Low PRESSURE PORTS

The screw threads visible behind each low pressure port retaining knob should be greased
monthly.

1. Remove the capacitance detectors by turning counter-clockwise.
2. Remove the plastic caps.
3. Unscrew the retaining knobs until the threads disengage.

Turn retaining knob counter-clockwise to expose
threads behind knob

4. Lubricate the retaining knob threads and mating surfaces with a medium consistency
grease such as white lithium grease.

5. Screw the retaining knobs back into the low pressure ports.

6. Replace the plastic caps and capacitance detectors.
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HANDLING MERCURY OVERFILL

1.

On the Manual Control window, open the reservoir evacuation valve. Evacuate for twenty
seconds

The Hg reservoir evacuated indicator should be displayed on the analyzer schematic. If it is
not shown, do not proceed to the next step. Instead, verify that the mercury reservoir fill cap
is properly sealed on top of the mercury filling funnel. If the Hg reservoir evacuated indicator
still is not displayed, contact a Micromeritics Service Representative.

Open the gas inlet valve. Close the gas inlet valve when at least 15 psia or atmosphere is
attained.

Open the mercury drain valve.

Open the front panel of the analyzer and locate the Override switch on the small control
panel.

Press the switch. This allows mercury to drain back into the reservoir.

Release the switch as soon as the pulsed buzzing stops. Close the mercury drain valve.
Close the reservoir evacuation valve. If the pulsing tone remains, call the Micromeritics Ser-
vice Department. The analyzer may be powered off.
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REPLACE CHAMBER CUP SEALS

The chamber plug is sealed into the high pressure chamber by means of a cup seal and a backup
ring. There is also an O-ring in the vent valve. These rings should be checked monthly and
replaced when the backup ring extrudes, small slivers come from the cup seal or backup ring, or
pinched areas appear on the cup seal. The rings may also need replacing when oil appears
around the top of the chamber or when it is difficult to maintain pressure in the high pressure
chamber

1. Remove the chamber cup seal and backup ring without scratching the surrounding sur-
faces.

A. Backupring
B. Chamber cup seal

2. Replace the backup ring on the lower portion of the chamber plug with the backup ring
uppermost and with the groove of the cup seal downward.

3. Replace the O-ring in the vent valve.
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REPLACE THE VENT VALVE O-RING

A. Ventvalve
B. Ventvalve O-ring

1. Remove the vent valve from the top of the high pressure chamber by turning the vent valve
counter-clockwise.
2. Gently remove the O-ring on the vent valve and replace with a new one.

CHANGE HIGH PRESSURE FLUID AND CLEAN HIGH PRESSURE
CHAMBER

The high pressure fluid should be changed after every 600 samples or 3 months to ensure
accurate results. It should also be changed if mercury is spilled into a high pressure chamber.
Small drops of mercury in the bottom of the chamber can cause erroneous results.

1. Remove the high pressure fluid from the high pressure chambers using the syringe
provided.
2. Clean the high pressure chambers using a clean, lint-free cloth dampened with IPA.

3. When the chambers are completely dry, add new high pressure fluid.
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MAINTAIN HYDRAULIC PumP FLUID LEVEL

/ When changing the hydraulic pump fluid, use only Mobil-1 50W-50 Synthetic Motor
Oil [Micromeritics part number 004-16011-00].

The hydraulic pump fluid container is located in the lower left corner inside the analyzer's front
door.

Check the fluid level when the intensifier on the schematic is in the down position. Add fluid as
necessary to keep the fluid level near the top of the container.

E=8 Hol >
l%File Unitl Reports Options Window Help —|[=] %
25.2 "Cl
.
4 e 3 %——%
Intensifier in the
DOWN position
Intrusion Intrusion
Port Sample Vol. (ml) % Stem Port Sample Vol. (ml) % Stem
i 0.000 1 0.000
2 0.000 2 0.000
3 0.000 Status:  Idle Pressure: 0.000 MPa
0.000
Status: _ Idle Pressure: 0.0000 MPa T
Tdle ‘
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Hydraulic fluid container

Filling the fluid container when the intensifier is in the up position can cause the fluid to
overflow the when intensifier is lowered.

To add fluid to the container, remove the cap to the fluid container and add fluid as necessary.
Replace the cap when done.
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CHECK VALVES FOR LEAKS

Valve leakage due to sample particles or oxidized mercury deposits on valve seats can cause
difficulty in attaining adequate vacuum conditions. To test for leakage:

1. Openvalves 1, 2, 3, and 8.

2. Ifthe pressure does not reach 100 ym in less than five minutes, the system has a leak. If
this occurs, clean the valves.
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CLEAN VALVES

and fill valves with the low pressure manifold at atmospheric pressure. Failure to do
so could result in a mercury spill.

Power off the analyzer before removing the rear panel. Failure to do so could resultin
personal injury.

1. Disconnect the power cord.
2. Remove the upper rear panel by removing the retaining screws.

@ Ensure all mercury is below drain valves. Evacuate the reservoir and open the drain

3. Remove the 11/16 in. nut retaining the valve actuating coil from the mercury fill [5] and drain
[6] valves. Pull the coils off.
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Low Pressure System Valve Locations

Valve

Description

Servo isolation
valve [1]

Ensures no leaking occurs through the servo. It is open when the servo is in
use and closed when the servo is off.

Fast evacuation
valve [2]

Used at the end of the evacuation routine to achieve the best vacuum.
When this valve is open, the sample stations are directly connected to the
vacuum system.

Vacuum valve [3]

The vacuum valve is opened to evacuate the back of the servo valve during
the ramping part of the evacuation sequence. This allows the servo valve to
control the evacuation rate.

When the pressure is low enough, the evacuation through the reservoir
proceeds. This is accomplished by alternately opening valve 8 (to allow gas
from the sample to move to the reservoir) and valve 3 (to evacuate the
reservoir for the next step).

Gas inlet valve [4]

Allows pressurization at the back of the servo valve. The servo can then be
used to dose pressures from 0.2 psia to 50 psia onto the low pressure
stations. Dry nitrogen or argon is the preferred gas. Do not use air unless it
is dried to remove water vapor.

Mercury fill valve

[5]

Mercury flows into the degasser then into the low pressure stations and is
controlled by the fill valve. The drain valve allows mercury to flow back into
the reservoir.

Drain valves [6]

See Mercury fill valve [5].

Mercury reservoir
evacuation valve

[7]

Connects the vacuum line to the mercury reservoir.

Evacuation reser-
voir valve [8]

See Vacuum valve [3].

Vent valve [9]

If a cap detector is removed when the pressure is above atmospheric
pressure, the low pressure system will be vented to atmosphere with this
valve.

4. Place a container below the valves to capture any retained mercury.
5. Remove the plunger housing from each using the special spanner wrench from the access-

ory kit.

6. Clean the plunger and housing with IPA and expose the valve seat. Use a pipe cleaner to
clean the valve seat. Ensure that no lint remains on the sealing surface.

7. Re-assemble the valves.

8. The slow/ medium, medium, and fast evacuation valves, and the gas inlet solenoid valve
are much less likely to collect debris. They can be cleaned (as outlined above) if cleaning
the mercury valves did not solve the vacuum difficulty.
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CLEAN THE INSTRUMENT

The exterior casing of the instrument may be cleaned using a clean, lint-free cloth dampened with
isopropyl alcohol (IPA), a mild detergent, or a 3% hydrogen peroxide solution. Do not use any type
of abrasive cleaner. It is not necessary to remove knobs, screws, etc. while cleaning.

Do not allow liquid to penetrate the casing of the instrument. Doing so could result in
damage to the unit.

REMOVE MOISTURE FROM THE ANALYZER

A difficult-to-detect vacuum problem arises if moisture is allowed to collect in the system. A
probable accumulation point is the restricting frits that control flow rates. The best way to remove
moisture is to evacuate the analyzer at full rate for several days. If the indicated vacuum continues
to decrease slowly over this period, accumulated moisture is the probable cause of the vacuum
difficulty.

To prevent the accumulation of moisture in the future, do not evacuate samples which hold
excessive water vapor. This is best done by precleaning samples in a drying oven.
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REPLACE THE BANANA PLUG

HIGH PRESSURE CHAMBER

1. Remove the fluid from the high pressure chamber using the syringe provided.

2. Remove any mercury droplets found in the high pressure chamber. Clean the high pressure
chamber using a clean dry cloth.

3. Locate the feedthru assembly in the bottom of the high pressure chamber. Remove the
banana plug from the feedthru assembly using the banana plug tool provided.

Feedthru assembly
Banana plug

Banana plug tool

High pressure chamber

Cowz>

4. Insert a new banana plug into the banana plug tool, ensuring the flat sides of the hex fit
down into the slot.

5. Screw the banana plug into the feedthru assembly. Do not cross-thread or overtighten the
banana plug.

6. REefill the high pressure chamber with clean high pressure fluid.
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Low PRESSURE CAPACITANCE DETECTOR

1. Remove the low pressure capacitance detector from the low pressure station.

2. Remove the banana plug from the low pressure capacitance detector using the banana
plug tool provided.

3. Inserta new banana plug into the banana plug tool, making sure the flat sides of the hex fit
down into the slot.

A. Banana plug tool
B. Low pressure capacitance detector
C. Bananaplug

4. Screw the banana plug into the low pressure capacitance detector.
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PENETROMETER NUT

REMOVE THE PENETROMETER NUT

Wrench peg
Place pen-
etrometer
tool over the
nut and cap

w >

If the penetrometer nut cannot be easily opened by hand, it may have become sealed too tightly
during analysis. Use the penetrometer wrench to remove it.

TO REMOVE THE PENETROMETER NUT:

1.
2.

w

Place the penetrometer tool over the nut.

Place the wrench peg into a hole in the penetrometer nut. Use the penetrometer tool to sta-
bilize the cap while tightening the nut counter-clockwise.

Position the wrench so the peg on the wrench fits into the notch on the nut.

While holding the penetrometer tool, turn the wrench clockwise to loosen and remove the
nut.
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TO TIGHTEN THE PENETROMETER NUT

1. Apply grease to the penetrometer bulb and remove any excess grease.

2. Hold the penetrometer upright (sample bulb opening facing upward) and place a seal on the
bulb opening.

3. Turn the seal one half turn to smooth the grease and seat the seal.
Take care not to move the seal after seating onto the penetrometer bulb. The grease
may extrude too much and cause an air leak.

4. Place the penetrometer tool over the nut.

5. Place the wrench peg into a hole in the penetrometer nut. Use the penetrometer tool to
stabilize the cap while tightening the nut counter-clockwise
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POWER

The AutoPore V is designed to operate with a universal input power supply (100/120/220/240
VAC) at 50/60 Hz. Noise-free power of the correct voltage and frequency, with a safety earth
ground, should be available through a standard wall receptacle. The power outlet should be able
to supply 15 amps @ 100 or 120 VAC £10% or 7.5 amps @ 220 or 240 VAC £10%. These
requirements can be checked by using a circuit analyzer (available at most hardware or electronic
supply houses) or a multimeter. There should also be sufficient outlets for the analyzer, pump,
computer, monitor, printer, and any other peripheral devices.

/ 220V applications should use the 230V setting.

Correct power outlet wiring can be checked by using a circuit analyzer or a multimeter. The circuit
analyzer is the preferred method. These devices plug directly into the wall receptacle and give a
visual or audible indication of the status of the receptacle.

The analyzer and peripheral devices must be installed on their own dedicated power
line. Other devices — such as motors, generators, or ovens — should not be placed

on the same power line.

/ Replacement power supply cords must be rated for the specifications stated above.
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POWER INSTRUMENT ON AND OFF

DO NOT connect or disconnect cables when the instrument is powered ON.

Power ON the equipment in the following order:

The vacuum line from the low pressure system and the vacuum pump filter must be
installed before applying power to the vacuum pump. Refer to the vacuum pump

manual.

1. Analyzer
2. Computer, monitor, and printer

Power OFF the equipment in the following order:

1. Exit the analysis program. Failure to do so could result in loss of data.
2. Computer, monitor, and printer.
3. Analyzer.

RECOVER FROM A POWER FAILURE

The analyzer saves entered and collected data in case of power failure. File parameters and any
other data entered will still be present when power is restored. If an analysis was in progress when
the power failure occurred, it will be canceled when the analyzer restarts. Any data collected
during the analysis will still be present, but the analysis should be restarted in order to produce
complete results.
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VAcuum Pump

The Vacuum Pump Guide can be found on the Micromeritics web page (www.Micromeritics.com).

VAcuuM PumP EXHAUST FILTER

The exhaust filter is attached to the mercury vapor filter on the vacuum pump.

Mercury vapor filter
Exhaust filter

Wing nut clamp
Centering ring
Exhaust port

moOow>»

1. Loosen the wing nut that secures the clamp between the exhaust filter and the mercury
vapor filter by turning the nut counterclockwise. Open the clamp and remove it, the cen-
tering ring, and the exhaust filter.

2. Inspect the centering ring for wear and replace if necessary.

3. Align the centering ring between the replacement exhaust filter and the mercury vapor filter.

4. Open the clamp and place it around the lip of the exhaust filter, mercury vapor filter, and cen-

tering ring.
5. Close the clamp and secure it by turning the wing nut clockwise. Tight the wing nut finger
tight.
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VAcuumM PuMP MERCURY VAPOR FILTER

Mercury vapor filter
Wing nut clamp
Centering ring
Exhaust port

Cowz>

Mercury vapor filters are used on vacuum pumps to minimize the release of mercury
vapors.

The mercury vapor filter should be replaced annually when preventive maintenance is

P performed. When the mercury exhaust filter is replaced, go to Unit [n] > Show Dash-
board. Right-click the Days until Hg filter replacement is due box and click Reset. The
counter resets to 365 days until the next filter change is due. Service Mode and pass-
word are required to make this change.

1. Loosen the wing nut that secures the clamp between the exhaust port and the mercury
vapor filter by turning the nut counter-clockwise.
2. Open the clamp and remove it.
a. Remove the protective cover if this is an initial installation.
b. Ifthisis not an initial installation, remove and inspect the centering ring for wear and
replace if necessary.
3. Align the centering ring between the mercury vapor filter and the exhaust port.
4. Open the clamp and place it around the lip of the exhaust port, mercury vapor filter, and cen-
tering ring.
5. Close the clamp and secure it by turning the wing nut clockwise. Tighten the wing nut finger
tight.

AutoPore V Series Operator Manual

962-42800-01 (Rev E) — Oct 2022 -39



11 Maintenance and Troubleshooting Iml micromeritics®

CHANGE OR ADD VAcuumM Pump OIL

/ Drain the oil while the pump is warm and disconnected from the power source.

The pump must be removed from the analyzer to change the oil. Use oil supplied by Micromeritics
or refer to the vacuum pump manual for other acceptable oils.

1.
2.

Unplug the vacuum pump from the power source.

Remove the exhaust filter by loosening the wing nut on the clamp between the vacuum
pump exhaust filter and the mercury vapor filter. Remove the centering ring and place to the
side.

Remove the vacuum hose from the vacuum pump by loosening the wing nut on the clamp
between the vacuum pump and the vacuum hose. Remove the centering ring and place to
the side.

Remove the pump from inside the analyzer then remove the mercury vapor filter. Swing the
clamp open and remove the trap from the hose. Remove the centering ring and place to the
side.

Grasp the handle on top of the vacuum pump and place the pump on a work surface.

Place a waste container under the drain spout.

7. Remove the drain plug and drain the oil into the waste container.
8. Replace the drain plug.
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9. Remove the drain plug from the oil-fill port on top of the pump.

ﬁ =
S

10. Slowly add oil to the port until the level is midway between the indicator lines in the oil-level
window when the pump is running.

Do not allow oil to rise above the midway position when the pump is running. Doing so
may cause oil to splash into the oil filter causing contamination.

11. Check the washer or O-ring used at the oil-filling port and replace if necessary.
12. Insert the oil-fill plug and turn clockwise to tighten.
13. Return the vacuum pump to the original position inside the analyzer.

14. Reconnect the vacuum pump hose and the exhaust filter to the top of the mercury vapor fil-
ter.

15. Reconnect the power cord to the power source and power on the vacuum pump on and
recheck the oil level.

16. Allow the pump to run a few hours (overnight if possible) to eliminate air and moisture from
the fresh fluid and to produce efficient vacuum operations.
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A ADVANCED REPORTS - PYTHON MODULE

The mic Python module is automatically imported when running a user supplied script. The
module provides access to intrusion / extrusion data and provides support for summary, tabular,
and graphical reports.

= Summary reports. Consist of summary sections, each containing a two-column table of label
and value pairs. Summary reports are created with the mic.summary call.

= Tabular reports. Consist of one or more tables each containing one or more labeled columns
of data. Tabular reports are created with the mic.table call.

®m Graphical reports. Consist of a single graph with one or more curves on one or two y-axes.
Graphical reports are created with the mic.graph call.

Calls for accessing the sample file data can be found in the Mic Module Python Calls section of
this appendix. More advanced example python scripts are included in the analyzer software.

ADVANCED REPORT OPTIONS

Up to five Advanced reports, each with up to 10 summary reports, 10 tabular reports, and 10
graphical reports can be created. To use this feature, a file containing a Python script that imports
a "mic" Python module must be created. See MicModule Python Calls on page A - 13foran
example of a Python script and functions for the "mic" Python module.

1. Create the Python script and save it in the Scripts directory.

2. Open a sample file with a Complete status.

3. Select Advanced in the view selector drop-down list at the bottom of the window to return to
the tabbed view.

4. Onthe Report Options tab, select Advanced in the Selected Reports list box, then click
Edit.

5. Onthe Advanced Report Options window, click Add in the Available Scripts group box to
locate and select the Python script. Repeat for each script to be added.

[ Advanced Repart Options ST 5

Select Reports

Home

) t e

A Nome

5 Hooe

Add
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6. Inthe Selected Reports group box, click the drop-down arrows to select up to five Python
scripts previously added in the Available Scripts box.

7. Click Pressures to add pressure points to the report. Click OK to return to the Report
Options tab.

8. Select the Overlay samples checkbox to enable the overlay sample feature.

9. Onthe Report Options tab, click Preview. The Python Reports will be included on the tabs
across the top portion of the Reports window.

Advanced Reports

Selections Description

Advanced Report 1 Use the drop-down lists to select currently-defined functions used to
through 5 define the report calculations and output.

[drop-down box]

Available Scripts Lists the available reports and provides the option to add, replace,
[group box] edit, or remove reports.

Overlay samples (if Use to overlay samples as defined by the function.

shown) [check box]

/ For fields and buttons not listed in this table; see Common Fields and
Buttons on page 2 - 2.
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SCRIPTS

Run a Script

ok wbh =

7.
8.
9.

Open a sample file with a Complete file status.

Select Advanced in the view selector drop-down list at the bottom of the window.

Select the Report Options tab.

Highlight Advanced in the Selected Reports list box, then click Edit.

On the Advanced Report Options window, click Add.

Locate and select one or more python scripts then click Select. The selected scripts
become a part of the drop-down list in the Available Scripts section of the Advanced Report
Options window.

In the Select Reports section, select up to five Advanced reports in the drop-down lists.
Click OK.

Click Preview on the Report Options tab to view all reports selected in the previous window.

Remove a Script

Select the script in the Available Scripts box then click Remove. The script is removed from the
application however, the original .py text file is not affected.

Edit a Script
Selections Description
Add [button] Adds one or more scripts to the Available Scripts box. The added
scripts then become available as options in the Selected Reports
section.
Edit [button] Edits the script stored within the application but does not affect the
original .py text file.
Remove [button] Removes the script from the Available Scripts box but does not affect
original .py text file.
Replace [button] Replaces the contents of the selected script however, the script
name remains the same.

AutoPore V Series Operator Manual

962-42800-01 (Rev E) — Oct 2022




A Advanced Reports - Python Module EI micromeritics®

PYTHON REPORTS

Graphic Report

This script is an example of the mic module producing a graph with two curves:

import mic

import numpy as np

mic.graph( 'My Graph', 'X', "F(X)' )
myx = np.array( [0.1, 0.2, 0.3, 0.4, 0.5, 0.6, 0.7, 0.8, 0.9, 1.0 ] )

mic.graph.add( 'X2', myx, myx*myx, marker='o' )

N o o un A W N R

mic.graph.add( 'sin(X)"', myx, np.sin(myx), marker='"" )

The results are:

User-Defined Report : My Graph
/4%
25 ,—»// /
/
. ] __/—-0———"/—-(
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Summary Report

This script produces a summary report with two summaries:

1| import mic
2 | import numpy as np
3
4 | mic.summary( "My Summaries" )
5| mic.summary.add( "Summary A",
6 ["Label 1:", "Label 2:", "Label 3:"],
7 ["vall", "val2", "val3"] )
8 | mic.summary.add( "Summary B",
9 ["Label 4:", "Label 5:", "Label 6:"],
10 ["val4", "val5", "val6e"] )
The result is:
Summary A
Label 1: vall
Label 2: val2
Label 3. val3
Summary B
Label 4. vald
Label 5. vals
Label 6. valG
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Tabular Report

If more than one column is required, the call mic.table is employed. This script produces a tabular
report consisting of two tables.

/

This script uses the Python package numpy and c-style formatting of the numerical

values.

11| import mic

12 | import numpy as np

13

14 | mic.table( "My Tables" )

15| mic.table.addtable( "My Set A" )

16 | mic.table.addcolumn( "X", ["1.0", "2.0", "3.0"] )

17 | mic.table.addcolumn( "Y", ["©0.5", "1.0", "1.5"] )

18| x1 = 0.2

19| x2 = 0.5

20 | x3 = 3.14159/2

21 | mic.table.addtable( "My Set B" )

22 | mic.table.addcolumn( "X", ['{:8.3f}'.format(x1),

23 "{:8.3f}' . format(x2),

24 "{:8.3f}" . format(x3)] )

25| mic.table.addcolumn( "sin(X)", ['{:8.3f}'.format(np.sin(x1)),

26 "{:8.3f}".format(np.sin(x2)),

27 "{:8.3f}".format(np.sin(x3))] )

28 | mic.table.addcolumn( "cos(X)", ['{:8.3f}'.format(np.cos(x1)),

29 "{:8.3f}".format(np.cos(x2)),

30 "{:8.3f}".format(np.cos(x3))] )
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Python Reports
The result is:
My Set A
x
10 05
20 1.0
30 15
My Set B
X sinX) cos(X)
0.200 0.199 0.930
0.500 0479 0878
1571 1.000 0.000
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ACQUIRE BASIC INFORMATION

1| import mic
2
3| xdatl, ydatl = mic.intrusion('pressure', 1)
4 | xdat2, ydat2 = mic.extrusion('pressure’, 1)
5| mic.graph( 'Cumulative Intrusion vs. Pressure', 'Pressure (psi)', 'Cumulative
Intrusion (mL/g)', xlinear = False )
6 | mic.graph.add( 'Intrusion: Cycle 1', xdatl, ydatl )
7 | mic.graph.add( 'Extrusion: Cycle 1', xdat2, ydat2 )
8
9 | xdat3, ydat3 = mic.intrusion('diameter', 1)
10 | xdat4, ydat4 = mic.extrusion('diameter', 1)
11 | mic.graph( 'Cumulative Intrusion vs. Diameter', 'Diameter (Angstroms)’,
"Intrusion Volume (mL/g)', xlinear = False)
12 | mic.graph.add( 'Intrusion: Cycle 1', xdat3, ydat3 )
13 | mic.graph.add( 'Extrusion: Cycle 1', xdat4, ydat4 )
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Acquire Basic Information

The results are:

Advanced 1 :Cumulative Intrusion vs. Pressure Advanced 1:Cumulative Intrusion vs. Diameter
—+— Intrusion: Cycle 1 —=— Bxrusion: Cycle 1 —+— Inirusion: Cycle 1 —s— Extusion: Cycle 1

sl | IR

sion (mig)

I

Cumulative Intru

Intrusion Volume (mLig)

N

!

// 005
e L‘m
" 100000

X 1,000
Pressure (psi) Diameter (ngstroms)

The following script applies the generic mic module python calls mic.sample_information and
mic.report and also applies the AutoPore application specific calls mic.material _properties, and
mic.mercury_properties. Three summaries are produced:

® Sample Information
= Material Mercury Properties
B |ntrusion Summary Results

10

11

import mic

sampleinfo = [ ["Description:”, mic.sample_information("sample

description")],

["Sample mass (g):", "%8.3f" % mic.sample_information

("sample mass")],

["Assembly mass (g):", "%8.3f" % mic.sample_information

("assembly mass"),],

["Penetrometer mass (g):", "%8.3f" % mic.sample_information

("penetrometer mass")] ]

materialinfo = [ [ "Material name:",
erties("material name") ],

[ "BET surface area (m*2/g):",
ial properties("bet surface area") ],

[ "Mercury Density (g/ml):",
cury_properties("density") ],

[ "Mercury Surface Tension (dynes/cm):",
cury_properties("surface tension") ],

mic.material_prop-

"%8.3f" % mic.mater-

"%8.3f" % mic.mer-

"%8.3f" % mic.mer-
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12 [ "Advancing Contact Angle (degrees):", "%8.3f" % mic.mer-
cury_properties("advancing contact angle") 1,

13 [ "Receding Contact Angle (degrees):", "%8.3f" % mic.mer-
cury_properties("receding contact angle")] ]

14

15 | summaryinfo = [ [ "Total intrusion volume
(mL/g):", "%8.3f" % mic.report("hgsum", "total intrusion
volume") ],

16 [ "Pore area
(m~2/g):", "%8.3f" % mic.report("hgsum", "pore
area")],

17 [ "Bulk density
(g/mL):", "%8.3f" % mic.report("hgsum", "bulk
density")],

18 [ "Apparent density
(g/mL):", "%8.3f" % mic.report("hgsum", "apparent
density")],

19 [ "Median diameter by volume
(Angstroms):", "%8.3f" % mic.report("hgsum", "median diameter by
volume")],

20 [ "Median diameter by area
(Angstroms):", "%8.3f" % mic.report("hgsum", "median diameter by
area")],

21 [ "4 V/A average diameter
(Angstroms):", "%8.3f" % mic.report("hgsum", "4 V/A average dia-
meter")],

22 [ "Porosity
(%):", "%8.3f" % mic.report("hgsum",
"porosity")],

23 [
"Tortuosity:", "%8.3f" % mic.report
("hgsum", "tortuosity")],

24 [ "Tortuosity
factor:", "%8.3f" % mic.report("hgsum", "tor-
tuosity factor")],

25 [ "Permeability
(mdarcy):", "%8.3f" % mic.report("hgsum", "per-
meability")],

26 [ "Permeability
constant:", "%8.3f" % mic.report("hgsum", "per-

A-10 AutoPore V Series Operator Manual

962-42800-01 (Rev E) — Oct 2022



EI micromeritics® Acquire Basic Information

meability constant")],

27 [ "Break-through pressure
ratio:", "%8.3f" % mic.report("hgsum", "break-through
pressure ratio")],

28 [ "linear compressibility coefficient
(1/psi):", "%8.3f" % mic.report("hgsum", "linear compressibility coef-

ficient")],

29 [ "quadratic compressibility coefficient
(1/psin2):", "%8.3f" % mic.report("hgsum", "quadratic compressibility coef-
ficient") ] ]

30
31| mic.summary( "Summaries" )
32

33 | mic.summary.add( "Sample Information:",

34 [ a for a, b in sampleinfo],
35 [ b for a, b in sampleinfo] )
36

37 | mic.summary.add( "Material & Mercury Properties",

38 [ a for a, b in materialinfo],
39 [ b for a, b in materialinfo] )
40

41 | mic.summary.add( "Intrusion Summary Results",
42 [ a for a, b in summaryinfo],

43 [ b for a, b in summaryinfo] )
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The results are:

Sample Information:

Description:

Sample mass:
Aszsembly mass:
Penetrometer mass:
Penetrometer volume:
Stem volume used:

Clay
211049
140380 g
62.37% g
6.760 mL
33.477%

Matenal Properties

Material name: Garnet
BET surface area: 200.000 m3g
Entered bulk density: nan g/mbL
Entered true density: nan a/mL
Entered particle density: nan a/mL
Entered conductivity formation factor: nan
Entered threshold pressure: nan psia
Linear compressibility coefficient:  -0.000 1/p=ia
Cluadratic compressibility coefficient:  0.000 1/p=ia?
Mercury Properties
Advancing contact angle:  130.000°
Receding contact angle: 130.000°
Surface tension: 485.000 dynesicm
Density: 13533 g/mL
Linear compressibility coefficient:  -0.000 1/p=ia
Cluadratic compressibility coefficient:  0.000 1/psia?

Intrusion Summary Rezults

Total intrusion volume:

Pore area:

Bulk density:

Bulk density pressure:
Apparent density:

Apparent density pressure:
Median diameter by volume:
Median diameter by area:

4 ViA average diameter:
FPorosity:

Pressure range min:
Pressure range max:

FPore range min diameter:
FPore range max diameter:
Tortuosity:

Tortuosity factor:
Permeability:

Permeability constant:
Break-through pressure ratio:
Linear compressibility coefficient:
Cluadratic compressibility coefficient:

0.182 mbLig
12.0471 m3g
1.833 a/mL
1.5594 p=ia
2751 gmL
58853.699 psia
5595.058 A
539174
605.072 A
33.384%
0.000 psia
61000.000 psia
29.650 A
0.000 A
25407
1.8532
0.729 mdarcy
0.004
6.272
-0.000 1/psia
0.000 1/psia®
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MicMoDULE PYTHON CALLS

Tables

Available Mic Python calls for tables:

® Create a new tabular report
= Add acolumn
= Add atable

Add a Table

This script adds a table to the last created tabular report:

1| mic.table.addtable( name )
2
3 | Keyword arguments:
4
5

name --- the table name

Add a Column

This script adds a column to the last created table:

1| mic.table.addcolumn(header, values, align="r"):

2

3 | Keyword arguments:

4

5 header --- column header; must be a string (or convertible)

6 values --- column values; must be a list of strings (or convertible)

7 align --- column alignment; 'r', 'l', 'c' for right, left, and center jus-
tified
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Create a New Tabular Report

1| mic.table( title='User Table' )
2
3 | Keyword arguments:
4
5

title --- the tabular report title (default = 'User Table')
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Summary Reports

Add a Summary Section

This script adds a summary section to the last created summary report:

(or convertible) and the same length as values

values --- column of values; must be a list of strings

1| mic.summary.add(name, labels, values):

2

3 | Keyword arguments:

4

5 name --- summary section name

6 labels --- column of labels; must be a list of strings
7

8

9

(or convertible) and the same length as labels

Create a New Summary Report

mic.summary( title='User Summary' )

Keyword arguments:

vi A W N R

title --- the summary title
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Graphic Reports

Add a Curve

This script adds a curve to the last created graphical report:

1| mic.graph.add(name, x, y, yyaxis=False, color=None, linestyle='-',

2 marker="a', graphtype='both', interpolation="akima'):

3

4 | Keyword arguments:

5

6 name --- the curve name

7 X --- list of x values; must be a list of floats

8 (or convertible) and the same length as y

9 y --- list of y values; must be a list of floats

10 (or convertible) and the same length as x

11 yyaxis --- place this curve on the yy-axis if True

12 otherwise place on the y-axis (default = False)

13 color --- RGB color as an HTML hex string (e.g., '#4169el')

14 or a three-element list or tuple (e.g., [65,105,225]);
15 if None, color is automatically selected (default = None)
16 linestyle --- line style; (default = '-'")
17 - : solid
18 Host : dash
19 "o : dot
20 Hop ! : dash dot
21 "eoo : dash dot dot
22 marker --- marker shape; (default = 'a')
23 "+ : plus
24 ‘o' or '@" : circle
25 "x' : cross
26 At : up triangle
27 'v' : down triangle
28 's' : square
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29 d : diamond

30 '8’ : hourglass

31 't : horizontal hourglass
32 "' or None : no marker

33 ‘a' : automatically selected
34 graphtype --- graph type; (default = 'both")

35 ‘curve' or 'c' : curve

36 ‘points’ or 'p' : points

37 "both’ or 'b' : curve-and-points
38 "hist' or 'h' : histogram

39 interpolation -- linear or akima spline interpolation (default='akima')
40 ‘akima' use akima spline

41 ‘linear' use linear interpolation

Add a Curve Using the Second Y-Axis

This script adds a curve to the last created graphical report using the second y-axis:

mic.graph.addyy(name, xx, yy):

1
2
3| Add a curve to the last created graphical report using the second
4

y-axis. The arguments to this call are the same as to mic.graph.add.
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Create a New Graphical Report

1| mic.graph(title="User Graph', xlabel='X axis', ylabel='Y axis',
2 yylabel="YY axis’,
3 xlinear=True, ylinear=True, yylinear=True,
4 xinvert=False, yinvert=False, yyinvert=False,
5 xrange=None, yrange=None, yyrange=None, xbars_id="'"):
6
7 | Keyword arguments:
8
9 title --- the graphical report title (default = 'User Graph')
10 xlabel --- Xx-axis label (default = 'X axis')
11 ylabel --- y-axis label (default = 'Y axis')
12 yylabel --- yy-axis label (default = 'YY axis')
13 xlinear --- x-axis linear scale; if false, use log scale
14 (default = True)
15 ylinear --- y-axis linear scale; if false, use log scale
16 (default = True)
17 yylinear --- yy-axis linear scale; if false, use log scale
18 (default = True)
19 xinvert --- Invert x-axis if true (default = False)
20 yinvert --- Invert y-axis if true (default = False)
21 yyinvert --- Invert yy-axis if true (default = False)
22 xrange --- None, or two values giving the min and max
23 range of the axis.
24 yrange --- None, or two values giving the min and max
25 range of the axis.
26 yyrange --- None, or two values giving the min and max
27 range of the axis.
28 xbars_id --- None, or the id of an xbar control created
29 via the mic.control() object
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Get Intrusion-Extrusion Data

def intrusion(xaxis='pressure', cycle=1):
Get intrusion data for a specified cycle
Keyword arguments:
xaxis --- Specifies what the dependant variable will be
‘pressure’ in units of psi (default)

‘diameter’ in units of Angstrom

cycle --- Specifies the cycle number
(default = 1)

Usage:
p, v = mic.intrusion()
p, v = mic.intrusion('pressure', 2)
d, v = mic.intrusion('diameter")
--- array of pressures (psi)
--- array of diameters (Angstrom)
v --- array of intrusion volumes (ml/g)

mic.extrusion(xaxis="'pressure', cycle=1):

Get extrusion data for a specified cycle

Keyword arguments:
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Xaxis --- Specifies what the dependant variable will be
‘pressure’ in units of psi (default)

‘diameter’ in units of Angstrom

cycle --- Specifies the cycle number
(default = 1)

Usage:

p, v = mic.extrusion()

p, v = mic.extrusion('pressure', 2)

d, v = mic.extrusion('diameter")
--- array of pressures (psi)
--- array of diameters (Angstrom)

v --- array of intrusion volumes (ml/g)
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Get Mercury Properties

mercury properties(property=""', sample_number=0):

Keyword arguments:

property --- the property value to return.
If '' or None, then return all the properties
strings available for the sampe material.

Default value is None.
sample_number --- Identifier for the sample material to retrieve
0 : current sample file (default)

1 through 8 : corresponding overlay sample file

Usage:

property list mic.mercury_properties()

mercury_density = mic.mercury_properties('density")

In the above first usage case, the list of all available mercury

property keywords is returned.
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Get Properties of Sample Material

mic.material properties(property=""', sample_number=0):

Get material properties for a sample

Keyword arguments:

property --- the property value to return.
If '' or None, then return all the properties
strings available for the sampe material.

Default value is None.

sample_number --- Identifier for the sample material to retrieve
0 : current sample file (default)

1 through 8 : corresponding overlay sample file

Usage:

property_list = mic.material properties()

material_name = mic.material properties( 'material name')

In the above first usage case, the list of all available material

property keywords is returned.
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B BLANK AND SAMPLE COMPRESSION CORRECTIONS

Baseline errors in AutoPore V data are errors that occur even when no sample is placed in the
sample bulb and when a zero intrusion or extrusion volume of mercury would be expected as the
pressure is increased to its maximum pressure and then decreased again. The material which
follows relates the causes of these errors and discusses ways to minimize and compensate for
them when maximum accuracy is required.

BASELINE ERRORS

When the AutoPore applies pressure to the mercury, penetrometer, and surrounding high-
pressure oil, compression occurs.

Compressibility effects account for a substantial portion of the baseline errors. The penetrometer
bulb and capillary are made of glass which decreases in linear dimensions by about 0.8% and in
volume by 2.3% at 60,000 psia. If the mercury were incompressible, a typical penetrometer having
a 400 microliter capillary and a 5 milliliter bulb would experience a rise of mercury in the capillary
of about 124 microliters or 31% of the capillary. Fortunately, mercury compresses also, but slightly
more than glass such that the capillary actually falls some as the pressure is increased. The
compressibility amounts to about 150 microliters in this example leaving a net fall of 26 microliters
or about 6% of the capillary. The oil which surrounds the penetrometer and transmits the pressure
to the mercury compresses at more than 10 times the rate of the mercury and occupies only 3/4
the original volume at 60,000 psia. Some of the oil is in the electric field of the capacitor, especially
around the sample bulb and its connection to the exterior. The dielectric constant of the oil
increases with its density. This contributes an increasing capacitance which cancels some of the
decrease due to the net fall of mercury with compression.

Other effects caused by compression arise from the plastic insulators which are used on the
penetrometer bulb base to prevent an electrical short circuit. Not only does the plastic compress
almost as much as the oil, but it lags behind and only slowly assumes its final density. This is
especially pronounced upon release of pressure where the plastic may continue to increase in
dimensions for almost an hour. It also tends to increase the dielectric constant and capacitance
with increasing pressure. The pressure vessel expands as the internal pressure is increased and,
like the plastic, requires considerable time to stabilize. The resulting changes in spacing from the
sample bulb to the walls and bottom causes a decrease in capacitance. Micromeritics has
minimized this effect by making the initial spacings as large as is practical.
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Another effect, and the one most difficult to predict, arises from the similarity of the penetrometer
to a thermometer. This would not be troublesome if its temperature could be maintained constant,
but compression of the surrounding oil causes a temperature rise of nearly 50 °C in the oiland a
smaller change in the glass and mercury. How quickly this heat is transferred to the mercury
depends upon how rapidly the pressure is being increased, the relative amounts of oil and
mercury present, and how recently the vessel has been previously cycled and the metal and oil
warmed relative to the penetrometer. Release of the pressure causes the inverse effect, chilling
the oil and setting up a reversal of the heat flow. The thermal gradient across the glass of the
penetrometer may be considerable such that little benefit may be derived from precisely
equalizing the temperature coefficients of the mercury and glass. As might be expected this
problem is worst when the sample bulb is large and the capillary volume small. Choosing the right
penetrometer helps minimize this effect. Make sure the sample nearly matches the size of the
sample bulb and that the capillary volume is large enough to satisfy intrusion.

APPROACHES FOR ERROR COMPENSATION

Situations arise where the typical errors of about 1.0% of capillary volume are significant or where
the errors exceed this level due to unfavorable sample characteristics. Most commonly, this
happens when one of the following is encountered: 1) The amount of sample available is so
limited that the intrusion volume is only a small fraction of the smallest diameter capillary; 2)
adequate sample is available but the porosity is so low that a limited amount of the smallest
capillary is used even though the largest sample bulb is filled; 3) the sample is of small or
moderate porosity and its compressibility or thermal properties differ considerably from those of
mercury; 4) accuracy and reproducibility specifications have been imposed at levels tighter than
the typically expected levels for mercury porosimetry. In such cases “blank corrections” may be
used to advantage.

Micromeritics’ AutoPore provides four different ways to apply blank corrections. The first, and
simplest, is by use of stored formulas based upon averages of large numbers of blank runs on
mercury-filled penetrometers under varying rates of pressure build and release. No provisions are
made for entering compressibility data or thermal data since these numbers are seldom known
and the formulas would become very complex. Typical examples of blank runs are shown in
Figures 1, 3 and 7. Typical examples of formula blank correction of data are shown in Figures 2
and 6. Itis very important that trial blank runs be made when applying these formulas to ensure
that a reasonable degree of correction is actually attained under the running conditions being
used.

The second technique is apt to be much more useful. It permits the user to run a blank run, store
the results using the exact run conditions and penetrometer type to be used for the real sample,
and subtract this result from other runs. Examples of correction by subtracting a blank run file are
shown in Figures 4 and 8.
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The third technique provides the highest degree of compensation possible and can be attained
when the exact penetrometer to be used later is loaded with a nonporous sample of the same
mass and material as the porous sample to be run later. When analyzed, the non-porous sample
will expose all the aforementioned compressibility effects which can then be subtracted from the
porous sample run. This third technique has the advantage of compensating for differences in
compressibility and thermal effects between mercury and the sample material. Care should be
exercised that the interval between runs, oil temperature, and penetrometer temperature, and any
other initial conditions are made as nearly identical as possible. Figure 9 is a typical baseline run
so obtained. Figure 10 is a subsequent blank run corrected using the Figure 9 data and shows the
actual degree of correction attained.

Besides running blank runs, correction files may be created by manually entering the data. This
fourth technique allows entry of the average of several blank runs, assuring a representative
correction.

Figure 1

S T R R A blank run on a 5-mL powder penetrometer
I I | /_,/“""-} with a 1.1 mL stem volume. The rise in the initial
T i o depressurization data is primarily caused by
N 1 B T 1 11 thermal effects. As the hydraulic fluid is allowed
to expand, it cools. this in turn cools the mercury
in the penetrometer, causing it to contract and
recede in the stem, giving the appearance of
e e T e T ety e positive intrusion during depressurization.
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Figure 3

Another blank data set taken under identical
conditions to those for Figure 1. The similarity
between the two blank data sets is an indication
of the excellent repeatability of blank runs.

Figure 4

The difference between the blank data from
Figure 1 and the blank data from Figure 3. This
demonstrates that blank data collection and
subtraction is a powerful method for accurately
removing blank error from sample data.

Figure 5

Uncorrected data from analysis of a sample of
controlled pore glass made of a mixture of three
pore sizes. Note the three distinct regions of
intrusion between 0.03 and 0.01 micrometers
on the pressurization curve, and the
corresponding extrusion regions. The apparent
intrusion at sizes above 10 micrometers is due
to interparticle filling. The apparent intrusion
between 0.01 and 0.003 micrometers, and the
“loop” in the extrusion curve from 0.04 to 0.003
micrometers, are due to a combination of
sample compression and blank error. There is
no actual intrusion in this region.
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Approaches for Error Compensation
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Figure 6

The data from Figure 5 with the formula blank
correction applied. Note that the rise at the top
due to blank error has been removed, but the
apparent intrusion due to sample compression
remains. This is because the formula makes no
attempt to account for sample compression.

Figure 7

A blank run with the same type of penetrometer
under the same conditions as the sample in
Figure 5. It is dominated by the initial increase
between pressurization and depressurization,
primarily due to thermal effects.

Figure 8

The sample data from Figure 5 corrected by
subtracting the blank data from Figure 7. Note
that practically all of the blank error and
compression data have been removed, leaving
only the filling curve and the actual intrusion.
The sample compression is effectively canceled
because the compression coefficient of mercury
is close to that of the controlled pore glass used
as sample. Many solid materials have
compression coefficient fairly close to that of
mercury, making this a very effective means of
blank correction in many cases.
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Figure 9

Uncorrected data from an essentially
nonporous sample of the same type of glass
shown in Figure 5. The mass of sample used
was approximately equal to the mass of porous
sample analyzed, so that the same volume was
occupied. Note the filling curve and the blank
error “loop.” The slight incline of the
intermediate plateau and the angle of the “loop”
are due to compression of the sample.

Figure 10

The difference between the porous sample data
of Figure 5 and the nonporous sample data of
Figure 9. Some of the filling curve has been
removed, as well as all blank error and sample
compression effect, leaving an accurate picture
of the actual intrusion. This is the preferred
method of blank correction, especially for
materials with compression coefficients
substantially different from that of mercury, and
where maximum accuracy is desired.
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C CHOOSE PROPER PUMP-DOWN RATES FOR UNFAMILIAR
SAMPLE MATERIALS

There are a number of characteristics of an unfamiliar sample which can aid you in making a
proper decision as to how aggressively the sample may be pumped down. Some of these
characteristics are listed below. The assumption is always made that the sample material has
been first dried in a shallow pan at 150 °C or higher for one hour or in a vacuum oven.

Samples, whether in the form of fine powders, granules, or even larger pieces, require extreme
caution if one or more of the following characteristics are noted or known to be the case:

= afine dustis raised upon stirring or shaking and the sample shows little sign of quickly settling
= the sample is a finely powdered organic material

the sample is known to be microporous or mesoporous with pores of less than 100 Angstrom
width

the sample is known or suspected to be a carbon

the sample is known or suspected to be a zeolite

the sample is known or suspected to be a fluid cracking catalyst

the sample has significant fine particle content below 10 mm

the sample leaves behind a visible deposit of fine particles when transferred from a weighing
pan

Such sample materials should be evacuated at initial pump down rates of about 0.5 psia/minute or
more slowly if of marked fineness until a pressure of 0.1 psia is reached. The pulsing of the
second pump down path should be maintained until 100 mmHg is reached before the final shift to
the third and most direct pump down path takes place. The penetrometer must be filled only about
1/3 full so that there is a margin of clearance between the stem bore and the sample bed.

Sample materials which are coarse, medium, or dense powders, or are composed of obviously
non-shedding chunks, pellets, or extrudates, can be pumped down at rates of 1 to 2 psia per
minute until a pressure of 0.25 psia is reached. The pulsing of the second pump down path should
be maintained until 250 mmHg is reached before the third pump down path takes over.

Sample materials that obviously present little risk such as monolithic chunks or very coarse,
dense granules usually can be pumped down at near maximum rates. For these, specify 5 psia
per minute initial pump down followed by a change to the second path at 0.5 psia and finally a
transition to the direct path at 500 mmHg.
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In most cases, you should choose a conservative rate of evacuation to be on the safe side. When
large numbers of samples of a material are to be run, the potential time savings may make it
worthwhile to investigate as to whether faster pump down rates might be possible without risk. To
do so, leave the capacitance transducer off the penetrometer base so that you may observe the
sample during a trial pump down performed at slightly higher than the usual speed. Twenty
percent increases in pump-down rates and pressures of path changeovers are reasonabile trial
increases.

Monitor closely during all portions of the pump-down sequence, especially as changes from one
path to another occur. Should the sample bed or any particles begin to boil or move, immediately
stop the pump down and return the sample to atmospheric pressure; reduce the pump down rate
to a slower rate and try again. If the pump down was successful, then another twenty percent
speed increase might be attempted. Continue until a suitable rate is found. Note that this
procedure is not without risk and must be done very carefully.

The amount of time for which to continue the extended pump down after the lowest target on the
third path has been met will depend upon the structure of the sample and what volatile materials
may be present within it. Large chunks of porous materials such as sandstone or green ceramics
or concrete may present a considerable diffusion barrier for gases and vapors traveling to their
surface and may require extended exposure times to vacuum to sufficiently clear the internal
pores of this obstructive matter which would prevent fully measuring the true porosity. Experience
and prior knowledge of the sample can be used for guidance.

Additionally, a manual mode test can be done in which you pump the sample down to the target
pressure, and then close it off from further vacuum and monitor the rate and ultimate value of the
pressure rebound that results from the tardy release of gas or vapor. The amount of time before
the rebound ceases or remains within tolerable limits will serve to guide you in choosing an
extended evacuation time for future automatic runs of the sample material.
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D PROPER HANDLING OF MERCURY

Because of its low melting point (-38.87 °C), mercury (Hg) is slightly volatile at ordinary room
temperatures and its vapor may pose a health hazard if allowed to accumulate in the work space.
Although mercury can enter the body through the skin, lungs or digestive system, breathing air
laden with high concentrations of mercury vapor is the most common cause of mercury poisoning.
Chronic poisoning caused by long-term exposure to low levels of mercury is occasionally found
among those working with mercury. Mining, chemical, electrical, dentistry materials,
pharmaceutical, explosive, porcelain, photography, printing, battery, paint, engraving, jewelry,
cosmetics and color are some of the industries that use mercury in their manufacturing or
processing.

Governmental agencies, i.e., National Institute for Occupational Safety and Health (NIOSH),
Environmental Protection Agency (EPA), etc., and some industries have set criteria and
recommended standards to protect the health and safety of workers exposed to mercury. A
Threshold Limit Value (TLV) of 0.05 mgHg/cubic meter of air, recommended by the American
Conference of Governmental Industrial Hygienists, was among the first hygienic guides for
controlling exposure of mercury in the U.S. Values well below this level can easily be met through
proper ventilation, prompt and thorough cleanup of spills, good personal hygiene and safe storage
when working with mercury.

Health hazards from mercury can be prevented by limiting the average concentration of mercury
to values below the TLV in an 8-hour workday. This is achieved through proper ventilation in the
work area where mercury is handled; for example, a local exhaust ventilation system can be
designed and maintained to prevent the accumulation or recirculation of mercury vapor, dust and
fume; all handling of mercury can be confined to a hood, etc. Appropriate protective respiratory
devices can be used when mercury exposure continues to exceed the recommended standard.
To ensure TLV levels are met, governmental agencies suggest environmental levels of inorganic
mercury be monitored every six months: breathing-zone samples are collected to permit
calculation of a time-weighted average exposure for every operator. When any time-weighted
average exposure is at or above the TLV, immediate steps are required to reduce exposure below
the standard.

Maintaining low temperature where mercury is used will help limit mercury concentration. Vapor
pressure of mercury goes up exponentially with temperature, for example, 20 °C: P = 1.20 x 1073
mmHg. As temperature increases from 20 to 40 °C, the partial pressure of mercury vapor
increases fivefold.
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D Proper Handling of Mercury EI micromeritics®

Proper clean-up of mercury spills and disposal of mercury-contaminated articles will limit
exposure. In a poorly ventilated, closed area, where mercury spills have not been properly and
thoroughly cleaned, mercury concentration in air can become significantly elevated above the
TLV of 0.05 mg per cubic meter of air. The following figure shows that the equilibrium
concentration of mercury at a room temperature of 25 °C reaches a level of 20 mg per cubic meter
of air. This is 400 times the TLV, resulting in a dangerous work environment. Surveys in labs
where mercury is routinely used reveal the presence of mercury in porous surfaces, in pools under
cabinets or floors, and inside drawers and lab equipment. This accumulation can be attributed to
the lack of an effective clean-up procedure for both large and small spills.

VOLUME pi

WEIGHT OF MERCURY mg/m? OF AIR

-10 o 10 20 30 40 50

TEMPERATURE °C
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Proper Use of Mercury as a Tool in Pore Structure

Ei micromeriti05® Analyses

Mercury spills should be cleaned immediately and thoroughly by mechanical, chemical or other
appropriate means. Micromeritics uses and recommends that you use plastic or rubber gloves
and a small vacuum pump equipped with a mercury vapor absorbing filter on the exhaust and a
vacuum probe with a mercury trap on the inlet for efficient pick-up of small mercury particles in
cleaning mercury spills. Afterwards, the spill area should be swabbed with a mercury
decontaminants’) and allowed to dry.

The health status of those working with mercury should be monitored regularly, with emphasis
placed on good personal hygiene to prevent contamination of hands, mouth, clothing or food.
Hand washing facilities, including hot and cold running water, soap, hand cream, and towels
should be made available adjacent to mercury work areas. Clothing contaminated with mercury
should be stored in vapor-proof containers pending removal for laundering.

Open containers for storage of mercury in the work area should be covered with an aqueous or an
oil layer and kept at ambient temperatures to prevent vaporization. Because of permeability of
polyethylene or plastic bottles to mercury vapor, thick glass bottles, stainless steel or cast iron
containers are recommended for storing mercury. To avoid dangerous chemical reactions,
mercury should not be stored with acetylene, fulminic acid, ammonia and oxalic acid.

PROPER USE OF MERCURY AS A TOOL IN PORE STRUCTURE
ANALYSES

Micromeritics’ Mercury Intrusion Porosimeters obtain accurate and reproducible pore structure
analyses using mercury. Mercury is ideal as an intrusion liquid in the porosimetry method because
it does not wet nor react with most materials. By measuring the amount of mercury intruded into
the pores of a powdered or solid sample, the porosimeters give valuable data from which pore
size, volume and distribution, as well as apparent densities, pore surface area and particle size
can be determined.

All of Micromeritics’ porosimetry instruments are designed with safety in mind. They come
equipped with built-in spill and vapor safeguards that minimize operator exposure to mercury.
They also are designed so that you may connect them to a ventilation system that pulls ambient
air over the counter, through the instrument and out a duct at the back. A built-in tray work area
allows the operator to easily wipe exposed mercury to a dish where it is covered with oil. Our
product literature on porosimetry supplies detailed site recommendations to assure safe
operation.

Mercury vapor levels well below the accepted safe level can easily be achieved through regular
monitoring, diligent handling and proper clean-up practices.

1) Mercury decontaminants may be purchased from Fisher Scientific (800/766-7000) or Lab
Safety Supply (800/356-0783). They also may be available from your local laboratory supplier.
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EI micromeritics® E Theory for Mercury Porosimetry

E THEORY FOR MERCURY POROSIMETRY

Mercury porosimetry is based on the capillary law governing liquid penetration into small pores.
This law, in the case of a non-wetting liquid like mercury and cylindrical pores, is expressed by the
Washburn equation

D=— (%) 4~ycos¢p

where D is pore diameter, P the applied pressure, y the surface tension, and ¢ the contact angle,
all in consistent units. The volume of mercury V penetrating the pores is measured directly as a
function of applied pressure. This P-V information serves as a unique characterization of pore
structure.

Pores are rarely cylindrical, hence the above equation constitutes a special model. Such a model
may not best represent pores in actual materials, but its use is generally accepted as the practical
means for treating what, otherwise, would be a most complex problem.

The surface tension of mercury varies with purity; its usually accepted value and the value
recommended here is 485 dynes/cm. The contact angle between mercury and the solid
containing the pores varies somewhat with solid composition. A value of 130 degrees is
recommended in the absence of specific information to the contrary.

Mercury extruding from pores upon reduction of pressure is in general accord with the above
equation, but indicated pore diameters are always offset toward larger diameters. This results
from equivalent volumes of mercury extruding at pressures lower than those at which the pores
were intruded. It is also commonly observed that actual pores always trap mercury. The first
phenomena is usually attributed to receding contact angles being less than advancing ones. The
second is likely due to pore irregularities giving rise to enlarged chambers and “inkwell” structures.
These phenomena give rise to hysteresis phenomena, i.e., distinct intrusion and extrusion P-V
curves.

See the Calculations document on the Micromeritics web page (www.Micromeritics.com) for a
discussion on Pore Surface Area Computation.
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F MAxXimMmum INTRUSION VOLUME OPTION

Using the maximum intrusion volume option allows routine analyses with fewer points in a
pressure table while maintaining good resolution. However, use of the maximum intrusion volume
requires some knowledge of the total pore volume of the sample to be analyzed. You should use
about 2% of the sample’s total pore volume as the maximum intrusion volume. This would give
about fifty points for the intrusion pore spectrum and should be adequate to completely
characterize most samples. The AutoPore IV will automatically add a pore spectrum point any
time it sees an increment of intrusion equal to the maximum intrusion volume specified.

Care should be taken not to use too small a maximum intrusion volume. Use of a value less than
0.4% of the total intrusion volume will cause too many points to be taken at lower pressures. The
total of 1000 data points will be exhausted and the analysis will terminate prematurely.

Use of too small a maximum intrusion volume can also cause points to be taken too close together
on the pressure axis. If this causes pressures to be taken within the target pressure tolerance of
each other, an apparent pressure decrease may be reported during the intrusion sequence. A
reported pressure drop greater than 10 psi or 0.5% of the target pressure will be interpreted as the
end of the intrusion segment. Reported summary data (such as total intrusion volume) will be
reported at this point, rather than at the maximum pressure as intended. Data for graphs other
than cumulative intrusion volume will also be terminated at this point.
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[M] micromeritics 6 Worksheets

G WORKSHEETS

Worksheets in this section may be copied as needed.

Analysis Conditions Worksheet on the next page
Penetrometer Properties Worksheet on page G - 3
Penetrometer Volume Calibration Worksheet on page G - 4
Pressure Table and Tabular Data Worksheet on page G - 6
Report Options Worksheet on page G -7

Sample Data Worksheet on page G - 8

Volumetric Reference Capsule Worksheet on page G - 9
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ANALYSIS CONDITIONS WORKSHEET

File Name:

Analysis conditions identifier

Low pressure equilibration

O Time 1 Rate

Max. intrusion volume

Evacuation

Initially evacuate at

Switch to medium at

Switch to fast at

Evacuation target

Continue evacuating for

High pressure equilibration

O Time O Rate
O Pressure-controlled scan

O Intrusion-controlled scan

Max. intrusion volume

Mercury Properties

Advancing contact angle

Receding contact angle

Hg surface tension

Hg density

Copy and use this worksheet as needed
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PENETROMETER PROPERTIES WORKSHEET

File Name:

Penetrometer Number
(etched on penetrometer)

Mass. Weigh the loaded penetrometer.
Subtract the mass of the sample. Enter
the difference.

Volume

Constant

Stem Volume

Max. head pressure

Correction method If Blank, give file name:

O Blank 0O Formula O None

Copy and use this worksheet as needed
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PENETROMETER VOLUME CALIBRATION WORKSHEET

Calculate the penetrometer volume three times, then record the average of these calculations.
When creating the penetrometer properties file, enter the average volume.

Penetrometer Number Date:

By:

First Calibration of Penetrometer Volume:

1. Mass of penetrometer filled with mercury g
2. Mass of sealed, empty penetrometer g
3. Mass of mercury (line 1 minus line 2) g

Room Temp = °C Density of mercury * = g/mL
4. Volume of penetrometer (line 3 + density of mercury) mL

Second Calibration of Penetrometer Volume:

1. Mass of penetrometer filled with mercury g
2. Mass of sealed, empty penetrometer g
3. Mass of mercury (line 1 minus line 2) g

Room Temp = °C Density of mercury * = g/mL
4. Volume of penetrometer (line 3 + density of mercury) mL

Third Calibration of Penetrometer Volume:

1. Mass of penetrometer filled with mercury g
2. Mass of sealed, empty penetrometer g
3. Mass of mercury (line 1 minus line 2) g

Room Temp = °C Density of mercury * = g/mL
4. Volume of penetrometer (line 3 + density of mercury) mL
Average Reference Capsule Volume: mL

*

Refer to the table Density of Mercury on the next page for values.

Copy and use this worksheet as needed
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DENSITY OF MERCURY
Density of Mercury
°C g/mL °C g/mL °C g/mL °C g/mL

18.0 13.5512 23.2 13.5384 252 13.5335 27.2 13.5286
19.0 13.5487 234 13.5379 254 13.5330 27.4 13.5281
20.0 13.5462 23.6 13.5374 25.6 13.5325 27.6 13.5276
21.0 13.5438 23.8 13.5369 25.8 13.5320 27.8 13.5271
22.0 13.5413 24.0 13.5364 26.0 13.5315 28.0 13.5266
22.2 13.5408 24.2 13.5359 26.2 13.5310 29.0 13.5242
224 13.5403 24 4 13.5354 26.4 13.5305 30.0 13.5217
22.6 13.5399 24.6 13.5350 26.6 13.5301 31.0 13.5193
22.8 13.5394 24.8 13.5345 26.8 13.5296 32.0 13.5168
23.0 13.5389 25.0 13.5340 27.0 13.5291 33.0 13.5144

Copy and use this worksheet as needed




[M] micromeritics:

PRESSURE TABLE AND TABULAR DATA WORKSHEET

= For pressure table, enter:

Filling pressure:

Last low pressure point index:

® For tabular data, select:

[ Pressure
[ Pore size
O Percent intrusion

Entry Entry Entry

Entry

Copy and use this worksheet as needed
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REPORT OPTIONS WORKSHEET

File Name:

Calculation range

O Pressure O Pore size

Reports

Overlays

Sample 1 Sample 5

Sample 2 Sample 6

Sample 3 Sample 7

Sample 4 Sample 8

Copy and use this worksheet as needed



[M] micromeritics®

SAMPLE DATA WORKSHEET

Basic presentation sample file

Advanced presentation sample file

Port 1

Port 2

Port 3

Port 4

Sample file name or identifier (optional)

Penetrometer number(optional - etched
on penetrometer)

Sample mass(g). Enter this value on the
Sample Description tab.

Sample + penetrometer mass. Load the
penetrometer with sample and weigh.

Penetrometer mass. Subtract the sample
mass from the Sample + penetrometer
mass and enter the difference.

® |f using Basic presentation, enter this

value on the Sample Information window.

= |f using Advanced presentation, enter
this value on the Penetrometer Prop-
erties window.

High pressure port number(optional).
Enter the number of the high pressure port
where the sample is loaded.

Assembly mass. The mass of the sample
+ penetrometer + mercury. (Weigh the pen-
etrometer after the low pressure analysis.)
Enter this value on the Start High Pressure
Analysis window.

Copy and use this worksheet as needed
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VOLUMETRIC REFERENCE CAPSULE
WORKSHEET

WORKSHEET INSTRUCTIONS

/ Either a Volumetric Capsule test or a Reference Material test is required for veri-
fication.

A Volumetric Reference Capsule test is performed to verify the ability of the low pressure and high
pressure system to measure mercury intrusion volume accurately. Perform the following tests and
record the data in this worksheet.

® Perform the Low Pressure ports test using 5 cc solid penetrometers with a 1.131 mL stem
volume and an 8 ym membrane.

®m Perform the High Pressure ports test using 5 cc solid penetrometers with a 1.131 mL stem
volume and a 3 ym membrane.

Copy and use this worksheet as needed
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Calculate the volumetric reference capsule volume three times, then record the average of these

calculations. When creating the penetrometer properties file, enter the average volume.

Penetrometer Number Date:
By:

First Calibration of Reference Capsule Volume:

1. Mass of capsule filled with mercury
2. Mass of sealed, empty capsule
3. Mass of mercury (line 1 minus line 2)

Room Temp = °C Density of mercury * =

4. Volume of capsule (line 3 + density of mercury)

Second Calibration of Reference Capsule Volume:

1. Mass of capsule filled with mercury
2. Mass of sealed, empty capsule

3. Mass of mercury (line 1 minus line 2)

Room Temp = °C Density of mercury * =

4. Volume of capsule (line 3 + density of mercury)

Third Calibration of Reference Capsule Volume:

1. Mass of capsule filled with mercury
2. Mass of sealed, empty capsule
3. Mass of mercury (line 1 minus line 2)

Room Temp = °C Density of mercury * =

4. Volume of capsule (line 3 + density of mercury)

Average Reference Capsule Volume:

*

See Density of Mercury Table on the next page for values.

g/mL

mL

g/mL

mL

g/mL

mL

mL

Copy and use this worksheet as needed
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DENSITY OF MERCURY TABLE

Density of Mercury

°C g/mL °C g/mL °C g/mL °C g/mL

18.0 13.5512 23.2 13.5384 252 13.5335 27.2 13.5286
19.0 13.5487 234 13.5379 254 13.5330 27.4 13.5281
20.0 13.5462 23.6 13.5374 25.6 13.5325 27.6 13.5276
21.0 13.5438 23.8 13.5369 25.8 13.5320 27.8 13.5271
22.0 13.5413 24.0 13.5364 26.0 13.5315 28.0 13.5266
222 13.5408 24.2 13.5359 26.2 13.5310 29.0 13.5242
224 13.5403 24 4 13.5354 26.4 13.5305 30.0 13.5217
22.6 13.5399 24.6 13.5350 26.6 13.5301 31.0 13.5193
22.8 13.5394 24.8 13.5345 26.8 13.5296 32.0 13.5168
23.0 13.5389 25.0 13.5340 27.0 13.5291 33.0 13.5144

Copy and use this worksheet as needed
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H EXPORTED DATA EXAMPLE

This exported data has been truncated for this manual.

Sample Information

Sample Information

Method: Default
Sample: garnet ref mat 60k eqil (rate) 568
Operator: jch
Submitter: micromeritics performance test
Type of data: Automatically collected
Instrument type: 9600
Original instrument type: 9600
Comments:
Penetrometer mass: 63.9542 g
Sample mass: 0.2890 g
Assembly mass: 104.2008 g

Material Properties

Material: Garnet
BET surface area: 3.0000 m2/g
Use user entered density: Yes
Bulk Density: 1.2287 g/mL
True Density: 3.8800 g/mL
Effective Particle Density: 3.8800 g/mL
Use user entered conductivity formation factor: Yes
Factor: 1.000
Use user entered pressure threshold: No
Linear compressibility: -2.7400e-07 1/psia
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Quadratic compressibility: 2.8500e-13 1/psia?

Penetrometer Properties

Penetrometer: #568 - (14-0765) 3 Bulb, 0.412 Stem, Powder
Penetrometer mass: 63.9542 g
Volume: 3.2091 mL
Constant: 11.117 plL/pF
Stem volume: 0.4125 mL
Max. head pressure: 4.680 psia
Correction method: None

Analysis Conditions

Analysis conditions: Run Conditions

Mercury Properties

Advancing contact angle: 130.000 °
Receding contact angle: 130.000 °
Surface tension: 485.000 dynes/cm
Density type: Entered
Mercury density (entered): 13.5335 g/mL
Linear compressibility: -2.7400e-07 1/psia
Quadratic compressibility: 2.8500e-13 1/psia?

Evacuation Options

Sample type: Other
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H Exported Data Example

Initially evacuate at:

Switch to medium at:

5.0 psia/min

Use pressure transducer

0.25 psia
Switch to fast at: 200 pmHg
Evacuation target: 50 pmHg
Continue evacuating for: 5 min
Low Pressure
Filling pressure: 1.000 psia
Equilibration time: 1ls
High Pressure
Equilibration time: 1s
Hold at maximum pressure: No

Reverberi Options

Autocalculate Reverberi pres

sures: No

Pressure Table

Intru-
sion
Pressure Points Ending Maximum Sca-
n
Increment per  Pressure Intrusion Scan Rate Rate
(psia) Decade (psia) (mL/g) (min/decade) -mL/g)
1 1.00 30.00 0.0-
0100
2 30.46 0.0-
0100
AutoPore V Series Operator Manual H-3
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3 30.93 5.0 0.0-
0100

4 31.40 5.0 0.0-
0100

5 31.88 5.0 0.0-
0100

6 32.37 5.0 0.0-
0100

7 32.87 5.0 0.0-
0100

8 33.38 5.0 0.0-
0100

9 33.89 5.0 0.0-
0100

10 34.41 5.0 0.0-
0100

11 34.94 5.0 0.0-
0100

12 35.47 5.0 0.0-
0100

13 36.02 5.0 0.0-
0100

14 36.57 5.0 0.0-
0100

15 37.13 5.0 0.0-
0100

16 37.70 5.0 0.0-
0100

17 38.28 5.0 0.0-
0100

18 38.87 5.0 0.0-
0100

19 39.46 5.0 0.0-
0100

20 40.07 5.0 0.0-
0100

21 40.68 5.9 0.0-
0100
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22 41.31 5.0 0.0-
0100

23 41.94 5.0 0.0-
0100

24 42.59 5.0 0.0-
0100

25 43.24 5.0 0.0-
0100

26 43.90 5.0 0.0-
0100

27 44 .58 5.0 0.0-
0100

28 45.26 5.0 0.0-
0100

29 45.96 5.0 0.0-
0100

30 46.66 5.0 0.0-
0100

31 47.38 5.0 0.0-
0100

32 48.11 5.0 0.0-
0100

33 48.84 5.0 0.0-
0100

*

34 49.59 5.0 0.00100

35 50.35 5.0 0.0-
0100

36 51.13 5.0 0.0-
0100

37 51.91 5.0 0.0-
0100

38 52.71 5.0 0.0-
0100

39 53.52 5.0 0.0-
0100

40 54.34 5.0 0.0-
0100
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41
0100

42
0100

43
0100

44
0100

45
0100

46
0100

47
0100

48
0100

49
0100

50
0100

51
0100

52
0100

53
0100

54
0100

55
0100

56
0100

57
0100

58
0100

59
0100

55.

56.

56.

57.

58.

59.

60.

61.

62.

63.

64.

65.

66.

67.

68.

69.

70.

71.

72.

17

02

88

75

64

54

45

38

32

28

25

24

24

26

29

34

40

48

58

5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
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H Exported Data Example

60 73.69 5.0 0.0-
0100
61 74.82 5.0 0.0-
0100
62 75.97 5.0 0.0-
0100
63 77.14 5.0 0.0-
0100
64 78.32 5.0 0.0-
0100
65 79.52 5.0 0.0-
0100
66 80.74 5.0 0.0-
0100
67 81.98 5.0 0.0-
0100
68 83.24 5.0 0.0-
0100
69 84.52 5.0 0.0-
0100
70 85.82 5.0 0.0-
0100
71 87.13 5.0 0.0-
0100
72 88.47 5.0 0.0-
0100
73 89.83 5.0 0.0-
0100
74 91.21 5.0 0.0-
0100
75 92.61 5.0 0.0-
0100
76 94.03 5.0 0.0-
0100
77 95.47 5.0 0.0-
0100
78 96.94 5.0 0.0-
0100
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79
0100

80
0100

81
0100

82
0100

83
0100

84
0100

85
0100

86
0100

87
0100

88
0100

89
0100

90
0100

91
0100

92
0100

93
0100

94
0100

95
0100

96
0100

98.

99.

lo1.

103.

104.

106.

107.

109.

111.

112.

114.

116.

118.

119.

121.

123.

125.

127.

43

94

47

03

61

22

85

50

18

89

62

38

17

98

82

69

59

52

5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
5.0 0.0-
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| Compute Volumetric Compressibility of a Sample

[M] micromeritics® Sample

| ComMPUTE VOLUMETRIC COMPRESSIBILITY OF A SAMPLE
MATERIAL

Ideally, choose a sample material that is completely non-porous; if this is not the case, then
choose the pressure range over which the compressibility test is conducted such that no pore
filling occurs within it. Closed pores may not always cause volume changes during testing but they
may alter the results due to stress concentrations around them or because of their effects upon
measured density. Closed pores may also abruptly fail and even become open during testing and
cause invalid compressibility results to be reported. In some cases, such as the testing of plastic
foams at low pressures, the presence of closed pores may be acceptable and expected.

The sample mass and sample density must be known and available to a resolution and accuracy
at least three significant digits (preferably better) to permit accurate computation of the initial
volume of the sample material. Alternatively, an accurate geometric volume of a material such as
one containing closed pores (such as plastic foam) may be supplied. Before data reduction can be
performed, have available a “blank run” file consisting (at least ideally) of a run made with the
same penetrometer and accessory hardware that is to be used in the compressibility test and
(again ideally) on the same instrument ports as will be used in the compressibility run. The
pressure range of the blank run must, at a minimum, fully encompass the planned range to be
used in the compressibility measurement and have a minimum of seven uniformly spaced (linear
basis) data points inside the planned computation range and with the beginning and ending data
points within 5% (pressure) of the planned computation range end points. It is also permissible for
the “blank run” to consist of a manually entered data file.

The first and second order isostatic pressure coefficients of volumetric compressibility for mercury
over the pressure range from zero psia to 60,000 psia must be known and available. All standard
input information such as sample material identity, equilibration times, evacuation information,
penetrometer constants, etc. that would be required for standard runs is required for a
compressibility run. Note that sample volume, bulk volume / density, and skeletal volume / density
as measured during the mercury porosimetry run are, in general, far too imprecise to yield good
results if used in the compressibility computations. For this reason, enter very accurate material
density and sample mass values to be used in computing an accurate initial sample volume or,
alternatively, directly enter a measured initial sample material volume.

The pressure table entered must contain at least seven pressure points uniformly spaced (on a
linear basis), with these points coinciding as closely as possible to those in the blank run which is
to be used along with the data in the final computation. As indicated above, the pressure values of
the end points achieved during the run must be within 5%.
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This declaration of conformity is issued under the sole responsibility of the manufacturer:

Micromeritics Instrument Corporation
4356 Communications Drive
Norcross, GA 30093, USA

Hereby declares that the product:
AutoPore V (9600, 9605, 9610, 9620) Automated Mercury Porosimeter
is in conformity with the following EU harmonization legislation:

2014/35/EU - LVD Directive
2014/30/EU - EMC Directive
2011/65/EU - RoHS Directive

and that the equipment is in conformity with the following harmonized and other appropriate standards;

2014/35/EU (LVD)

IEC 61010-1:2010/A1:2016 - Safety requirements for electrical equipment for measurement, control, and laboratory
use — Part 1: General requirements.

IEC 61010-2-081:2019 - Particular requirements for automatic and semi-automatic laboratory equipment for analysis
and other purposes

2014/30/EU (EMC)

IEC 61326-1:2020 - Electrical equipment for measurement, control and laboratory use — EMC requirements — Part 1:
General requirements

IEC 61000-3-2:2014 - Part 3-2: Limits — Limits for harmonic current emissions (equipment input current < 16 A per
phase)

IEC N 61000-3-3:2013 - Part 3-3: Limits — Limitation of voltage changes, voltage fluctuations and flicker in public low-
voltage supply systems, for equipment with rated current <= 16 A per phase and not subject to conditional connection

2011/65/EU (RoHS)
EN 63000:2018 - Technical documentation for the assessment of electrical and electronic products with respect to the restriction of
hazardous substances

Name: John McCaffrey, Ph.D. Title: Vice President, R& D
Signature: | Date of issue: 08/12/2022

Location: Norcross, GA USA

Document # 962-49001-08 Revision ( B) 2022-08-12 Release #220147
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